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1 Copyright Information 

⚫ SIGLENT TECHNOLOGIES CO., LTD All Rights Reserved. 

⚫ SIGLENT is the registered trademark of SIGLENT TECHNOLOGIES CO., LTD. 

⚫ Information in this publication replaces all previously corresponding material. 

⚫ SIGLENT reserves the right to modify or change parts of or all the specifications or pricing 

policies at the company’s sole decision. 

⚫ Any method of copying, extracting, or translating the contents of this manual is not allowed 

without the permission of SIGLENT. 
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2 Safety Requirements 

This section contains information and warnings that must be observed to keep the instrument 

operating under the corresponding safety conditions. In addition to the safety precautions 

specified in this section, you also have to follow common safe operating procedures. 

2.1 Safety terms and symbols 

When the following terms or symbols appear on the front panel, rear panel, or this manual, it 

indicates particular attention should be paid. 

 

 

This symbol is used where caution is required. Refer to the accompanying 
information or documents to protect against personal injury or damage to 
the instrument. 

 
This symbol warns of a potential risk of shock hazard. 

 
This symbol is used to denote the measurement ground connection. 

 
This symbol is used to denote a safety ground connection. 

 

This is a start/standby switch. Press the switch, the VNA will switch between 
the working state and the standby state. The switch could not power off the 
device, to completely power off the VNA, the power cord must be removed 
from the AC socket. 

 
This symbol is used to represent alternating current, or "AC". 

 

The "CAUTION" symbol indicates a potential hazard. It calls attention to a 
procedure, practice, or condition which may be dangerous if not followed. Do 
not proceed until its conditions are fully understood and met. 

 

The "WARNING" symbol indicates a potential hazard. It calls attention to a 
procedure, practice, or condition which, if not followed, could cause bodily 
injury or death. If a WARNING is indicated, do not proceed until the safety 
conditions are fully understood and met. 
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2.2 Operating environment 

Use in a clean and dry indoor environment with an ambient temperature range from 0°C to 40°C. 

Note: Direct sunlight, electric heaters, and other direct heat sources, should be considered when 

evaluating the ambient temperature. 

 

 

Do not operate the instrument in explosive, dusty, or humid environments. 

 

This instrument meets the EN 61010-1 standard, and has the following restrictions:  

Installation (overvoltage) category: Class II (electric supply connector) and Class I (measure 

terminal) 

Pollution level: Class II 

Protection level: Class I 

 

Note: 

Installation (overvoltage) category Class II indicates the local supply level is suitable for 

equipment connected to the AC power supply. 

Installation (overvoltage) category Class I indicates the signal levels suitable for terminals 

connected to the RF source.  

Pollution level Class II indicates it only occurs in a dry and non-conductive environment, 

sometimes we should consider the temporary conductivity caused by concentration. 

Protection level Class I indicates grounding equipment, it prevents electric shock by connecting 

the equipment to the ground wire. 
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Do not apply excessive pressure or strike the surface of the touch screen. 

 

 

Do not exceed the maximum voltage marked on the front panel connectors. 

 

2.3 Cooling requirement 

This instrument is cooled through a built-in fan. To keep adequate ventilation, a gap of at least 

15 cm should be left on both sides, as well as the front and rear panels of the instrument. 

 

 

Do not block the vents located along the side and real panel of the instrument. 

 

 

Do not let any external objects enter the instrument through the vents. 

 

2.4 AC power supply 

The instrument accepts 100-240V, 50/60/400Hz AC power. The maximum power consumption 

is 90W with complete options.  
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Note: The instrument can operate within the following input ranges: 

 

Voltage range: 90 - 264 Vrms 90 - 132 Vrms 

Frequency range: 47 - 63 Hz 380 - 420 Hz 

 

2.5 Power supply and grounding 

The instrument has a three-terminal plug and an IEC320 (Type C13) standard connector for the 

input power and grounding connections. The grounding terminal on the socket is directly 

connected to the instrument shell. To prevent electric shock, the plug must be inserted into a 

well-grounded socket. Please use the power cord provided to connect the instrument to the 

power source. 

 

 

Danger of electric shock! 

Disconnected or broken internal or external grounding wires will increase the risk of electric 
shock. It is strictly forbidden to destroy the protective grounding wire or safety grounding 
terminals. 

 

The location of the instrument should be convenient to access the power supply. To completely 

power off the instrument, the power cord should be removed from the power socket of the 

instrument. When the instrument is idle for long durations, it is recommended to unplug the 

power cord from the AC socket.  
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The RF connector’s shell on the front panel is connected to the instrument’s shell, and then 
connected to the earth ground. 

 

2.6 Calibration 

The recommended calibration cycle is one year. Calibration should only be performed by 

qualified personnel. 

2.7 Cleaning 

Only a soft damp cloth without any chemical/corrosive substances can be used to clean the 

instrument. Do not clean or use the product in wet environments. To avoid electric shock, unplug 

the power cord from the AC socket before cleaning. 

 

 

Danger of electric shock! 

Do not disassemble the instrument. Maintenance must be carried out by qualified personnel 
only. 

 

2.8 Exceptional conditions 

Use the instrument only for the purpose specified by the manufacturer. Do not use if the 

instrument has visible damage or has endured severe transportation vibration. If the device is 

suspected to be damaged, please disconnect the power cord and contact your local SIGLENT 

office. To operate the instrument correctly, all instructions and marks should be read carefully.  
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Use of the instrument for purposes unspecified by the manufacturer may damage the 
instrument. 
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3 Product Introduction 

3.1 General Description 

The SNA5000A&SNA5000X-E series of vector network analyzers includes the following models: 

SNA5002A, SNA5004A, SNA5012A, SNA5014A, SNA5022A, SNA5032A, SNA5003X-E, SNA5006X-

E. That have a frequency range of 9kHz to 26.5GHz, which support 2/4-port scattering, differential, 

and time-domain parameter measurements. The SNA5000A&SNA5000X-E series are ideal for 

determining the Q-factor, bandwidth, and insertion loss of a filter. They feature impedance 

conversion, movement of measurement plane, limit testing, ripple test, fixture simulation, and 

adapter removal / insertion adjustments. The VNAs have five sweep types: Linear-Frequency 

mode, Log-Frequency mode, Power-Sweep mode, CW-Time mode, and Segment-Sweep mode. 

They also support scattering-parameter correction of SOLT, SOLR, TRL, Response, and Enhanced 

Response for increased flexibility in R&D and manufacturing applications. The frequency range of 

each model is shown in the table below. 

Model Ports Frequency range 

SNA5002A 2 9kHz-4.5GHz 

SNA5004A 4 9kHz-4.5GHz 

SNA5012A 2 9kHz-8.5GHz 

SNA5014A 4 9kHz-8.5GHz 

SNA5022A 2 100kHz-13.5GHz 

SNA5032A 2 100kHz-26.5GHz 

SNA5003X-E 2 9kHz-3GHz 

SNA5006X-E 2 9kHz-6.5GHz 
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The SNA5000A&SNA5000X-E Series supports various options as detailed in its summary table: 

Option\Model 

SNA5002A 

SNA5004A 

SNA5012A 

SNA5014A 

SNA5022A 

SNA5032A 

SNA5003X-E 

SNA5006X-E 

SA Option (Spectrum Analyzer) √ √ √ 

TDA Option (Time Domain) √ √ √ 

TDR Option (Time Domain Reflectometer) √ √ √ 

AFR Option (Automatic Fixture Removal) √ √ √ 

SMM Option (Scalar Mixer Measurement) √ √ × 

VMM Option (Vector Mixer Measurement) √ √ × 

PM Option (Pulse Measurement) √ √ × 

MT Option (Material Measurement) √ √ × 

GC Option (Gain Compression) √ √ × 

NF Option (Noise Figure) √ √ × 

PV Option (Performance Tests) √ √ × 

 

3.2 Features 

⚫ SNA5000A Frequency range : 9 kHz-8.5GHz and 100kHz-26.5GHz 

◆ SNA5000X-E Frequency range: 9 kHz-6.5GHz 

⚫ Ports : 2/4 

⚫ Frequency resolution : 1 Hz 

⚫ Level resolution : 0.05 dB 

⚫ Range of IFBW : 1 Hz-10 MHz 

⚫ SNA5000A Setting range of output level : -55 dBm ~ +10 dBm  

⚫ SNA5000X-E Setting range of output level : -40 dBm ~ 10 dBm 

⚫ Dynamic range : 125 dB 
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⚫ Trace noise: 0.003 dBrms, 0.05 rms 

⚫ SNA5000A Types of calibration : Response calibration, Enhanced Response calibration, Full-

one port calibration, Full-two port calibration, Full-three port calibration, Full-four port 

calibration, TRL calibration 

◆ SNA5000X-E Types of calibration: Response calibration, Enhanced Response calibration, Full-

one port calibration, Full-two port calibration, TRL calibration 

⚫ SNA5000A Types of measurement: Scattering-parameter measurement, differential-

parameter measurement, receiver measurement, time-domain parameter analysis, limit 

test, ripple test, impedance conversion, fixture simulation, adapter removal/insertion, 

spectrum analysis, frequency offset, scalar mixer measurement, Pulse measurement, Gain 

Compression measurement, Vector mixer measurement. 

◆ SNA5000X-E Types of measurement: Scattering-parameter Measurement, Differential-

parameter Measurement, Receiver Measurement, Time-Domain parameter analysis, limit 

test, ripple test, impedance conversion, fixture simulation, adapter removal/insertion, 

spectrum analysis, frequency offset. 

⚫ Internal Bias-Tee connections 

⚫ Interface: LAN, USB Device, USB Host (USB-GPIB) 

⚫ Remote control: SCPI / Labview / IVI based on USB-TMC / VXI-11 / Socket / Telnet / 

Webserver. 

⚫ Touch control: Multi Touch，Mouse，Keyboard 

⚫ 12.1-inch touch screen 

⚫ Video output: HDMI  
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4 User Manual Overview 

Main Contents 

Chapter1. Copyright 

Chapter2. Safety Requirement 

Chapter3. Product Introduction 

This chapter introduces the characteristic index and function of vector network analysis. 

Chapter4. User Manual Overview 

This chapter introduces the chapters of the user manual. 

Chapter5. Quick Start 

This chapter introduces the appearance and size of the vector network analyzer, the basic 

operation of the front and rear panels, user interface, buttons, and touch screen. 

Chapter6. Set Up a Measurement 

This chapter describes the measurement function, sweeping trigger setting, and other 

functions of the vector network analyzer, and introduces the functions under each menu in 

detail. 

Chapter7. Measurement Calibration 

This chapter introduces the different calibration methods of S parameters, power calibration 

methods, test fixture, and other functions of vector network analyzer in detail. 

Chapter8. Data Analysis 

This chapter introduces the mathematical analysis function, including time-domain analysis, 

windows, coupling, markers, and other functions. 

Chapter9. Save and Recall 

This chapter introduces the data save and recall processes. 
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Chapter10. TDR Measurement 

This chapter introduces how to use the TDR option. 

Chapter11. Spectrum Analyzer 

This chapter introduces how to use the SA option. 

Chapter12. Frequency Offset Mode 

This chapter introduces the function of instrument Sources tune to frequencies that are 

different (offset) from the instrument Receivers. 

Chapter13. Mixer Measurements 

This chapter introduces how to do the Scalar Mixer Measurement or Vector Mixer 

Measurement. 

Chapter14. Pulse Measurement 

This chapter introduces how to use pulse measurements to test some DUT that cannot be 

tested using continuous signals. 

Chapter15. Material Measurement 

This chapter introduces how to measure a material. 

Chapter16. Gain Compression Measurement 

This chapter introduces how to do the Gain Compression Measurement. 

Chapter17. External Switch Matrices 

This chapter introduces how to use external matrix switch for multi-port expansion. 

Chapter18. Noise Figure 

This chapter introduces how to do the Noise Figure Measurement. 

Chapter19. Automatic Fixture Removal 

This chapter introduces the calibration methods for automatic fixture removal. 
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Chapter20. System setting 

This chapter provides information about the system settings. 

Chapter21. Service and Support 

This chapter provides information about service and support. 
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5 Quick Start 

5.1 Dimensions 

 

 

Figure 5-1 Front view and side view 

 

Figure 5-2 Rear panel view 
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5.2 Power supply 

The equipment accepts 100-240V, 50/60Hz AC power supplies. Please use the power cord 

provided to connect the instrument to the power source as shown in the figure below. 

 

Power 

Interface

 

Figure 5-3 Power interface 
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5.3 Front panel 

 

Figure 5-4 Front panel 

 

Table 5-1 Front panel area description: 

No. Items Description 

A 
LCD  

Touchscreen 

12.1 inch TFT color capacitive LCD touchscreen. 

Notes: Avoid touching the LCD touchscreen with sharp objects. The 

effective pixel ratio of the screen is more than 99.998%, so it doesn't 

mean a fault when the screen has some black / blue / green / red fixed 

points less than 0.002%. Screen savers are not recommended. The LCD 

screen is unlikely to suffer from image burn-in. 

B 
Response 

Includes the setting of measurement parameters, parameter format, 

markers, calibration, and so on. 

Utility Includes the function keys of the system, help, display, and so on. 
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Stimulus 
Includes the setting of measurement frequency, sweep time, sweep 

points, trigger, and so on. 

C Knob 
Rotate the button left or right to move the cursor or change the 

parameter value, the effect of pressing the button is the same as “Enter”. 

D Navigation 
Press the up, down, left, and right buttons to select the desired 

operation. 

E Numeric Includes the parameter numbers and units. 

F Test ports Connect to the DUT for signal transmission and reception. 

G Power Switch Power on/off the equipment. 

H USB Hub 
Includes four USB ports for data exchange and power supply with 

peripherals. The total current of four USB ports is less than 2A. 

 

5.3.1 Functional keyboard 

Table 5-2 Front panel functional keyboard description: 

Keys Description 

Meas 
Set the single-ended/ differential S parameter measurement, reference/ 

measurement receivers power measurement, and so on. 

Format 
Set the measurement parameter’s display format, such as Log Mag, Lin Mag, 

Smith Chart, Polar Chart, SWR, Phase, and so on. 

Marker Set markers to obtain the value of measurement parameters. 

Math 
Contains storing measurement data in memory, comparing current data with 

previous data, time-domain analysis of measurement results, and so on. 

Scale Set the scale of parameter levels. 

Cal Include the setting of S parameter calibration and power calibration. 

Search 
Press this button to get the measurement parameter’s maximum/ minimum 

value, bandwidth, Q-factor, and so on. 
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Avg BW 
Press this button to smooth/average measurement data, set the receiver’s IF 

bandwidth, and so on. 

Start Set start frequency. 

Stop Set stop frequency. 

Freq 
Set start frequency, stop frequency, center frequency, frequency span, 

measurement point. 

Power Set the RF power level, turn on/off RF power, and so on.  

Sweep 
Set sweep mode, sweep point, sweep time, log/lin frequency sweep mode, 

and so on. 

Trigger Press this button to choose the trigger source, set the trigger mode, and so on. 

System Set IP address, system time, language, and so on. 

Preset Press this button to revert to the default parameters. 

Save Recall Save and recall the measurement data, status, calibration data. 

Help Open the help file. 

Display 
Set measurement window, measurement channel, measurement trace, and 

so on. 

Touch Press this button to turn on/off the screen’s touch function. 

 

5.3.2 Digital keyboard 

Table 5-3 Front panel digital keyboard description: 

Keys Description 

 
When setting the frequency, press this key to set the unit as THz. if the input 

is time-related, press this key to set the unit as ps. 

 
When setting the frequency, press this key to set the unit as GHz. if the input 

is time-related, press this key to set the unit as ns. 
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When setting the frequency, press this key to set the unit as MHz. if the input 

is time-related, press this key to set the unit as us. 

 
When setting the frequency, press this key to set the unit as kHz. if the input is 

time-related, press this key to set the unit as ms. 

 

During the parameter editing process, pressing this button will clear the input 

of the active function area and exit the parameter input state. Press this 

button to return to local control if previously controlling the instrument 

remotely.  

 
During the parameter editing process, pressing this button will clear the input 

of the active function area from right to left. 

 
Pressing this button will activate every sub-function area from top to bottom 

in turn. 

 
In the parameter input process, pressing this button will end the parameter 

input process and add the currently set units for the parameter. 

 

5.3.3 Power switch 

Stand-by is indicated by a constant orange-colored power switch.   

A single button press will cause the light to turn white which indicates the instrument is 

operating. 

Continuous white indicates the instrument is operating.  

A short press of this button (one second) causes the light to turn orange which indicates the 

instrument is in the stand-by state after saving the settings.  

A long press of this button (three seconds) will cause the light to turn orange which indicates the 

instrument is in the stand-by state immediately without saving the settings. 
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5.3.4 RF connectors 

 

 

Figure 5-5 Front panel RF connectors (2-port VNA) 

 

Figure 5-6 Front panel RF connectors (4-port VNA) 

 

⚫ The number of RF connectors is two or four, depending on the instrument configuration. 

⚫ When an RF connector is transmitting an RF signal, the corresponding orange light above 

the RF connector will be lit. 

⚫ To avoid damage to the instrument, the RF connector input signal must meet the following: 

The DC voltage and the maximum continuous RF power cannot exceed 35 V and 27 dBm 

respectively. 
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5.4 Rear panel 

 

Figure 5-7 Rear panel 

 

Rear panel area description: 

No. Items Description 

A Lock 
Used to fix the instrument on the fixed object such as a table to help 

prevent theft.  

B Fan Used to cool down internal components of the instrument. 

C 

Ground  

Terminal 

Connect the instrument with earth ground. Electrically connects the 

metallic shell and connectors of the instrument to earth ground. 

LAN Port 
Used to connect the instrument to a LAN for data exchange with 

peripherals such as PCs.  

USB Port Include one USB port for data exchange with peripherals. 
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HDMI Port Connect the port to a compatible external monitor. 

D OCXO  Install the OCXO option to use the high-performance reference source. 

E 

10MHz Ref  

Signal Input 

The characteristic impedance of this port is 50 Ω. The detectable input 

frequency and power range are 10 MHz ± 10 ppm, -3 dBm to +10 dBm 

respectively. When there is a 10 MHz external reference signal on the 

port, the VNA’s transmitting signal will be locked into this 10 MHz 

external reference signal. Otherwise, the VNA’s transmitting signal will 

be locked into the internal 10 MHz reference signal.  

10MHz Ref  

Signal Output 

This port can output a 10 MHz reference signal so that it can be used 

by other equipment. The characteristic impedance, output frequency, 

and power range are 50 Ω, 10 MHz ± 10 ppm, -3 dBm to +10 dBm 

respectively.  

F 

Trigger In 

When there is an external trigger signal at the port, the VNA will use 

this external trigger signal instead of the internal trigger signal.  

Input level: 

Low threshold voltage: 0.5 V  

High threshold voltage: 2.1 V  

Input level range: 0 to + 5 V  

Pulse width: ≥ 2μs  

Polarity: Positive or negative 

Trigger Out 

This port can output a trigger signal so that it can be used by other 

equipment. 

Max output current: 20 mA  

Output level: 

Low-level voltage : 0 V  

High-level voltage : 3.3 V  

Pulse width : 1μs  

Polarity : Positive or negative 

G Bias-Tees Connect an external DC voltage source to this port to provide DC 
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Ports power for the DUT such as a power amplifier. The DC voltage and 

current cannot exceed 35V. This is the rated current of the fuse. 

H 
AC Power Port 

and Fuse 

The equipment accepts 100-240 V, 50/60/400 Hz AC power supply. 

please connect the VNA to the AC power supply with the supplied 

power cord. Make sure the current does not exceed the rated current 

of the fuse. 

I Handle Portable handle to carry the instrument. 
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5.5 OCXO option installation guide 

Power off the instrument, use a screwdriver to remove the cover where the OCXO option is 

located on the rear panel. 

Cover

 

Figure 5-8 OCXO option installation guide 

 

Insert the fixed OCXO module into the instrument’s slot, then tighten the screws. 

 

Figure 5-9 OCXO option installation guide 

 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  39 

Power on the instrument and the OCXO option can be used normally. 

 

5.6 User interface 

 

Figure 5-10 User interface 

 

A. Active Entry 

B. Marker Readout 

C. Trace Status 

D. Soft Keys 

E. Soft tabs 

F. Window number 

G. Stimulus Range 

H. Status Bar 
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I. Message Bar 

 

5.6.1 Active entry 

Table 5-4 Active entry description: 

Functions Functions Description 

 Recall the previous step. 

 Recovering the withdrawn operation. 

 Add a measurement trace. 

 Add a measurement window. 

 Add a marker. 

 
Delete active window or trace. 

Note: Keep at least one trace on the interface. 

 Screenshot (Ctrl+P) 

 

5.6.2 Value of marker 

Display the frequency and reading of the marker. 

 

5.6.3 Trace State 

⚫ A trace is a series of measured data points. Up to 256 traces can be created. In addition, one 

historical memory trace for each active trace can be stored and displayed. Mathematical 

operations can be performed on the current trace data and the historical memory trace. 
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⚫ Press the Display button in the front panel, and the Trace Setup menu pops up on the right 

side of the screen to manage the operation Trace, such as adding a trace, deleting a trace, 

maximizing the trace window, moving traces between Windows, keeping the trace to the 

maximum or minimum value without displaying the current value, etc. 

⚫ Select a trace line and press the Scale button to change the reference electric equalization 

operation. 

 

5.6.4 Channel State 

⚫ Channels contain traces. Up to 256 channels can be created. The channel setting 

determines how trace data is measured, and all traces assigned to a channel share the same 

channel setting. 

⚫ Press the Display button in the front panel, and the Channel Setup menu pops up on the 

right side of the screen. This can be used to manage operation channels, such as adding 

channels, copying channels, and deleting channels. 

 

5.6.5 Function Keys 

Table 5-5 Function Keys Interface Description 

Functions Functions Description 

Log Mag Parameters are displayed in logarithmic amplitude mode. 

Lin Mag The parameters are displayed in amplitude linear fashion. 

Phase Displays the phase of the parameter. 

Delay Displays the delay of the parameter. 

Smith The parameters are shown in the form of a Smith chart. 

Polar The parameters are displayed in polar coordinates. 
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SWR The parameters are shown in SWR. 

 

5.6.6 Label Page 

Displays all parameter display formats supported by the vector network analyzer. 

 

5.6.7 Window State 

⚫ Windows can be used to view trace data and up to 100 windows can be created. 

⚫ Press the button of Display in the front panel and the Window Setup menu pops up on the 

right side of the screen. It can be used to manage operation windows, such as selecting a 

window, adding a window, deleting a window, maximizing a window, layout, and so on. 

 

5.6.8 Stimulus Range 

Displays the excitation signal set in the current window, including starting frequency, ending 

frequency, internal source output power, etc. 

 

5.6.9 Status Bar 

Table 5-6 Status Bar Interface Description 

Functions Functions Description 

IntTrig Displays the current trigger mode. 

Continuous Continuous trigger, single trigger, and other trigger mode displays. 

BW=10k Display of the current IF bandwidth. 

C1·Port S parameter calibration data state loading display. 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  43 

SrcCal Display whether the internal source power calibration data state is loaded or 

not. A Gray dark shaded label represents an unavailable selection/option. 

RF On Internal source output power ON and off, RF ON stands for ON. 

IntRet A display that currently uses an internal or external reference signal. 

Update On UI waveform update or not. 

 

5.6.10 Message Bar 

Displays the current date information and error information during testing. 

 

5.6.11 Graffiti Function 

This product provides a basic graffiti function, which is used to draw graphics and mark 

information on the main interface. This feature is great for annotating screenshots and adding 

important details before saving.  

 

⚫ Graffiti function menu bar 
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Figure 5-11 graffiti function menu bar 

 

As shown in Figure 5-11, the graffiti menu contains functions of enable, edit, clear, save and call. 

 
⚫ Graffiti Editing Interface 
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Figure 5-12 graffiti editing interface 

 

As shown in Figure 5-12, the toolbar at the bottom of the interface displays a series of tools for 

graphic editing: 

1. Selection tool: A series of editing can be carried out after the drawing is selected 

2. Text tool: Add text notes in the interface 

3. Line tool: Add a line in the interface 

4. Rectangle tool: Add a rectangle to the interface 

5. Ellipse tool: Add an ellipse to the interface 

6. Curve tool: Draw a series of lines arbitrarily in the interface (double click the mouse/ 

double click the finger on the screen to finish drawing) 

7. Delete tool: Delete the currently selected drawing 

8. Text color tool: Set text color (support graphics: text) 

9. Text size tool: Set text size (support graphics: text) 
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10. Background filling tool: Fill graphics background color (support graphics: text, rectangle, 

ellipse) 

11. Border color tool: Set the border color of graphics (support graphics: text, line, 

rectangle, ellipse, curve) 

12. Border line tool: Adjust the border line thickness of graphics (support graphics: text, line 

segment, rectangle, ellipse, curve) 

13. Exit editing tool: Exit the current editing state 

 

 

Figure 5-13 Color selection interface 

 

As shown in Figure 5-13, after calling out this interface, you can adjust the corresponding colors 

of the graphics: 

1. Color shade selection tool: Mouse/ finger click to select the appropriate brightness of 

the color 

2. Color selection tool: Select a specific color 
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3. Color transparency tool: Adjust color transparency (the more right, the lower color 

transparency) 

 

Figure 5-14 Line thickness adjustment interface 

As shown in Figure 5-14, you can adjust the line thickness at the edge of the graph by calling out 

this interface. The larger the value is, the thicker the line will be. 

 

⚫ Save/Recall 

Click the save menu button to save the current graffiti content as a file with *.GFT as the file 

extension. 

 

5.6.12 Display Setup 

5.6.12.1 Display Update 

⚫ On: The trace waveform display on the user interface refreshes, and the status bar at the 

bottom shows "Update On". 

⚫ Off: The trace waveform display on the user interface stops refreshing, freezing the latest 

trace on the screen. However, the trace data in the background continues to update. The 

status bar at the bottom displays "Update Off" with a red background. 
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5.6.12.2 Touchscreen 

The vector network analyzer is equipped with a high-resolution color touch LCD screen for 

trace, function keys, and other measurement-related information. With the help of the touch 

screen, the LCD screen can be directly touched by a finger to select measurement and 

parameter setting operations. 

⚫ On: When the Touch button display light is on, the touch screen function is on. Users can 

operate the touch screen using their fingers or a mouse. Most of the display and control 

functions can be achieved through the touch screen, with effects equivalent to using 

buttons and knobs. 

⚫ Off: When the Touch button display light is off, the touch screen function is off. The 

instrument no longer responds to touch operations, but it still responds to button and 

mouse operations. Remote operations via WebServer are also unaffected. 

 

5.6.12.3 Softtool Layout 

⚫ Left: The menu bar is displayed on the left side of the user interface. 

⚫ Right: The menu bar is displayed on the right side of the user interface. 

 

5.6.12.4 Grid Brightness 

This setting is used to adjust the grid brightness percentage in the user interface, where the grid 

brightness will change in real-time according to the set value. The range of this setting is from 

0% to 100%, with a default setting of 20%. 

 

5.6.12.5 Theme Management 

In the "Theme Management" panel, SNA provides display configuration options for the 
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measurement panel, allowing you to flexibly configure parameters such as trace color thickness, 

XY axis font style, and view grid style. 

 

Figure 5-15 The Measurement Panel 

A. Trace Title Bar 

B. Response Axis/Left Axis 

C. Plot Grid 

D. Marker 

E. Marker Info Bar 

F. Trace Line 

G. Stimulus Axis/Bottom Axis 

Press the "Display" button on the front panel → "View Settings" →"Theme Manager…" to 

enter the "Theme Management" panel. SNA supports importing and saving themes. Select a 

specific theme from the theme drop-down menu to configure the measurement panel display 

parameters in one step. After completing the new theme configuration, click "Copy..." and then 

set a new name to add the current theme to the theme drop-down menu. Click "Delete" to 

delete the current topic from the theme drop-down menu. 
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Figure 5–16 Theme Management Panel 

A. theme drop-down menu 

B. "Copy...", save current theme 

C. "Delete", delete current theme 

D. Style Settings 

E. Color Settings 

 

5.6.12.5.1 Style Settings 

Click on "Style Settings" to enter the style setting interface, with the following options: 

⚫ Plot Grid 

"Window" → "Plot Grid" to enter the plot grid style setting menu, where you can set the grid 

line style and width. The grid line style menu bar has five styles to choose from: solid, dash, dot, 

dash-dot, and dash-dot-dot. 
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Figure 5–17 Choosing The Line Style With “dash” In The Plot Grid Menu   

 

⚫ Marker 

"Window" → "Marker" to enter the marker style setting menu, where you can set the font 

size, font style and font weight of the marker. The font style can be selected as normal or italic, 

and the font weight can be selected as normal or bold. The settings for font styles are the same 

below.  

⚫ Marker Info Bar 

"Window" → "Marker Info Bar" to enter the marker information bar style setting menu, where 

you can set the font size, font style, and font weight of the marker information bar. 

⚫ Response Axis 

"Window" → "Response Axis" to enter the response axis style setting menu, where you can 

set the font size, font style, and font weight of the response axis. 

⚫ Stimulus Axis 

"Window" → " Stimulus Axis" to enter the stimulus axis style setting menu, where you can set 

the font size, font style, and font weight of the stimulus axis. 
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⚫ Trace Line 

"Window" → "Trace Line" to enter the trace line style setting menu, where you can set the 

trace line width. 

⚫ Trace Title Bar 

"Window" → "Trace Title Bar" to enter the trace title bar style setting menu, where you can 

set the maximum limit columns, minimum limit columns, maximum limit rows, font size, font 

style, and font weight. 

 

5.6.12.5.2 Color Setting 

Click on "Color Setting" to enter the color setting interface. In the interface, you can set the 

colors of current traces, historical memory traces, measurement window backgrounds, grid lines, 

axis text, and other objects. For the current trace and historical memory trace, you can choose 

eight colors each, corresponding to Trace1-8 and MemTrace1-8. If the number of traces is 

greater than 8, the color of the trace is Trace x% 8, where x is the serial number of the trace. 

Click on the color box on the right, and the "Color Picker" interface will pop up. You can set 

the desired color by moving the color panel circle and color axis ruler. 

SNA supports importing and exporting color configuration files. Click on "Import" on the 

bottom right side and select the corresponding file to complete the color configuration in one 

step; Click on "Export", select the save path and set the file name to save your current color 

configuration. 
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A. Objects with modifiable colors 

B. Color Box, click to pop up the "Color Picker" interface  

C. "Color Picker" interface 

D. Import Color Settings 

E. Export Color Settings 

 

5.6.12.6 Hardkeys 

Press the Display> Display Setup > Hardkeys, enable the virtual keypad to operate the VNA 

without needing to use the function keys on the front panel. This is equivalent to using the 

Response, Stimulus, and Utility keys on the VNA's front panel. 
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5.6.13 RefLine Setup 

5.6.13.1 Overview of Reference Line Settings 

Reference Line: A line added to measurement results to mark specific frequency, magnitude, or 

phase values. 

The reference line setting is a key function in the VNA Display module, enabling users to flexibly 

add, adjust, and manage reference lines on measurement results. These lines help quickly locate 

and analyze critical data points, such as frequency peaks or phase transitions. 

 

5.6.13.2 Detailed Function Description 
1. Types of Reference Lines 

Horizontal Line: Marks specific magnitude or phase values. 

Vertical Line: Marks specific frequency points. 

2. Attribute Configuration 

Color: Customize line color for visual distinction. 

Value Type: Toggle between absolute (fixed value) and relative (percentage-based position) 

displays 

3. Reference Line Management 

Add: Create new lines with specified types and attributes. 

Move: Adjust positions via touchscreen drag, numeric input, or rotary knob. 

Delete: Remove unnecessary lines. 

 

5.6.13.3 Operational Workflow 

1. Access Menu: Press 【Display】> RefLine Setup to enter the reference line configuration 

interface, as the picture shown below: 
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○A Display/Drag: Show reference line values and drag to reposition. 

○B Horizontal Line Selection: Choose 1 of 8 predefined horizontal lines. 

○C Toggle Visibility: Enable/disable selected horizontal lines. 

○D  Set Horizontal Value: 

 

 

• Click to input absolute/relative values directly. 

• Double-click to open a dialog for switching between absolute and relative modes. 

• Relative values: Calculated as a percentage of the distance from the bottom of the 

display area. 

○E  Vertical Line Selection: Choose 1 of 8 predefined Vertical lines. 
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○F  Toggle Vertical Line Visibility: Enable/disable selected vertical lines. 

○G  Set Vertical Value: 

• Similar to horizontal lines. 

• Relative values: Calculated as a percentage of the distance from the left edge of the 

display area. 

○H Disable All Lines: Hide all reference lines. 

○I Open Reference Line Table: Manage line attributes collectively. 

 

 

○1  Add Line: Create new lines in ascending order. 

○2  State: On (visible), Off (hidden), Delete (remove). 

○3  Name: Assign custom labels to lines. 

○4  Value Type: Switch between absolute and relative modes. 

○5  Abs Value: Edit absolute or relative coordinates. 

○6  Rel Value: Edit relative value. 

○7  Color Adjustment: Change line colors. 
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5.7 Help Information 

The Help system of the vector network analyzer can provide the Help information of the 

function keys and menu options on the front panel. Press the Help button on the front panel to 

enter the Utility menu, click Help to open the Help document, click into the corresponding 

directory to view the information. 
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6 Setting Up a Measurement 

This chapter introduces in detail each function button on the front panel of 

SNA5000A&SNA5000X-E series vector network analyzers and the following menu functions. 

 

6.1 Measurement Classes 

Measurement Classes are categories of measurements that can coexist on a channel. 

Measurements in a measurement class can not coexist in a channel with a measurement of a 

different measurement class. For example, a Spectrum Analyzer measurement can NOT reside in a 

channel that is currently hosting Scalar Mixer Measurements. And Measurement classes vary according 

to the Vector Network Analyzers model and options installed. 

Press the Meas> “S-Params” > “Mode…” to enter the Measurement class dialog, and the box 

shows the supported classes for Vector Network Analyzers unit. except the “Standard (VNA)” class, 

all other measurement classes are commonly called "Applications measurement class". 

Measurement class dialog box shows the supported classes for Vector Network Analyzers unit. The 

supported classes depends on the product and installed options. As figure below. 
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Measurment class select dialog 

 

“Show Setup Dialog” check box is selected by default. Indicates that when a measurement class is 

selected to enable, the measurement configuration dialog box for the measurement class is 

displayed, so that users can directly set related parameters. If the check box is deselected, the 

measurement class’s setup dialog box will not be displayed when the measurement class is 

selected. 

“New Channel” check box is selected Indicates that create the measurement class in a new 

channel and new window. A default measurement for that class is created in the channel. 

 

6.2 Measurement parameters 

6.2.1 S parameters 

S parameters are used to describe the degree of a transmitted or reflected signal through an 



SNA5000A&SNA5000X-E User Manual 

60                                                                                   int.siglent.com 

impedance discontinuity. S parameters are relative measurements, defined as the ratio of two 

complex voltages. They contain the amplitude and phase information of the relevant signals. For 

the 2-port vector network analyzer, there are 4 S parameters (S11, S21, S12, S22).  

The specific meaning of each S parameter can be described by the following items: 

Sxy  x,y∈(1,2): 

x: The response port is also known as the receiving port of the vector network analyzer. 

The transmitted signal enters the port after passing through the DUT. 

y: The excitation port is also known as the transmitting port of the vector network 

analyzer. The output signal of this port is provided to the DUT. 

 

Here is a list of common Measurements with S-Parameters: 

Reflection Measurements Transmission Measurements 

⚫ Return loss 

⚫ SWR 

⚫ Reflection coefficient 

⚫ Input impedance 

⚫ S11, S22 

⚫ Insertion loss 

⚫ Transmission coefficient 

⚫ Gain/ loss insertion 

⚫ group delay 

⚫ Linear phase shift 

⚫ electrical delay 

⚫ S21, S12 

 

6.2.2 Balanced Measurement 

6.2.2.1 Balanced Devices 

Standard Single-ended devices generally have one input port and one output port. Signals on 

the input and output ports are referenced to ground. As Fig2.1 Balanced devices have two pins 

on either the input, the output, or both. The signal of interest is the difference and average of the 
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two input or output lines, not referenced to ground, as Fig2.2. 

DUTV V  

Fig 2-1 Single-ended devices 

DUTV V  

Fig 2-2 Balanced devices 

 

Differential and Common Modes Model 

On balanced devices, the signal of interest is the difference and average of the two input or 

output lines. In balanced device terminology, these signals are known as the Differential and 

Common modes. 

⚫ Signal A is fixed at 1V peak 

⚫ Signal B is selectable 

⚫ Differential is calculated as A minus B 

⚫ Common is calculated as the average of A and B 

 

Input Signal A and B, A =1V, B=2V Differential=(A-B), Common=(A+B)/2 
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Input Signal A and B, A =1V, B= reverse phase 2V Differential=(A-B), Common=(A+B)/2 

  

 

6.2.2.2 Measuring Mixed Mode (Balanced) S-Parameters 

The mixed mode S parameter is an extension of the conventional S parameter for balance 

measurement. If the measuring device is a balanced device, its mixed mode parameters can be 

measured by the VNA. Some balanced devices are designed to amplify the differential 

component and reject the common component. This allows noise that is common to both inputs 

to be virtually eliminated from the output. For example, a balanced device may amplify the 

differential signal by a factor of 5, and attenuate the common signal by a factor of 5. Using 

traditional S-parameter notation, an S21 is a ratio measurement of the device Output/ device 

Input. Mixing this with balanced terminology, we could view the amplifier's Differential Output 

signal/ Differential Input signal. To see this parameter on the analyzer, we would select an Sdd21 

measurement using the following balanced notation: 
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The general notation for the mixed S parameter is Sabxy, where: 

1) a - Represents the output mode of the device 

2) b - Represents the input mode of the device 

Choose from the following for both a and b 

⚫ s – single ended (unbalanced port) 

⚫ d – differential (balanced port) 

⚫ c – common (balanced port) 

3) x – device output “logical” port number 

4) y - device input “logical” port number 

 

6.2.2.3 Measuring Imbalance Parameters 

Imbalance is a measure of how well two physical ports that make up a balanced port are matched. 
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With a perfectly balanced port, the same amount of energy flows to both ports and the magnitude 

of the ratio of these ports is 1. The notation is similar to traditional S-parameters. In the following 

diagrams, the letters a, b, c, and d are used because any analyzer port can be assigned to any 

logical port using the port mapping process.  

For example, in the following single-ended - balanced formula, Sba indicates the device output 

port is logical port b and the input port is logical port a. 

(1) Imbalance parameter when measuring a single -balanced device.  

ImBal = − 
Sba

Sca

 

 

Single Balance

Port a

Port b

Port c

 

 

(2) Imbalance parameter of ImBal1 and ImBal2 when measuring a balanced -balanced device. 

 

ImBal1 = − 
𝑆𝑎𝑐 − 𝑆𝑎𝑑

𝑆𝑏𝑐 − 𝑆𝑏𝑑

 

 

ImBal2 = − 
𝑆𝑐𝑎 − 𝑆𝑐𝑏

𝑆𝑑𝑎 − 𝑆𝑑𝑏
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Logical Port 1 Logical Port 2

Port a

Port b

Port c

Port d

 

 

(3) Imbalance parameter of ImBal1 to ImBal4 when measuring a single- single -balanced 

device.  

 

ImBal1 = −
Sac − Sad

Sbc − Sbd

 

 

ImBal2 = −
Sca − Scb

Sda − Sdb

 

 

ImBal3 = − 
Sca

Sda

 

 

ImBal4 = − 
Scb

Sdb
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Logical Port 1 Logical Port 3

Port a

Port b

Port c

Port d

Logical Port 2

 

 

6.2.2.4 Measuring CMRR 

CMRR is a ratio of the transmission characteristic in differential mode over the transmission 

characteristic in the common mode of the balanced port as the measurement parameter. A high 

value indicates more rejection of common mode, which is desirable in a device that transmits 

information in the differential portion of the signal. On the measurement balanced parameter 

TAB interface, click “Change” to set the DUT topology and port mapping relationship. Different 

DUT topologies lead to different CMRR parameters. 
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The table below shows the CMRR parameters available when measuring different balanced 

device. 

Balanced device. CMRR parameters 

Single- balanced device Sds21/Scs21 , Ssd12/Ssc12 

Balanced - balanced device Sdd21/Scc21 

Single- single- balanced device Sds31/Scs31 , Sds32/Scs32 

 

6.2.2.5 DUT Topology Port Mapping 

In the balanced measurement, the signal of interest is the difference or average of two 

BALANCED input or BALANCED output lines. It is also possible to have single-ended ports AND 

balanced ports on the same device. 

Press the “Meas” button on the front panel → Balanced → Topology... , Create or edit DUT 

Topology and Logical Port Mapping. The port Topology / Logical port Mapping setting dialog box 

is as below: 

Logical Port 1 Logical Port 2

 

 

“Logical Port” is used to describe a physical analyzer test port that has been remapped to a new 

port number. 

1. Map any two physical ports of the vector network analyzer to a balanced logical port. 
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2. Map any physical port of the vector network Analyzer to a single-ended logical port. 

These selections apply to ALL measurements in the channel. If the device topology is changed, 

any existing measurements in the channel that are incompatible with the new topology will be 

automatically changed to one that is compatible. 

The following are the topological relationships of several common differential devices. A multi-

port vector network analyzer can be used to measure the following topological relationships for 

differential devices. When the vector network analyzer has only 2 test ports, then only the first 

balanced device under test can be tested. When the vector network analyzer has four test ports, 

then all the devices under test with the following four topological relationships can be tested. 

1) Balanced 

1 Logical port (Balance Port 1) - 2 physical ports (Port1, Port2) 

 

 

2) Balanced-Balanced 

2 Logical port (Balance Port 1, Balance Port 2) - 4 physical ports (Port1, Port2, Port3, Port4) 
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3) Single - Balanced 

2 Logical port (Balance Port 1, Balance Port 2) - 3 physical ports (Port1, Port2, Port4) 

 

 

4) Single-Single-Balanced 

3 Logical port (Balance Port 1, Balance Port 2) - 4 physical ports (Port1, Port2, Port4) 
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6.2.3 Receiver Measurement 

Each port of the vector network analyzer contains 1 reference receiver and 1 measurement 

reference receiver. For the 4-port vector network analyzer, there are a total of 4 reference 

receivers and 4 measurement reference receivers. The power measured by these receivers can 

be compared to obtain all the S parameter indices. 

R1, R2, R3, and R4 are the reference receivers used to measure the signal emitted from the 

vector network analyzer. It is equal to the transmitted power at the port after power calibration. 

⚫ R1: Measures the output power of port 1. 

⚫ R2: Measures the output power of port 2. 

⚫ R3: Measures the output power of port 3. 

⚫ R4: Measures the output power of port 4. 

 

A, B, C, and D are test receivers used to measure the reflected or transmitted signal power after 

passing through the device under test. 

⚫ A: Measures the signal power entering port 1. 

⚫ B: Measures the signal power entering port 2. 
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⚫ C: Measures the signal power entering port 3. 

⚫ D: Measures the signal power entering port 4. 

 

6.2.4 Wave (Receivers notation) 

Receivers can be also selected using logical receiver notation 

Press the “Meas” button on the front panel → Wave → Other... to enter the Wave TAB interface. 

 

 

 

Logical receivers are generally represented by aN, M and bN, M forms. 

⚫ aN - Represents Reference receiver for logical port N 

⚫ bN - Represents the test port receiver for logical port N 

⚫ M – Represents the Physical port number of the output power 

 



SNA5000A&SNA5000X-E User Manual 

72                                                                                   int.siglent.com 

For example: 

⚫ a1,1 Represents Physical port 1 outputs power when the reference receiver of logical 

port 1 is measured. When logical port 1 is mapped to physical port 1, it is equivalent to 

R1,1; 

⚫ a2,1 Represents Physical port 1 outputs power when the reference receiver of logical 

port 2 is measured. When logical port 2 is mapped to physical port 2, it is equivalent to 

R1,2; 

⚫ b1,1 Represents Physical port 1 outputs power when the test port receiver of logical 

port 1 is measured. When logical port 1 is mapped to physical port 1, it is equivalent to 

A,1; 

⚫ b2,3 Represents Physical port 3 outputs power when the test port receiver of logical 

port 2 is measured. When logical port 2 is mapped to physical port 2, it is equivalent to 

B,3; 

 

6.2.5 Ratio 

Ratio measurement allow you to choose your own ratio of any two receivers that are available in 

your analyzer. S-parameters are actually predefined ratio measurement. For example S11 is 

A/R1. 

Ratio - Check Activate to create or change a measurement. Select a receiver for the Numerator, 

select another receiver for the Denominator, then select a source port for the measurement. 

The Source port is always interpreted as a logical port number. 

For ratio measurement: "b2/a1,1" means that the logical source port number is 1, and the logical 

port 2 measurement receiver/logical port 1 reference receiver. 
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6.3 Frequency range 

Frequency range is the span of frequencies you specify for making a device measurement. 

6.3.1 Set the frequency range 

Set the range of RF frequencies. 

Operating steps: 

Press Freq on the front panel to open the frequency setting interface, parameter change 

mode: 

1. Use the numeric keypad to input the value of the frequency and press the unit button to 

select the desired unit. The optional units are GHz, MHz, KHz, and Hz. Press Enter to 

select the current unit by default. 
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2. Press ENTER or the multifunction knob to enter the state of parameter editing. Move 

the cursor to the specified position by the left and right arrow keys. Modify the value by 

pressing the up and down key, rotating the knob, or pressing the numeric keypad. Press 

ENTER, the knob, or ESC to exit the editing mode. 

Note: 

⚫ Start: Specify the starting frequency of the swept measurement range 

⚫ Stop: Specify the end frequency of the swept measurement range 

⚫ Center: Specify a center frequency of the swept measurement range 

⚫ Span: Specify the swept measurement frequency range 

⚫ Step: Specifies the frequency step size between data points 

⚫ Points: Specify the number of measurement points per sweep 

6.3.2 CW time sweep or power sweep 

Measurements using a CW time sweep or power sweep will be performed on a single frequency 

rather than the entire frequency range 

Operating steps: 

Press Sweep, use the knob or arrow keys to focus on the Sweep → Sweep type. Parameter 

change mode: 

1. Press ENTER or the knob to enter the parameter editing state and then move the 

cursor to the specified position by up and down arrow keys or the knob to set the 

Sweep type to CW Time or Power Sweep. Press ENTER or the knob to select the current 

option. 

2. Press Freq use the knob or arrow keys to focus on the Freq → CW parameter entry. 

Select the edit box to enter the edit mode and change the value by pressing the up and 

down key, rotating the knob, or pressing the numeric keypad. Press ENTER, the knob, or 
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ESC to exit editing mode. 

 

6.3.3 Frequency resolution 

Set the frequency resolution to 1Hz. 

 

6.4 Power level 

Power level refers to the output power at the port of the vector network analyzer. 

Here are the keys to operation: 

1. Press Power , use the knob or arrow keys to focus on the Power → Power Level parameter 

item. Input the required power level. Press ENTER to exit editing mode. The default unit is 

dBm. 

2. Press Power , use the knob or arrow keys to focus on the Power → RF Power parameter 

item. Turn on or off RF power. 

3. Press Power , use the knob or arrow keys to focus on the Port Power parameter item, 

Configure start and stop power. Start and stop power are only available in power sweep 

mode. 

4. Press Power , use the knob or arrow keys to focus on the Port Power → Select parameter 

item, Press ENTER or the knob to select the corresponding power port. 

5. Press Power , use the knob or arrow keys to focus on the Port Power → Coupling 

parameter item, Press ENTER or the knob to choose to turn coupling off or on. 

6. Press Power , use the knob or arrow keys to focus on the Leveling & Offsets → Slope Enable 

parameter item, Press ENTER or the Knob to turn on the Slope switch, Press Leveling & 
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Offsets → Slope to set the Slope. 

 

6.4.1 Coupled port power 

● Coupling (selected): The power level of each test port is the same. If the power of any test 

port is set, the power of all test ports will change accordingly. 

● Decoupling (clearing): Set the power level for each test port separately and decouple the 

Power. For example, if you want to measure the gain and reverse isolation of a high gain 

amplifier, the input port of the amplifier requires much less power than the output port. 

Power sweep can also be performed using uncoupled power 

 

6.4.2 Power Leveling and Offsets overview 

Power Limits controls the source power at each test port for ALL channels. Use this feature to 

protect DUTs that are sensitive to overpowering at the input. Source Power levels that exceed 

the Limit at the specified port are clipped at the limit, and an error message is displayed on the 

screen. 

Power Offset provides a method of compensating port power for added attenuation or 

amplification in the source path. The result is that power at the specified port, all dialogs, and 

annotations reflect the added components. For amplification use a positive offset, and for 

attenuation use a negative offset. 

Using the Softkey for setting: Press the “ Power ” key, “ Power ” > Leveling & Offsets then enter 

the menu. 
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A. Select the Port. 

B. Slope Enable. Helps compensate for cable and 

test fixture power losses at increased frequency. 

With power slope enabled, the port output 

power increases (positive input) or decreases 

(negative input) with the sweep frequency. 

C. Set the slope value 

D. Set the power offset value 

E. Power Limit Enable 

F. Set the power limit value 

G. Power Offsets and limits 

 

6.4.3 Power Offsets and Limits setting 

Using the Softkey for setting: Press the “Power” key, “Power” > Leveling & Offsets > Offsets and 

Limits to enter the menu. You can change the cell value in one of the following two ways: 

1. On the UI interface, click the cell twice in succession and then enter the value in the pop-up 

virtual numeric keyboard. 

2. Press the Tab key on the front panel to make the focus fall on the cell you want to change, 

press the number key +Enter on the front panel to set the value, or turn the knob to change 

the value. 
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A Global Power Limit. This sets a maximum source power level for individual test ports. This 

value limits port power for all channels and all applications. Power levels that attempt to 

exceed the power limit are clipped at the limit. 

B Power Limit Enable. Selects On indicate that power is limited to the adjacent value at the 

specified source port and selects Off indicate that power is not limited to this value, but the 

maximum power of the source. 

C Set the Source Power value. 

D Set the Power Offset value. 

E Set the Port Power value. The formula among Source Power, Power Offset, and Port Power 

is: Source Power + Power Offset = Port Power 

 

6.5 Sweep 

Sweeping refers to the measurement of a series of consecutive data points against a series of 

specified excitation values. 
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6.5.1 Points 

Data points are the number of data samples representing the measured values at a single 

excitation value. You can specify the number of data points that the vector network analyzer 

measures in a sweep. The sweeping time of the vector network analyzer varies proportionally 

with the number of points. 

Operating steps: 

Press Sweep, use the knob or arrow keys to focus on the Sweep → Number of Points parameter 

item, Enter the number of points required, Press ENTER to exit editing mode. 

The number of data points collected by the vector network analyzer during the measurement 

sweep can be set to any number between 1 and 100001. 

Note: Maximum point limits may differ for some measurement classes. 

⚫ For maximum trace resolution, use the maximum data points. 

⚫ For faster throughput, use a minimum number of data points to provide an acceptable 

resolution. 

⚫ To get the best number of points, look for values that do not differ significantly in the 

measurement as you add points. 

⚫ To ensure accurate measurement calibration, ensure that the user uses the same number of 

points for calibration and measurement. 

⚫ Points are the number of data items collected in one sweep. This number can be set 

separately for each channel. 

⚫ To obtain high trace resolution for excitation values, select a larger point value. 

⚫ For high throughput, keep the smaller point value within the allowable trace resolution range. 

⚫ For high measurement accuracy after calibration, use the same number of points as the 

actual measurement. 
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6.5.2 Sweep type 

Key operation: 

Press Sweep, use the knob or arrow keys to focus on the Sweep → Sweep Type parameter item. 

Press ENTER or Knob to enter the editing state, then move the cursor to the specified position 

by up and down direction keys or Knob, set the sweep type to the required measurement type, 

press ENTER or Knob to select the current option. 

Sweep type: 

⚫ Linear Frequency 

⚫ Log Frequency 

⚫ Power Sweep 

⚫ CW Time 

⚫ Segment Sweep 

 

Linear Frequency: Set the measured abscissa frequency scale as a linear scale, and keep the full 

frequency scale at equal intervals. 

 

Log Frequency: Set the measured abscissa frequency scale to log scale, to observe a wider 

frequency range, the calibration interval in the full frequency band is not uniform and presents 

periodic changes. 

 

Power Sweep: The power sweep will increase or decrease the power of the source according to 

the walk length. Power sweeping is used to characterize power-sensitive circuits through 

measurements such as gain compression. In the Sweep Type dialog box, you can specify “Start 
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Power”, “Stop Power”, “CW Frequency”, “Points”. 

 

Segment Sweep: “Segment Sweep” activates a sweep consisting of frequency sub sweep (called 

segmentation). For each segment, you can define a separate power level, IF bandwidth, IF 

bandwidth for each port, sweep time, delay, sweep mode. After the measurement calibration has 

been performed on the entire sweep or all segments, the measurement values of one or more 

segments can be calibrated. 

 

In the Segment Sweep type, the vector network analyzer performs the following operations. 

⚫ Sort all defined segments in order of increasing frequency. 

⚫ Measurements were made at each point. 

⚫ Display a trace containing all retrieved data. 

 

Limitations on segmented sweeping: 

⚫ The frequency range of one segment may not overlap with the frequency range of any other 

segment. 

⚫ The number of segments is limited only by the combined data points of all segments in the 

sweep. 

⚫ The frequency range of one segment may not overlap with the frequency range of any other 

segment. 

⚫ The number of segments is limited only by the combined data points of all segments in the 

sweep. 

 

Operating steps: 
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Press Sweep, Use the knob or arrow keys to focus on the Sweep → Sweep Type parameter item. 

Parameter change mode: 

1. Press ENTER or Knob to enter the state of parameter editing, then move the cursor to the 

specified position by up and down arrow keys or Knob, set the sweep type as Segment 

Sweep, and press ENTER or Knob to select the current option. 

2. Press Sweep, use the knob or arrow keys to focus on the Segment Table parameter item. 

Move the cursor to the specified position by up and down arrow keys or knobs, set Add 

Segment, Insert Segment, Delete Segment and Delete All Segments to perform segment 

operation. Select the segment table for segment setting and tick the corresponding menu to 

display the corresponding contents in the following segment. 

 

 

Figure 6-1 Segment table 

 

X-Axis Point Spacing: In segment sweep mode, this feature will affect how the segment trace is 

drawn on the screen. This function is in the sub-sweep table menu. 

⚫ When X-axis point spacing is not used, multi-segment sweeping traces may sometimes 

result in many measurement points being squeezed into a narrower portion of the X-axis 

⚫ When X-axis point spacing is used, the X-axis position of each point needs to be selected 

so that all measurement points are evenly distributed along the X-axis. 

 

For example, suppose you have the following two sections: 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  83 

 

 

Figure 6-2 X-point spacing is not used 

 

Figure 6-3 Use X-axis point spacing 

6.6 Trigger 

6.6.1 Overview of the Trigger 

Triggering serves as the "gating signal" that initiates measurement, determining: 

• When scanning begins 

• Whether data is acquired synchronously 

• How multiple instruments coordinate their operation 
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In applications such as high-speed device testing, production-line automation, and multi-port 

calibration, precise trigger control directly determines data consistency and system reliability. 

6.6.2 Trigger Menu Structure 

Press the front-panel [Trigger] button to enter the trigger setup menu. The trigger menu 

structure is shown in the table below: 

Function Item Option 

Trigger State Hold, Single, Continuous, Hold All Channels, Restart 

Trigger Source Internal, Manual, External, Bus 

Trigger Scope All Channel, Active Channel 

Trigger Event On Sweep, On Point 

Ext Trigger Input Positive Edge, Negative Edge 

Trigger Delay 0 ~ 10 s (Resolution 1 μs） 

Ext Trigger Output Positive Pulse, Negative Pulse 

Ext Trigger Output Position Before point, After point 
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6.6.3 Detailed Trigger Functions 

6.6.3.1 Trigger State 

Hold: The channel accepts NO trigger signals. 

Single: The channel accepts ONE trigger signal, then goes into Hold. 

Continuous: The channel accepts an infinite number of trigger signals. 

Hold all channels: All channels enter the hold state and do not accept any trigger signals. 

Restart: (Accessible only from the Trigger menu.) Channels that are in the Hold state are set to 

be triggered once (The channel accepts a single trigger signal). All other Settings are unaffected. 

1. When the trigger source is set to Internal and the trigger mode is "Single" or "Continuous", 

clicking "Restart" causes the channel trace(s) to re-sweep. 

2. When the trigger source is set to Manual, External, or Bus, and the trigger mode 

is "Single" or "Continuous", clicking "Restart" stops the current sweep of the channel 

trace(s); a new sweep will begin only upon receipt of a new trigger signal. 

3. When the trigger mode is set to "Hold", clicking "Restart" results in no action—the channel 
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trace(s) remain unchanged. 

4. In multi-channel sweeping, when the trigger source is Internal and the trigger mode 

is "Continuous", clicking "Restart" stops the current sweep of the active channel and 

restarts sweeping from the first channel. 

6.6.3.2 Trigger Source 

Trigger source: These Settings determine the source of the trigger signal for all existing 

channels. A valid trigger is generated only if the vector network analyzer is not sweeping. 

Internal triggers: After the previous measurement is completed, the vector network analyzer will 

immediately send a continuous trigger signal. 

Bus trigger: The vector network analyzer waits for the SCPI trigger instructions issued by an 

external controller (PC). 

External trigger: Trigger signals generated by external devices received through the BNC 

Connector on the rear panel. 

Manual trigger: Manually send a trigger signal to the vector network analyzer. Available Only 

when you select “Manual” to trigger. 

6.6.3.3 Trigger Scope 

All channels: Triggers are sent to all triggerable channels. A trigger will sweep all channels that 

can be triggered. (Default setting) 

Current channel: Triggers are sent to the current channel but after the current channel 

completes, the channel increments to the next triggerable channel. 

6.6.3.4 Trigger mode 

These settings determine the number of trigger signals that the channel will receive. 

On Sweep trigger: A single trigger initiates a complete frequency sweep (i.e., all N frequency 

points are acquired in one sweep). 
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On Point trigger: Each frequency point requires an individual trigger signal (i.e., N triggers are 

needed to complete one frame of N frequency points). 

6.6.3.5 External Trigger Input 

Effective only when the trigger source is set to "External". 

Positive Edge: Triggered when the external trigger signal (input via TRIG IN) transitions from low 

to high. 

Negative Edge: Triggered when the external trigger signal (input via TRIG IN) transitions from 

high to low. 

6.6.3.6 Trigger Delay 

After receiving a valid trigger signal, the instrument delays for a specified time before initiating 

the sweep. 

 Range: 0 to 10 seconds 

 Resolution: 1 µs 

 Purpose: Allows time for the device under test (DUT) to stabilize (e.g., after switch 

switching). 

6.6.3.7 External Trigger Output 

The following settings control the properties of the signals sent out the rear panel TRIG OUT. 

⚫ Polarity 

Positive Pulse:  Outgoing pulse is positive. 

Negative Pulse:  Outgoing pulse is negative. 

⚫ Position 

Before Point :  Pulse is sent immediately before data acquisition begins. 

After Point:  Pulse is sent immediately after data acquisition is complete. 
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6.7 Data format 

The data format is the method by which the vector network analyzer displays the measured data 

graphically. Select the data format that corresponds to the information you want to know about 

the test device. 

 

6.7.1 Display format 

Operating steps: 

Press Format, Use the knob or arrow keys to focus on the Format parameter item. Press ENTER 

or the Knob to enter the parameter editing state, then move the cursor to the specified position 

by the up and down arrow keys or the knob, and press ENTER or the knob to select the current 

option. 

 

6.7.2 Cartesian coordinates display format 

Nine of the twelve available data formats use rectangular displays to present measurement data. 

This display is also known as Cartesian, XY, or linear coordinates. The Cartesian coordinate 

display is especially suitable for clearly displaying the frequency response information of the 

device-under-test (DUT). 

⚫ The excitation data (frequency, power, or time) is linearly scaled and displayed on the X-axis 

⚫ The measured response data is displayed on the Y-axis 

 

Log amplitude scheme: 

⚫ Display amplitude (no phase) 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  89 

⚫ Y: dB 

⚫ Typical measurements: Return loss, insertion loss, or gain 

 

Phase format: 

The phase of the signal is measured relative to the calibration reference plane, within a range of 

±180 degrees. 

⚫ Display phase (no amplitude) 

⚫ Y: Phase (degrees) 

⚫ Each 180-degree trace is “wrapped” for easy scaling 

⚫ Typical measurement: Linear phase shift. 

 

A phase: 

⚫ Same phase, but no 180-degree entanglement. 

Note: Phase unwrapping is accomplished by comparing the phases of two adjacent data points. 

If the phase difference between the two points is greater than 180 degrees, or the DC 

offset phase of the first data point is greater than 180 degrees, then the phase 

measurement may not be accurate. 

 

Group delay format: 

⚫ Displays the transmission (propagation) time of signal in the device 

⚫ Y: Time (s) 

⚫ Typical measurement: Group delay 
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Linear amplitude scheme: 

⚫ Only positive values are displayed 

⚫ Y: No Unit (U, suitable for proportional measurements)  

  Watts (W, suitable for disproportionate measurements) 

⚫ Typical measurements:  

⚫ Reflection and transmission coefficients (amplitude), time domain transformation 

 

SWR format: 

⚫ Displays the reflection measurements calculated from the formula (1+ R) / (1-R), where R is 

the reflection coefficient 

⚫ Valid for reflection measurements only 

⚫ Y: No units 

⚫ Typical measurements: SWR 

 

Real number format: 

⚫ Show only the real part of the measured complex data 

⚫ Can display both positive and negative values 

⚫ Y: No units 

⚫ Typical measurements: Time domain, auxiliary input voltage signals for maintenance 

purposes 

 

Imaginary number format: 

⚫ Only imaginary parts of the measured data are displayed 
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⚫ Y: No units 

⚫ Typical measurement: Network impedance matching 

 

6.7.3 Polar coordinates 

The polar coordinate format is used to view the amplitude and phase of the reflection 

coefficients in S11 or S22 measurements. 

You can use a cursor to display the following items: 

⚫ Linear or log amplitude (in dB) 

⚫ Phase (in degrees) 

 

 

Figure 6-4 Polar diagram 

 

⚫ The dotted circle indicates the reflection coefficient. The outermost circle represents the 

reflection coefficient with a value of 1. The center of the circle represents the reflection 

coefficient with a value of 0. 

⚫ The radial line shows the phase angle of the reflected signal. The right-most position 
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corresponds to the zero-phase angle (that is, the reflected signal has the same phase as the 

incident signal). The phase differences of 90°, ±180°, and -90° correspond to the top, 

leftmost, and bottom of the polar display, respectively. 

 

6.7.4 Smith circle diagram 

Smith diagrams are a tool for mapping complex reflectance coefficients to test the impedance of 

equipment. In the Smith chart, the linear impedance plane is reshaped to form a cyclic grid from 

which the resistance and reactance (R+ Jx) can be read. 

You can use a cursor to display the following items: 

⚫ Resistance (in Ohms) 

⚫ Reactance as equivalent capacitance (in Ephraeras) or inductance (in Henrys) 
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Figure 6-5 Schematic diagram of Smith circle 

 

There is also a Reverse Smith circle diagram (also called an Admittance Smith Chart): 

Same as the standard Smith circle, with the following exceptions: 

⚫ The polar grid is reversed from right to left. 

⚫ Admittance (in Siemens) instead of resistance. 

 

Smith diagram interpretation: 
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Constant 

Reactance

Constant
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Figure 6-6 Schematic diagram of Smith circle 

 

⚫ Each point on the Smith chart represents a complex impedance (r±jx) consisting of a real 

resistance (r) and an imaginary reactance (x). 

⚫ The horizontal axis (solid line) shows the real part of the difference between impedance and 

resistance. The horizontal axis always represents the system impedance. The rightmost 

value is infinite ohms (open path). The leftmost value is zero ohms (short circuit). 

⚫ The dotted circle intersecting the horizontal axis represents a constant resistance. 

⚫ A dashed arc tangent to the horizontal axis represents a constant reactance. 

⚫ The top half of Smith's circle is the region where the reactance component is positive and 

hence inductance is generated. 

⚫ The lower half is the region where the reactance component is negative and therefore 

generates capacitance. 
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6.8 Scale 

6.8.1 Scale/reference level and position 

The “Scale”, “Reference Level”, and “Reference Position” Settings (as well as the format) 

determine how the data trace will appear on the vector network analyzer screen. 

Operating steps: 

Press Scale, Use the knob or arrow keys to focus on the reference level and reference position 

parameter items under the Scale menu bar. Press ENTER or the knob to enter the parameter 

editing state, then move the cursor to the specified position by the up and down arrow keys or the 

knob, and press ENTER or the knob to select the current option. 

 

Scale: Sets the vertical indexing value of the rectangular coordinate display format. In polar 

coordinates and Smith chart formats, the scale sets the value of the outer perimeter. Range: 0.001 

dB/div to 1000 dB/div. Scale do not apply in logarithmic scale type. 

 

Automatic scaling: Automatically sets the vertical indexing value and reference value to fit the 

working data trace in the screen grid area. The excitation value and reference position are not 

affected. The vector network analyzer determines the minimum possible scaling factor that will 

allow all display data to appear on the 80% vertical grid. The selected reference values center the 

trace on the screen. 

 

All autoscaling: Automatically scales all data traces in the working window to fit vertically into the 

grid area of the screen. 

 

Reference level: Sets the value of the guide in rectangular format. Range: -1000dB to 1000dB. In 
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polar coordinates and Smith's circle chart formats, and logarithmic scale type, the reference level 

does not apply. 

 

Reference position: Sets the position of the guide in Rectangular coordinate format. Zero is the 

bottom line and 10 is the top line. The default position is 5 (middle of the screen). Reference 

positions do not apply in polar coordinates, Smith chart formats and logarithmic scale type. 

 

6.8.2 Scaling coupling 

When “Scale Coupling” is enabled, tracks of the same format will have the same “Scale”, 

“Reference Level”, and “Reference Position”. You can choose to couple the scales for traces in the 

same window, for all traces in all Windows, or uncouple them. 

Operating steps: 

Press Scale, use the knob or arrow keys to focus on the Scale → Scale Coupling parameter item. 

Press ENTER or Knob to enter the editing state, select Off / Window / All, then move the cursor to 

the specified position by up and down arrow keys or Knob, press ENTER or Knob to select the 

current option 

Note: Traces of the same format have the same scale, reference level, and reference position. 

 

Coupling Method: 

Close: No coupling. Each trace is scaled individually. This is the default setting. 

Window: All traces of the same format in each selected window share the same scale settings 

All: Coupled between all selected windows, all traces of the same format in all selected windows 

share the same scale settings. 

⚫ When window or full coupling is enabled, the scale settings for the working trace will be 
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adopted by other coupling traces of the same format 

⚫ If traces of a different format exist, all traces of that format will be set as the least 

numbered trace in that format 

⚫ Once enabled, the scale settings for all coupling traces of the same format can be 

changed with any coupling trace in the working state 

 

Selected Windows: 

Available when selecting a window or all methods. The selected window participates in scaling 

coupling. By default, all windows are selected. Cancel the check box to disable zoom coupling for 

this window. 

About “Auto Scaling” and “Scaling Coupling”: 

Automatic scaling using the coupling method affects the work trace in the work window. All 

traces coupled to this trace will be set with the new scale of the working trace. This will cause 

some traces to not appear on the screen. 

Full automatic scaling using the coupled method 

⚫ Close: All traces in the working window are automatically scaled separately. 

⚫ Window: All traces in each selected window are automatically scaled to conform to a 

common set of scaling factors. 

⚫ All: All traces in all selected Windows are automatically scaled to conform to a common set 

of scaling factors. 

 

6.8.3 Electrical delay 

Electrical delay is a mathematical function that simulates the variable length of a lossless 

transmission line. Linear phase shifts through the device can be compensated using the electrical 
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delay function. Use this feature to determine only the linear phase deviation of the device. 

Electrical delay can be set separately for each measuring trace. 

Operating steps: 

Press Scale, use the knob or arrow key to bring focus to the Electrical Delay parameter item. 

Press ENTER or Knob to enter the editing state. After the editing is completed, move the cursor 

to the specified position by up and down direction keys or Knob. Press ENTER or Knob to select 

the current option. 

 

Delay time: Specifies the value of the delay added or removed, expressed in time or distance. 

This compensates for the linear phase shift through the device. Electrical delay can be set 

separately for each measuring trace. 

Speed coefficient: Specify the velocity factor applied to the device media inserted after 

measurement calibration. The value is 0.66 for polyethylene insulated cables and 0.7 for PTFE 

insulators.1 corresponds to the speed of light in a vacuum. 

Distance unit: Select meters, inches, or feet. When you change this value, the step size does not 

change automatically. 

Media: Select the media for the added length, including the following menu: 

⚫ Coax: Select if the added length is coax. Also specify the velocity factor of the coax. 

⚫ Waveguide: Select if the added length is waveguide. Also specify the low frequency cutoff 

of the waveguide. 

⚫ Wavegd Cutoff: Low frequency cutoff of the waveguide. 

 

6.8.4 Amplitude offset and amplitude slope 

The “amplitude offset” allows the amplitude (rather than phase) data to be offset by a fixed or 

slope value in Db. The amplitude offset setting affects only the work trace. If the display format is 
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“Linear Amplitude” or “Real Number” (unitless), the dB is converted and the correct offset is 

implemented. 

Operating steps: 

Press Scale, use the knob or arrow keys to bring focus to the Constants → Mag Offset / Mag 

Slope parameter item. 

Press ENTER or Knob to enter the editing state. After the editing is completed, move the cursor 

to the specified position by up and down direction keys or Knob. Press ENTER or Knob to select 

the current option. 

 

Amplitude deviation: Offset the entire data trace at the specified value. 

Margin slope: Offset the data trace by some value that changes with frequency. The offset slope 

starts at 0 Hz. 

 

6.8.5 Phase deviation 

Phase offset mathematically adjusts the phase measurement to a specified degree (up to 360°). 

This feature can be used in the following ways: 

⚫ Improved display of phase measurements. This is the same way as changing the reference 

level in the amplitude measurement. Change the phase response to the center or align the 

response on the screen. 

⚫ Simulate Projection phase shift in measurements. For example, if you know that you need to 

add a cable and that the length of the cable will add a certain phase shift to the 

measurement, you can use a phase shift to increase the length and simulate the entire 

device measurement. 
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Key operation: 

Press Scale, use the knob or arrow keys to bring focus to the Constants → Phase Offset 

parameter item. Press ENTER or Knob to enter the editing state. After the editing is completed, 

move the cursor to the specified position by up and down direction keys or Knob. Press ENTER 

or Knob to select the current option. 

 

6.8.6 Divisions 

Sets the number of divisions on the Y axis. An even number from 4 to 30 must be used. Once set, 

it is commonly applied to all the traces displayed in the linear scale type on the Y axis within that 

window.  

Operating steps: 

Press Scale, use the knob or arrow keys to focus on the Advanced → Divisions parameter item. 

Press ENTER or Knob to enter the editing state. Set the value of the Y-axis divisions in the 

Cartesian coordinate format. After the editing is completed, move the cursor to the specified 

position by up and down direction keys or Knob. Press ENTER or Knob to select the current option. 

Range: even numbers from 4 to 30. Divisions do not apply in polar coordinates, Smith chart 

formats and logarithmic scale type. 

 

6.8.7 Scale type 

The scale types include linear scale and logarithmic scale, which are expressed as the scale 

distribution of the Y axis in the coordinate system. In a logarithmic scale type, the upper and 

lower limits of the Y-axis determine how the data trace is displayed on the VNA screen. The 

scale type can be set separately for each measuring trace. 

Operating steps: 
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Press Scale, use the knob or arrow keys to focus on the Advanced → Scale Type parameter item. 

Press ENTER or Knob to enter the editing state. After the editing is completed, move the cursor 

to the specified position by up and down direction keys or Knob. Press ENTER or Knob to select 

the current option. 

Note: The logarithmic scale type can only be selected when the display format is linear 

magnitude scheme, real number format or imaginary number format. Other formats are linear 

scale type. 

 

Scale type: 

● Linear Scale Type 

● Log Scale Type 

Linear: Y-axis scale linear distribution. The display mode can be set by setting scale, reference 

level and position. 

Log: The Y-axis scale is logarithmic. The display range can be set by setting the maximum and 

minimum values of the Y axis. 

Max Value: Set the upper limit of the Y-axis in the logarithmic scale type. 

Min Value: Set the lower limit of the Y-axis in the logarithmic scale type. 

 

6.9 Avg BW 

6.9.1 Overview 

The dynamic range is the finite difference between the maximum input power level and the 

minimum measurement power level (noise floor) of the analyzer. In evaluating a characteristic 

accompanied by a large change in the amplitude (the start and stop band of a filter for example), 

it is important to increase the dynamic range. The noise floor can be reduced by narrowing the IF 
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bandwidth or turning on Sweep Averaging. 

For minimizing very low noise, Averaging is more effective than reducing IF bandwidth. Generally, 

Averaging takes slightly longer than IF bandwidth reduction to lower noise, especially if many 

averages are required. Also, changing the IF bandwidth after calibration results in uncertain 

accuracy. 

 

6.9.2 Averaging 

Averaging is a feature that the VNA averaging on each data point before stepping to the next 

data point. You determine the number of measurements by setting the averaging factor. The 

higher the averaging factor, the greater the amount of noise reduction. 

Averaging setting: 

Press the “Avg BW” key, then enter the Averaging and Bandwidth menu. 

 

Figure 6-7 Avg BW menu 

 

A. Averaging Enable. 

B. Sweep Averaging factor. (an integer 

between 1 and 999) 

C. Averaging Restart. Restart the 

Sweep Averaging from 1. 

 

 

6.9.3 IF Bandwidth 

The received signal of VNA is converted from its source frequency to a lower intermediate 
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frequency (IF). Reducing the IF receiver bandwidth reduces the effect of random noise on a 

measurement. Each tenfold reduction in IF bandwidth lowers the noise floor by 10 dB. However, 

narrower IF bandwidths cause longer sweep times. 

IF Bandwidth setting: 

1. Using the Softkey for setting: Press the “Avg BW” key, Press “Avg BW” > Averaging > IF 

Bandwidth > Enter the IF Bandwidth value. 

 

Figure 6-8 Set the IF from the menu bar 

 

2. Using a mouse for setting: Click the “BW=xx” icon on the menu bar and select IF Bandwidth. 
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Figure 6-9 Set the IF from the status bar 

 

6.9.4 Smoothing 

Trace smoothing averages several adjacent data points to smooth the displayed trace. The 

number of adjacent data points that get averaged together is also known as the smoothing 

aperture. You can specify the aperture as either the number of data points or the percentage of 

the x-axis span. 

Trace Smoothing reduces the peak-to-peak noise values on broadband measured data. It 

smooths trace noise and does not increase measurement time significantly. 

 

Smoothing setting: 

Using the Softkey for setting: Press the “Avg BW” key, “Avg BW” > Smoothing then enter the 

Smoothing menu. 
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Figure 6-10 Smoothing menu 

 

A. Smooth On|Off When is On, applies smoothing 

to the displayed trace. 

B. Percent of Smooth: Specify the percent of the 

swept stimulus span to smooth. For example, 

for a trace that contains 100 data points, and a 

smoothing percent of span = 11%, then the 

number of data points that are averaged is 11. 

C. Smooth Points: Specify the number of 

adjacent data points to average. 

 

 

Tips: 

⚫ Start with a high number of display points and reduce until you are confident that the trace 

is not giving misleading results. 

⚫ Do not use smoothing for high-resonance devices, or devices with wide trace variations.  

⚫ It may Smoothing is set independently for each trace. 

 

6.10 Preset instructions 

Invokes preset Settings to restore system Settings to the specified just started state. 

Operating instructions: 

⚫ Preset types are available through Preset → Preset Option, Select “Default”, “Last”, or 

“User”. 

⚫ Press the Preset key, and the device invokes either default Settings or user Settings. 
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Table 6-1 Some default setting values 

Take SNA5084A for example: 

Parameter name Parameter value 

RF Power 

RF state ON 

RF level 0 dBm 

Signal output port Port 1 

Port coupling ON 

Frequency 

Frequency range 100 kHz-8.5 GHz 

Frequency step size 42.4995MHz 

Frequency points 201 

Sweeping 

Sweeping points 201 

Sweeping type Linear frequency 

Sweeping time delay 0 s 

Sweeping mode automatic 

Trigger 

Trigger mode continuous 

Trigger source internal 

Measurement 

S parameter S11 

Display format 

Data display format Log Mag 
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Scale 

Scale 10 dB 

Reference level 0 dB 

reference position 5 

Scale coupling OFF 

Delay time 0 s 

Delay distance 0 m 

Distance unit meter 

Speed coefficient 1 

System impedance 50 Ω 

Phase deviation 0° 

Amplitude deviation 0 dB 

Average 

Average state OFF 

Smooth state OFF 

Calibration 

Calibration state Unloaded calibration data 
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7 Measurement Calibration 

7.1 Overview 

Usually, DUTs can't be measured directly and accurately due to cabling, adapters, probes, and 

more. Calibration, compensation, and fixture simulation are introduced to help achieve higher 

accuracy. These functions meet different measurement requirements, but they all can be 

expressed as a matrix multiplication of the scattering parameter matrix and a specific 

compensation matrix. The order of the matrix multiplication has a large influence on the result. 

So it's important to understand the order of applying these functions and to design a suitable 

physical connection to the DUT and expected measurement network. 

Internal source power calibration and receiver calibration are applied before the scattering 

parameter calculation, and the S parameter calibration is applied to the calculation results. This 

provides the highest measurement accuracy at the calibration reference plane.  

From the reference plane, the order of applying functions is as follow: 

 

 

Figure 7-1 The order of applying functions 

 

At first, adapter removal/ insertion, port extension, 2-port de-embedding are applied to remove 
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the needless networks in the physical connections of the DUT and move the measurement plane 

to the DUT. Then, Port match, N-port embedding/ de-embedding, port impedance conversion 

are used to embed or de-embed expected virtual networks. If balance scattering parameters are 

measured, balance conversion, differential port match, differential port impedance conversion, 

common port impedance conversion can be helpful if needed.  
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7.2 Calibration type 

The following table is a comparison of some common S-parameter calibration types: 

Table 7-1 S-parameter calibration types 

Calibration type precision Allow pass-through methods 

TRL Very high All, except the unknown direct 

SOLT high All 

Enhanced Response high 
Defined through or flush through (zero-length 

through) 

Port 1 (reflection) high Not Applicable 

Open Circuit Response/ 

Short Circuit Response 
low Not Applicable 

Direct Response low 
Known through or flush through (zero-length 

through) 

 

The following are the actual S-parameter calibration types used by this vector network analyzer. 

Table 7-2 The vector network analyzer S parameter calibration types 

Port number Calibration type Calibration item 

Port 1 

Response (Open) Open, Load (optional) 

Response (Short) Short, Load (optional) 

OSL Open, Short, Load 

Port 2 

Response (Thru) 1 → 2 Thru, Isolation (optional) 

Response (Thru) 2 → 1 Thru, Isolation (optional) 

Enhanced Response (Thru) 1 → 2 
Port1:Open, Short, Load 

Thru, Isolation (optional) 
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Enhanced Response (Thru) 2 → 1 
Port2:Open, Short, Load 

Thru, Isolation (optional) 

SOLT 

Port1: Open, Short, Load 

Port2: Open, Short, Load 

Thru, Isolation (optional) 

SOLR 

Port1: Open, Short, Load 

Port2: Open, Short, Load 

Unknown Thru, Isolation (optional) 

TRL 

Port1: Reflect (Open or Short) 

Port2: Reflect (Open or Short) 

Thru, Line 

 

TRL:  

Application: Used to precisely calibrate any pair of ports when no calibration kits are readily 

Available. 

Note: Difference matching calibration may be required (Delta Match Cal) 

Overall accuracy: Very high 

Calibration kits required: Straight, reflection, line, or similar combination 

Corrected system error: 

⚫ Directivity 

⚫ Isolation 

⚫ Frequency response  

transmission tracking 

⚫ Source match 

⚫ Load match 

⚫ Frequency response  

reflection tracking 

 

SOLT : 
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Application: Used to accurately calibrate any number of ports 

Overall accuracy: High 

Required calibration kits: short circuit, open circuit, load, through) or ECAL electronic calibration 

parts module 

⚫ Directivity 

⚫ Isolation 

⚫ Frequency response  

transmission tracking 

⚫ Source match 

⚫ Load match 

⚫ Frequency response  

reflection tracking 

 

Enhanced Response: 

Application: Calibrate two ports when only one direction (forward or reverse) is needed for 

measurement. Because no secondary sweep is required, the measurement is faster. 

⚫ The reflection calibration element (open, short circuit, or load) is connected to the source 

port to be calibrated. 

⚫ The defined through-through or flush through-through calibrator kits are connected 

between port pairs. 

⚫ The mechanical calibration kit is much faster than the SOLT. You can also use ECAL. 

 

To select an enhanced response, do the following: 

Keys operation: Press Cal, using the knob or arrow keys, to focus on the Cal → Basic Cal parameter 

item. Select port1 & port2 from the interface menu, Select Enhanced Response 1 → 2 or Enhanced 

Response 2 → 1 in the Cal Type, Press ENTER or the knob to select the current option. 

Overall accuracy: High 

Required calibration kits: Short circuit, open circuit, load, defined through or flush through 
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Corrected system error: 

⚫ Directivity (Source port) 

⚫ Isolation 

⚫ Frequency response transmission tracking (receiver port) 

⚫ Source match (source port) 

⚫ Load matching (receiver port) is used only to generate transmission trace items 

⚫ Frequency response reflection tracking (source port) 

 

One port (reflection): 

Application: Used to accurately calibrate any test port suitable for reflection measurement only 

Overall accuracy: High 

Required calibration kits: Short circuit, open circuit, and load or ECAL module 

Corrected system error: 

⚫ Directivity 

⚫ Frequency response reflection tracking 

⚫ Source match 

 

 

Open circuit response / short circuit response: 

Application: Quick calibration of any test port suitable for reflection measurement only 

Overall accuracy: Low 

Calibration kits required: Open circuit or short circuit. 

Corrected system error: 
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⚫ Frequency response reflection tracking 

 

Direct / Transport Tracking (isolation optional): 

Application: Quick calibration of any pair of test ports suitable for transmission measurements 

only. Isolation calibration is generally not recommended. 

Overall accuracy: Low 

Required calibration kit: Through 

Isolation: Each load corresponds to a vector network analyzer test port. 

Corrected system error: 

⚫ Isolation 

⚫ Frequency response transmission tracking 

Power calibration types: Transmitter calibration (internal source power calibration) and receiver 

calibration. 

 

7.3 Checking Calibration Status 

7.3.1 Execution Status of Error Correction for Each Channel 

User can check the execution status of error correction for each channel with the error correction 

status. 

The error correction status is indicated in the channel status bar in the lower part of the window 

by the symbols in the below table. 

Symbol Execution Status of Error Correction Accuracy 

No Cor Error correction: Off (No Correction) Lowest 
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C N-Port Error correction: On (Full N Port Correction) Highest 

C* N-Port Error correction: On (Interpolation is being executed) Uncertain 

CΔ N-Port Error correction: On (Stimulus settings change) Uncertain 

 

No Cor 

It indicates there is no Correction. The following will cause the VNA to turn Error Correction OFF 

for the channel: 

⚫ Decrease the start frequency. 

⚫ Increase the stop frequency. 

⚫ Increase number of points  

⚫ Change sweep type. 

 

C N-Port 

Full N Port correction, where N is the number of fully calibrated ports. This correction is applied to 

S Parameters. 

 

C* N-Port 

"C* " appears in the status bar when a measurement is being interpolated. Interpolation occurs 

when you change any of the following settings: 

⚫ Start frequency increased 

⚫ Stop frequency decreased 

⚫ Number of points 

Note: Decreasing the start frequency, or increasing the stop frequency will always turn correction 

OFF. 
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CΔ N-Port 

"CΔ" appears in the status bar when one or more of the following stimulus settings change. The 

resulting measurement accuracy depends on which parameter has changed and how much it 

has changed. For optimum accuracy, recalibrate using the new settings. 

⚫ Sweep time 

⚫ IF Bandwidth 

⚫ Port power 

 

7.3.2 Execution Status of Error Correction for Each Trace 

User can check the status of the error correction actually executed for each trace with the trace 

status area. 

For a trace for which error correction is executed, the applied calibration type is indicated in the 

trace status area by the symbols in the table below. 

Symbol Calibration type 

RO Open response calibration 

RS Short response calibration 

RT Thru response calibration 

ER Enhanced response calibration 

F1 1-port calibration 

F2 Full 2-port calibration/2-port TRL calibration 

F3 Full 3-port calibration/3-port TRL calibration 

F4 Full 4-port calibration/4-port TRL calibration 
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Note: If none of the symbols described above is displayed, error correction is not executed for 

the trace. 

 

7.3.3 Acquisition Status of Calibration Coefficient for Each Channel 

User can check the acquisition status of the calibration coefficient for each channel with the 

calibration property. 

The calibration property displays the acquisition status of the calibration coefficient between test 

ports for each channel in matrix format. The following figure shows an example of when the 

calibration coefficients have been acquired for the full 2-port calibration between test ports 1 and 

2, the response calibration for test port 3, and the response calibration (THRU) between test ports 

4 and 3. 

  

F : Full Port Calibration 

R : Response Calibration 

-- : Nothing  
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7.3.4 Procedure to turn on/off calibration property display 

There are two methods to turn on/off the display of calibration property. 

Method 1: Click the channel error correction execution status symbol in the channel status bar to 

open and close, as shown in the left figure below. 

Method 2: Press "Cal” on the front panel > Cal > Correction, as shown in the right figure below. 

 

 

 

 

7.4 Basic Cal 

S parameter user calibration can be started after selecting the required S parameter calibration 
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type in the calibration wizard and setting the corresponding parameters. 

Operating instructions: 

Press the Cal key, use the knob or the arrow key to make the focus fall on Basic Cal, and press 

Enter to enter the setting interface of the calibration kit: 

 

 

Figure 7-2 Calibration wizard interface 

 

Select the number of ports to be calibrated from the port menu in the calibration wizard 

interface, and select the corresponding calibration kit model in the Cal Kit pull-down option. 

Select the gender properties of the calibration connector from the DUT Connector drop-down 

option, and select the corresponding calibration method from the Cal Type drop-down option, 

as shown in the figure below: 
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Figure 7-3 Calibration wizard interface 

 

After the calibration is set, a specific calibration item interface will appear as shown in the figure 

below. Here, taking the two-port SOLT calibration method as an example, it includes several 

calibration items: OPEN, SHORT, LOAD, THRU, ISOLATION, among which the ISOLATION 

calibration item may not be calibrated. There is no sequence relation between these calibration 

terms. Simply select the corresponding calibration kit and click the corresponding calibration item 

menu on the interface.  

After completion of the corresponding calibration item, the percentage of calibration progress 

will be displayed in the lower-left corner of the interface. When all the calibration steps are 

completed, the calibration progress bar will show 100%. Click Finish to exit the calibration 

interface, calibration results are automatically loaded in the current screen. 
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Figure 7-4 Calibration wizard interface 

 

To Save the current calibration data for future use, press the Save Recall button and use the knob 

or arrow keys to bring the focus to the Save State menu bar. Select State+Cal Data from the Save 

Type drop-down option, click Save State As and enter the file name, and click OK to Save the 

current calibration Data and the current setting State. 

 

 

Figure 7-5 Calibration wizard interface 

7.4.1 Open Response Calibration 

When a single port is used for open-circuit response calibration, the reflection tracking error in 

the error model of the test device can be calculated by only connecting the OPEN calibration 
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element to the test port. If the LOAD calibration element is used for isolation calibration at the 

same time, the directional error can be calculated. 

 

 

Figure 7-6 Schematic diagram 

 

Operating steps: 

1. Preset vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band and 

other parameters. 

3. Select Cal → Basic Cal to enter the Settings screen. 

4. Select only Port1 or Port2, select the required calibration kit in the Cal Kit, select the Type of 

calibration element connector, Female or Male, in the DUT Connector, select 

Response(Open) in the Cal Type, and click Next to proceed to the next step. 

5. Connect the OPEN calibration element to the test port according to the interface prompts, 

click Open for calibration, and click Finish to exit the calibration interface after calibration, 

complete the calibration, and save the calibration data. 
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7.4.2 Short circuit response calibration 

Like the open-circuit response calibration, the single-port short-circuit response is connected to 

the port with the SHORT calibration element, and the reflection tracking error can be calculated. 

If the LOAD calibration element is used for isolation calibration at the same time, the directional 

error can also be calculated. 

 

Operating steps: 

1. Preset Vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band and 

other parameters. 

3. Select Cal → Basic Cal to enter the setting interface. 

4. Select only Port1 or Port2, select the required calibration kit in the Cal Kit, select the Type of 

connector, Female or Male, in the DUT Connector, select Response(Short) in the Cal Type, 

and click Next to proceed to the next step. 

5. Connect the Short calibration element to the test port according to the interface prompts, 

click Short for calibration, and click Finish to exit the calibration interface, complete the 

calibration, and save the calibration data. 

 

7.4.3 Full 1 port OSL calibration 

All 1-port OSL calibration connects the OPEN, SHORT, and LOAD calibration elements to the test 

ports in turn to calculate the reflection tracking error, directional error, and source matching error 

in the error model of the test device. 
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Figure 7-7 Schematic diagram 

 

Operating steps: 

1. Preset Vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and 

other parameters. 

3. Select Cal → Basic Cal to enter the setting interface. 

4. Select only Port1 or Port2, select the desired calibration kit in the Cal Kit, select the Type of 

calibration connector, Female or Male, in the DUT Connector, select OSL (Open, Short, Load) 

in the Cal Type, and click Next to proceed to the next step. 

⚫ Connect the OPEN calibration element to the test port according to the interface 

prompts.  

⚫ Click Open for calibration 

⚫ Then connect the SHORT calibration element to the test port, click Short for Calibration.  

⚫ Finally, connect the LOAD calibration element to the test port, click the Load for 

Calibration.  

⚫ After the calibration, click Finish to exit the calibration interface, complete the 

calibration, and save the calibration data. 
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7.4.4 Transmission response calibration (two ports) 

Two-port transmission response calibration is to connect the THRU calibration kit between two 

ports to calculate the transmission tracking error in the test device error model. If the LOAD 

calibration kit is used for isolation calibration at the same time, isolation error (crosstalk error) can 

also be calculated. 

 

 

Figure 7-8 Schematic diagram 

 

Operating steps: 

1. Preset Vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and 

other parameters. 

3. Select Cal → Basic Cal to enter the setting interface. 

4. Select both Port1 and Port2, select the desired calibration kit in the Cal Kit, select the Type 

of calibration connector, Female or Male, in the DUT Connector, Select Response (Thru) 1 → 

2 or Response(Thru) 2 → 1 in the Cal Type (the difference is to test S21 or S12), and click 

Next to proceed to the next step. 

5. Connect the Thru calibration element between the test ports according to the interface 

prompts, click Thru for calibration, and click Finish to exit the calibration interface, complete 
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the calibration, and save the calibration data. 

 

7.4.5 Enhanced response calibration (two ports) 

Two-port enhanced response calibration connects the Thru calibration element between two 

ports, and only connects the Open, Short, and Load on one port for calibration, or connects the 

LOAD element to both ports for isolation calibration. 

 

Operating steps: 

1. Preset Vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and 

other parameters. 

3. Select Cal → Basic Cal to enter the setting interface. 

4. Select both Port 1 and Port 2, select the desired calibration kit in the Cal Kit, select the type 

of calibration connector, Female or Male, in the DUT Connector, Select Enhanced Response 

1 → 2 or Enhanced Response (Thru) 2 → 1 in the Cal Type (the difference is that S21 or S12 

is tested during THRU calibration), and click Next to proceed to the next step. 

5. According to the interface prompts, connect Open, Short, and Load on a test port to 

complete the calibration successively, and then connect the THRU calibration kit between 

the two ports to perform the Thru calibration. After the calibration is completed, click Finish 

to exit the calibration interface, complete the calibration and save the calibration data. 

 

7.4.6 SOLT calibration (two ports) 

Two-port SOLT calibration connects the Open, Short, and Load calibration elements to each test 

port in turn and the THRU calibration kit between the two test ports. All 12 error parameters of the 
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two ports can be calculated, including 6 forward and 6 reverse errors, including directional, source 

matching, reflection tracking, transmission tracking, isolation (crosstalk), and load matching errors. 

It is also possible to connect the LOAD element to both ports for isolation calibration. 

 

 

Figure 7-9 Error model diagram 

 

Operating steps: 

1. Preset vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and 

other parameters. 

3. Select Cal → Basic Cal to enter the Settings screen. 

4. Select both Port 1 and Port 2, select the desired calibration kit in the Cal Kit, select the type 

of calibration connector, Female or Male, in the DUT Connector, select SOLT in the Cal Type, 

and click Next to proceed to the next step. 

5. According to the interface prompts, connect the Open, Short, and Load calibration elements 

to Port 1 successively, and click the corresponding Open, Short, and Load items successively 

to complete the Port 1 calibration. 
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6. According to the interface prompts, connect the Open, Short, and Load calibration elements 

to Port2 successively, and click the corresponding Open, Short, and Load items successively 

to complete the Port 2 calibration. 

7. According to the interface prompts, connect the THRU calibration kit between the two ports 

to perform the Thru calibration. 

8. After the calibration, click Finish to exit the calibration interface, complete the calibration, 

and save the calibration data. 

 

7.4.7 SOLR unknown through calibration (two ports) 

In contrast to the two-port SOLT calibration, the error term in the test unit can be calculated 

without knowing the S-parameter of the THRU straight-through calibration. The calibration 

method is similar to that of SOLT in that it is possible to connect the LOAD to both ports for 

isolated calibration. 

 

Operating steps: 

1. Preset vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and 

other parameters. 

3. Select Cal → Basic Cal to enter the Settings screen. 

4. Select both Port 1 and Port 2, select the desired calibration kit in the Cal Kit, select the Type 

of calibration Connector, Female or Male, in the DUT Connector, select SOLR in the Cal 

Type, and click Next to proceed to the next step. 

5. According to the interface prompts, connect the Open, Short, and Load calibration elements 

to Port 1 successively, and click the corresponding Open, Short, and Load items successively 
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to complete the Port 1 calibration. 

6. According to the interface prompts, connect the Open, Short, and Load calibration elements 

to Port 2 successively, and click the corresponding Open, Short, and Load items successively 

to complete the Port 2 calibration. 

7. Connect the THRU calibration kit between the two ports according to the interface prompts. 

The parameters of the THRU do not have to be known. Carry out unknown through Thru 

calibration. 

8. After the calibration, click Finish to exit the calibration interface, complete the calibration, 

and save the calibration data. 

 

7.4.8 TRL Direct Reflection Transmission Line Calibration (Two Ports) 

The two-port TRL calibration method does not need to know the index parameters of the 

calibration kit, and all the error items in the error model of the test device can be figured out 

through three simple connection methods. TRL calibration scheme will use the THRU straight 

through calibration element, reflection calibration kit (Open or Short), and a small section of 

transmission line. 

Operating steps: 

1. Preset vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and 

other parameters. 

3. Select Cal → Basic Cal to enter the Settings screen. 

4. Select both Port 1 and Port 2, select the desired calibration kit in the Cal Kit, select the Type 

of calibration kit Connector, Female or Male, in the DUT Connector, select TRL in the Cal 

Type, and click Next to proceed to the next step. 
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5. According to the interface prompts, connect the THRU calibration kit, Reflect(Open or Short) 

calibration element, and Line on a Port 1 in turn, and click the corresponding Thru, Reflect, 

and Line items in turn to complete the Port 1 calibration. 

6. According to the interface prompts, connect the THRU calibration element, Reflect(Open or 

Short) calibration element, and transmission line on a Port 2 in turn, and click the 

corresponding Thru, Reflect, and Line items to complete the Port 2 calibration. 

7. After the calibration, click Finish to exit the calibration interface, complete the calibration, 

and save the calibration data. 

7.4.9 Partial Overwrite calibration 

When the ports are calibrated, some error items in the error model may be not acceptable. 

For unacceptable error items, the partial overwrite calibration chooses suitable calibration items 

to calibrate the ports again. Taking the two-port SOLT calibration as an example, the following 

describes the partial overwrite calibration for achieving full two-port open calibration after 

completing full two-port SOLT calibration. 

Operating steps: 

1. Select Cal → Basic Cal to enter the Settings screen. 

2. Select both Port 1 and Port 2, select the desired calibration kit in the Cal Kit, select the 
type of calibration connector, Female or Male, in the DUT Connector, select SOLT in the 
Cal Type, and click Next to proceed to the next step. 

3. According to the interface prompts, connect the Open calibration element to Port 1, and 
click the corresponding Open item to complete the Port 1 open calibration.  

4. According to the interface prompts, connect the Open calibration element to Port 2, and 
click the corresponding Open item to complete the Port 2 open calibration. 

5. Click Overwrite to finish partial overwrite calibration. 

Notes 

1. Uncalibrated ports can’t be calibrated directly using partial overwrite calibration. 

2. Partial overwrite calibration requires that sweep points, IF bandwidth, and other 
parameters are the same as the values set by the previous calibration method. 
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7.4.10 All Cal 

The all-channel calibration function allows users to calibrate multiple channels in a single 
calibration process. This reduces both the number of connections required and the number of 
calibration standard measurements that must be performed. The existing all-channel calibration 
supports STD mode, SA mode, GC mode, and other modes, facilitating various measurements. 

 

After initiating all-channel calibration, calibration data is acquired across all channels under the 
same IFBW and port power. After calculating the error coefficients, different calibration datasets 
are assigned to each channel based on its configuration. It is important to note that all channels 
to be calibrated must have the same calibration reference plane; the all-channel calibration 
function cannot compensate for errors caused by external path changes to the VNA. The 
parameter configuration and calibration process for all-channel calibration are detailed below. 

 

The image below shows the channel port selection dialog box. The left menu shows the channels 
that can be calibrated. After selecting a channel, you can choose whether to calibrate that channel, 
i.e., whether the Enabled checkbox is selected. Use the Ports menu on the right to select the port 
that needs to be calibrated for that channel. 

 

The channel port selection 

 

The following image shows the attribute configuration dialog box. By configuring the calibration 
attributes, you can determine the measurement parameters during calibration. Different modes 
have different attributes, as detailed in the table. 
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The attribute configuration 

 

STD Include Power Calibration 

 Independent Calibration Channels 

SA Calibration Span 

 Calibration Points 

MT Include Power Calibration 

 Independent Calibration Channels 

GC Independent Calibration Channels 

GCX Independent Calibration Channels 

SMM Independent Calibration Channels 

Attribute description 

 

The following figure shows the port power configuration dialog box, which is used to configure the 
power of each port during S-parameter sweeping, as well as the IFBW during sweeping. 
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The port power configuration 

 

The image below shows the power meter configuration dialog box, used to set the power meter 
connection port and the port power during power sweep. 

 

The power meter configuration 

 

The image below shows the calibration kit configuration dialog box. In this interface, you select the 
calibration category, port calibration kit, and port gender, similar to the parameter configuration 
for basic calibration. The ports to be configured include all ports that require calibration. 
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The calibration kit configuration 

 

After completing the above parameter configuration, connect the power meter and calibration kit 
according to the described steps, perform measurements and calculations, and you can calibrate 
each channel. 

 

7.5 Cal Kit management 

7.5.1 Overview 

For most applications, the default calibration kit models provide sufficient accuracy for your 

calibration. However, several situations may exist that would require you to create a custom 

calibration kit: 

⚫ Using a connector interface different from those used in the predefined calibration kit 

models. 

⚫ Using standards (or combinations of standards) that are different from the predefined 

calibration kits. For example, using three offset SHORTs instead of an OPEN, SHORT, and 

LOAD to perform a 1-port calibration. 

⚫ Improving the accuracy of the models for predefined kits. When the model describes the 

actual performance of the standard, the calibration is more accurate. For example, A 7 mm 
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LOAD is determined to be 50.4 Ω instead of 50.0 Ω. 

⚫ Modifying the THRU definition when performing a calibration for a non-insertable device. 

⚫ Performing a TRL calibration. 

 

Operation instructions: 

Press “Cal” on the front panel, Cal > Cal >Cal Kit to enter the Manage Cal Kits page. You can edit, 

import, and create or delete calibration kits. 

 

 

Figure 7-10 Manage Cal Kits 

 

A. Edit the Existing Cal Kit. 
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B. Import the customized Cal Kit. 

C. Save the existing Cal kits and change the file name. 

D. Create a new custom Cal Kit. 

E. Select the Cal Kit. 

F. Save the current Cal kits (both factory and custom). 

G. Recall the Cal Kits. 

H. Restore the default factory Cal kits. 

 

7.5.2 Connector Tab 

At the bottom of each Tab, 'OK' is used to save the edited file, and 'Cancel' is used to close the 

calibration suite edit session and the file will not be saved. “Help” is used to view the Help 

documents. 
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Figure 7-11 The Connectors Tab interface 

 

A. Connector Family: Click the down arrow to select the connector family associated with the 

Cal Kit. 

B. Add: Starts the Add Connector dialog box which allows you to add a new connector type to 

the calibration kit. 

C. Select: The selected connector family. 

D. Frequency Range: Define the lowest and the highest frequency at which the standard is 

used for calibration. 

E. Gender: Gendered or Genderless 
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F. Impedance: Specify the impedance of the standard. 

G. Transmission Media: The medium of the connector, COAX or WAVEGUIDE 

 

7.5.3 Standards Tab 

Allows you to Add, Edit, or Delete Cal standards in a Cal kit. 

1) In the “Standard” tab, click “Add” to add the Standard sample. 

 

 

Figure 7-12 add standard interface 

 

2) Standards dialog box help, the following fields apply to ALL standard types. 
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Figure 7-13 The help dialog of the Standard 

 

A. Identification 

Standard ID: Number in list of standards 

Label: Type of standard. This usually appears in prompts for standards. 

Description: Description of standard. 

B. Connector 

Indicates the type and gender (Male, Female, None) of the standard. 

Thru and Isolation standards have two connectors. 

C. Frequency Range 

Min: Defines the lowest frequency at which the standard is used for calibration. 

Max: Defines the highest frequency at which the standard is used for calibration. 

D. Delay Characteristics 

Delay: Defines the one-way travel time from the calibration plane to the standard in 
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seconds. 

Z0: Defines the impedance of the standard. 

Loss: Defines energy loss in Gohms, due to skin effect, along a one-way length of coaxial 

cable. 

 

3) Open Standard 

C0, C1, C2, C3: Specify the fringing capacitance. 

 

 

Figure 7-14 Open Characteristics 

 

4) Short Standard 

L0, L1, L2, L3: Specify the residual inductance. 

 

 

Figure 7-15 Short Characteristics 

 

5) Load Standard 
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Figure 7-16 load Characteristics 

 

6) THRU Standard 

 

 

Figure 7-17 THRU Characteristics 

 

7.5.4 SOLT Tab 

Allows you to assign single or multiple standards to SOLT Calibration Classes. 

1) For each Cal Kit Class, select Available Standards from the left list, then click >> to copy the 

standard to the Cal Kit 

2) Use Move Up and Move Down to change the ORDER of the standards. 
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Figure 7-18 SOLT Tab dialog box 

 

7.5.5 TRL Tab 

Allows you to assign single or multiple standards to Calibration Classes. 

1) For each Cal Kit Class, select Available Standards from the left list, then click >> to copy the 

standard to the Cal kit. 

2) Use Move Up and Move Down to change the ORDER of the standards. 
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Figure 7-19 TRL dialog box 

 

A. TRL THRU 

All THRU calibration methods are supported in a TRL Cal EXCEPT Unknown Thru. 

⚫ The THRU standard can be either a zero-length or non-zero length. However, a zero-

length THRU is more accurate because it has zero loss and no reflections, by definition. 

⚫ The THRU standard cannot be the same electrical length as the LINE standard. 

⚫ If the insertion phase and electrical length are well-defined, the THRU standard may be 

used to set the reference plane. 

⚫ The THRU standard and LINE standard have the same characteristic impedance and are 

perfectly matched. They define the reference impedance of the calibration. 

⚫ If a THRU standard with the correct connectors is NOT available, an adapter removal cal 
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can be performed. 

 

B. TRL REFLECT 

⚫ The REFLECT standard can be anything with a high reflection, as long as it is the same 

when connected to one or more VNA ports. 

⚫ The REFLECT standard on each port is identical. 

⚫ The actual magnitude of the reflection need not be known. 

⚫ The phase of the reflection standard must be known within 1/4 wavelength. 

⚫ If the magnitude and phase of the reflection standard are well-defined, the standard 

may be used to set the reference plane 

 

C. TRL LINE 

The LINE and THRU standards establish the reference impedance for the measurement after the 

calibration is completed. TRL calibration is limited by the following restrictions of the LINE 

standard 

⚫ Must be of the same impedance and propagation constant as the THRU standard. 

⚫ The electrical length need only be specified within 1/4 wavelength. 

⚫ Cannot be the same length as the THRU standard. 

⚫ A TRL Cal with broad frequency coverage requires multiple LINE standards. For 

example, a span from 2 GHz to 26 GHz requires two lines standards. 

⚫ Must be an appropriate electrical length for the frequency range 

 

D. TRL MATCH 
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If the LINE standard of appropriate length or loss cannot be fabricated, a MATCH standard may 

be used instead of the LINE. 

⚫ The MATCH standard is a low-reflection termination connected to both Port 1 and Port 

2. 

⚫ The MATCH standard may be defined as an infinite length transmission line OR as a 1-

port low reflect termination, such as a load. 

⚫ When defined as an infinite length transmission line, both test ports must be terminated 

by a MATCH standard at the same time. When defined as a 1-port load standard, the 

loads are measured separately. The loads are assumed to have the same 

characteristics. 

⚫ The impedance of the MATCH standard becomes the reference impedance for the 

measurement. For best results, use the same load on both ports. The load may be 

defined using the data-based definition, the arbitrary impedance definition, or the fixed 

load definition. 

 

E. Calibration Reference Z0 

⚫ System Z0: The system impedance is used as the reference impedance. Choose when 

the desired test port impedance differs from the impedance of the LINE standard. Also, 

choose when skin effect impedance correction is desired for coax lines. 

⚫ Line Z0: The impedance of the line standard is used as the reference impedance or 

center of the Smith Chart. Any reflection from the line standard is assumed to be part of 

the directivity error. 

 

F. Test Port Reference Plane 

⚫ Thru Standard: The THRU standard definition is used to establish the measurement 
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reference plane. Select if the THRU standard is zero-length or very short. 

⚫ Reflect Standard: The REFLECT standard definition is used to establish the position of 

the measurement reference plane. Select if the THRU standard is not appropriate AND 

the delay of the REFLECT standard is well defined. 

 

G. Multiline TRL 

⚫ After selecting the Multiple TRL checkbox, you can click the Setup button to set the TRL 

calibration parameter configuration interface. 
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7.5.6 Create a custom Cal Kit 

There are two methods to create a custom Cal Kit: 

Method 1: Create custom Cal Kit based on existing Cal kits 

1. Press “Cal” > Cal > Cal Kit > F503ME > Save. Select the existing F503ME Cal Kit then save it 

to a local file named “F503ME123.xkt”. 

 

Figure 7-20 Creating a Custom Cal Kit dialog box 
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Figure 7-21 Save the Cal Kit 

 

2. In the Manage Cal Kits dialog box, click “Import” to Import the new calibration 

“F503ME123.xkt”. 

 

 

Figure 7-22 Import the new Cal Kit 

 

3. Select the newly imported calibration, click “Edit” to enter the calibration editing interface, 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  149 

and modify the calibration name as “F530ME-ABC”. 

 

 

Figure 7-23 Edit the new import Cal Kit 

 

4. Click the Connectors, Standards, SOLT, and TRL Tabs to modify the corresponding 

parameters as you need. 

5. Click “OK” for the changed Cal Kit to take effect. 

 

Method 2：Create a custom Cal Kit directly for new connector types. 

1. Press “Cal” > Cal > Cal Kit > Insert... 

2. Enter the name and description of the custom Cal Kit. 

3. Refer to Method 1, click the Connectors, Standards, SOLT, TRL tab to modify the 

corresponding parameters. 

4. Click “OK” to make the created calibration effective. 
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Figure 7-24 View the newly created Cal Kit 

 

 

 

7.6 Power Cal 

7.6.1 Internal source power calibration 

The vector network analyzer has been calibrated for the output power of the transmitter before it 

leaves the factory, but the factory calibration may not guarantee sufficient accuracy in all cases. 

To improve the accuracy, the user can conduct an internal source power calibration before 

performing any tests. 
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Figure 7-2 Transmitter power calibration 

 

Before attempting power calibration, power loss compensation at different frequency points can 

be set as shown in the figure below. Click “+” successively to add corresponding frequency and 

loss values. After setting, click OK to save the data. 

 

 

Figure 7-3 Set the interface 
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Power calibration operation steps: 

1. Connect the port-under-test to a compatible power meter (Keysight U2000 series, R&S 

NRP series, etc.) and probe to ensure normal communication between the vector network 

analyzer and the power meter. 

2. Preset vector network analyzer. 

3. Set internal source output power, IF bandwidth, sweep points, test frequency band and 

other parameters. 

4. Select Cal → Power Cal to enter the Settings screen. 

5. Select the test channel and select the power output port. 

6. Set parameters such as power offset, capacity limit, reading times, maximum iteration 

times, etc. 

7. Click Take Cal Sweep to start the power output measurement. 

8. Click OK to complete the calibration and exit the power calibration interface after the 

measurement is completed. 

 

7.6.2 Receiver calibration 

The vector network analyzer receiver power has been factory calibrated, but the factory 

calibration may not guarantee sufficient accuracy in every situation. The user can conduct a 

receiver power calibration before the test to improve the test accuracy. To ensure the calibration 

accuracy of the receiver, it is better to calibrate the power of the internal source before the 

calibration of the receiver. 
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Figure 7-4 Receiver calibration setting interface 

 

Operating steps: 

1. Preset vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and 

other parameters. 

3. Select Cal → Receiver Cal to enter the Settings screen. 

4. Select the test channel, select the internal source output port, select the receiver port 

5. Connect the two ports using an appropriate specification RF cable. 

6. Set parameters such as power offset. 

7. Calibrate R or Calibrate T or Calibrate Both can be clicked to begin receiver calibration. 

8. Click OK to complete the calibration and exit the receiver calibration interface. 
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7.7 Port extension 

Eliminating the errors of test fixturing can be a difficult task. The port extension function of a vector 

network analyzer is a good method to eliminate the error of test fixtures. The calibration of S 

parameters is usually carried out by the user at the plane where the RF cable is connected to the 

test fixture, typically a connector (SMA, N-type, etc.). The actual device to be tested is located in 

the test fixture. The device to be tested and the test fixture are generally connected by a microstrip 

line. As a result, the actual measurement plane of the device to be tested does not coincide with 

the calibration reference plane (the connector, as mentioned previously) which will introduce 

calibration errors.  

After the S parameter calibration is performed, the reference plane can be extended to the 

specified measurement plane by simply adding the added microstrip line length, speed factor, 

loss, and other parameters in the setting interface, to carry out more accurate testing. 
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7.7.1 Manual port extension 

 

Figure 7-5 Port extension setting interface 

 

1. Perform the appropriate calibration type (SOLT, etc.) on the associated cabling before 

entering Port Extensions. 

2. Select Cal → Port Extension → Port Extension to enter the Settings screen. 

3. Select the port that needs to be extended, the unit of length, and input the velocity 

coefficient.  

The velocity coefficient is different, and the propagation time of electromagnetic waves on 

the transmission line is different. Input the length of the extended transmission line and the 

time will be calculated automatically.  

If the transmission line has loss, the loss of the transmission line can be added, including DC 

and AC loss.  



SNA5000A&SNA5000X-E User Manual 

156                                                                                   int.siglent.com 

The AC loss can be selected as LOSS1 at the single-frequency point or LOSS1 and LOSS2 at 

the dual-frequency point. 

Among them, the fitting algorithm for two forms of AC loss are: 

Single-frequency point loss Loss1: 

Loss (f) = Loss1 * (f/Freq1) ^ 0.5 

Dual-frequency point loss Loss1, Loss2: 

Set the low frequency point to LOSS1 and the high frequency point to LOSS2,  

Loss (f) = Loss1 * (f/Freq1) ^ n, n = lg [abs(Loss1/Loss2)] / lg (Freq1/Freq2). 

4. Select whether to coupling to the system speed factor. If unchecked, the speed factor is set 

only for the specified port, and when checked, for all ports. 

5. Media: For port, select the media of the added transmission line or fixturing: 

⚫ Coax: Select when the fixture or added transmission line is coax. Also specify the 

velocity factor of the coax. 

⚫ Waveguide / Port Cutoff Freq: Select when the fixture or added transmission line is 

waveguide. Also enter cutoff frequency of the waveguide. 

⚫ Couple to System Media Definition: When unchecked, the Waveguide Cutoff 

Frequency is set for only the specified port and only for Port Extensions.  When 

checked, sets the Waveguide Cutoff Frequency for all ports. In addition, changing this 

value also changes this setting for the Electrical Delay feature. 

6. Check the Port Extensions ON button and the Port extension will take effect. 

 

Manual port extensions require the user to manually enter the parameters of the extended 

transmission line, while automatic port extension does not require prior knowledge of the 

transmission line parameters. The calibration plane can be automatically extended to the actual 

reference plane by simply performing an open or short circuit calibration on the actual reference 
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plane of the DUT. The automatic port extension function is not available in the following cases: 

1. The sweep type is set to power sweep. 

2. The frequency offset is set to on. 

3. Waveguide transmission line port extension. 

 

7.7.2 Automatic port extension 

 

Figure 7-6 Automatic port extension setting interface 

 

1. Perform the appropriate calibration type (SOLT, etc.) on the associated cabling before 

entering Port Extensions. 

2. Select Cal → Port Extension → Auto Port Extension to enter the Settings screen. 

3. Select the port you want to extend. Refer to practical application scenarios, select Port 1 or 

Port 2, or both ports. 
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4. Select the frequency span of the test.  

There are three frequency spans to choose:  

Current Span: The frequency span of the current interface setting. 

Active Marker: The frequency point currently marked, In this case, Loss2 can be ignored 

when +setting loss, only Loss1 can be set. 

User Span: Use the start and end frequencies set by the user. 

5. Set whether the loss should be included or not. Select this box to automatically measure the 

loss in the transmission line and apply it to the calibration. 

6. The mismatch adjustment option is only available when the inclusion loss item is selected. 

The mismatch increases the ripple on the trace lines of S11 and S22. If the ripple is large, the 

trace display of S11 and S22 will be greater than 0 dB, resulting in unstable values when S 

parameters are used. Selecting the adjustment mismatch item can increase the loss of the 

fixture so that the peak value of the ripple is below 0 dB. Although this will increase the error, 

it can prevent the numerical instability of S parameters from appearing when it is used. 

7. Remove the DUT from the test fixture. In this way, the open-circuit measurement can be 

performed. Of course, the test fixture can also refer to the plane Short circuit to conduct the 

Short measurement. It can carry out one of the Open or Short measurements or 

simultaneously carry out the Open and Short measurements. When two measurements are 

used, the result will be the average of the two measurements, and the accuracy will be 

improved. 
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Figure 7-7 Automatic port extension measurement completion interface 

 

7.8 Fixture measurement function 

In addition to the port extension function, the vector network analyzer also provides several other 

functions for test fixtures: 

1. Port match (2-port embedding) 

2. Port impedance conversion 

3. 2-port de-embedding 

4. N port embed/ de-embed (port 4/6/8) 

5. Differential port match 

6. Differential port impedance conversion 
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7. Common port impedance conversion 

 

7.8.1 Port match 

1. Ensure that the user has completed the S parameter calibration. 

2. Select Cal → Fixtures → Fixture Setup → Port Match to enter the Settings screen. 

3. By selecting the port and the parameter representation form of the matching module, the 

S2P file (AKA Touchstone file) of the matching module can be directly exported or the circuit 

model of the matching module can be used. It supports 9 topologies which are combined by 

L, R, G, and C. It is necessary to manually set the parameter values of L, R, G, and C 

components. Checking the Enable Port Matching On All Ports tab means that all ports are 

matched. When the frequency range in the S2P file of the imported matching module is less 

than the frequency range set by the current interface, the system will extrapolate the S2P file 

by default. In other words, all the uncovered low-frequency parameters are replaced by the 

first point in the S2P file and all the uncovered high-frequency parameters are replaced by 

the last point in S2P file making the frequency range of the S2P file the same as the 

frequency range of the current interface. 

4. Click Close to complete the setting and click Apply Fixtures to ON to take effect. 
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Figure 7-8 Port match 

 

7.8.2 Port impedance conversion 

1. Ensure that the user has completed the S parameter calibration. 

2. Select Cal → Fixtures → Fixture Setup → Port Z to enter the Settings screen. 

3. Choose the port, the default system port characteristic impedance is 50 Ω, you can fill in the 

required resistance values in the R and JX columns, Then the S parameter displayed will be 

automatically converted to the S parameter corresponding to the new characteristic 

impedance. Checking the Enable Port Z Conversion On All Ports tab means port matching is 

performed on all ports. 
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4. Click Close to complete the setting and click Apply Fixtures to ON to take effect. 

 

 

Figure 7-9-port impedance conversion 

 

7.8.3 2-port de-embed 

1. Ensure that the user has completed the S parameter calibration. 

2. Select Cal → Fixtures → Fixture Setup → 2-Port DeEmbed to enter the Settings screen. 

3. Select the port and select the form of de-embedding to import an S2P File. Click User S2P 

File to import the S parameter of the fixture part that needs to be removed.  

Checking the Enable De-Embedding On All Ports tab means that all ports are de-

embeddable.  

When the frequency range in the S2P file of the imported matching module is smaller than 

the frequency range set by the current interface, the system will extrapolate the S2P file by 

default. All the low-frequency parameters not covered are replaced by the first point in the 

S2P file, and all the high-frequency parameters not covered are replaced by the last point in 

the S2P file, making the frequency range of the S2P file the same as that of the current 

interface.  

4. Checking the Reverse Adapter Ports entry represents the part of the reverse connection 

that will need to be de-embedding. By default, the system reverses the imported S2P file. 

5. Click Close to complete the setting and click Apply Fixtures to ON to take effect. 
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Figure 7-10 de-embedding interface 

 

7.8.4 N-port embedding / de-embedding 

1. Ensure that the user has completed the S parameter calibration. 

2. Select Cal → Fixtures → Fixture Setup → N-Port DeEmbed to enter the Settings screen. 

3. Select the topology type.  

There are 3 topology types: A (using network 1); B (using network 1 and 3); C (using network 

1, 2 and 4) 

Select the port of the vector network analyzer in the VNA item, select the Network port 

configuration that needs to be embedded or de-embedded in the Network, and select the 

Embed operation or De-embed operation under each Network. Finally, load the S2P file 
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corresponding to the operating network. Checking the Enable 4/ 6/ 8-Port Embed / De-

embed On All Ports tab means that all ports are matched.  

When the frequency range in the S2P file of the imported matching module is less than the 

frequency range set by the current interface, the system will extrapolate the S2P file by 

default.  

In other words, all the uncovered low-frequency parameters are replaced by the first point in 

the S2P file, and all the uncovered high-frequency parameters are replaced by the last point 

in the S2P file, making the frequency range of the S2P file the same as the frequency range 

of the current interface.  

4. Click Close to complete the setting and click Apply Fixtures to ON to take effect. 

 

 

Figure 7-11 De-embedding interface 
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7.8.5 Differential port match 

1. Ensure that the user has completed the S parameter calibration. 

2. Select Cal → Fixtures → Fixture Setup → Differential Port Match to enter the Settings screen. 

3. By selecting the port and the parameter representation form of the matching module, the 

S2P file of the matching module can be directly imported or the circuit model of the 

matching module can be used.  

It is necessary to manually set the parameter values of L, R, G, and C components if the 

circuit model is used.  

Checking the Enable Differential Port Matching tab means that all ports are matched.  

When the frequency range in the S2P file of the imported matching module is less than the 

frequency range set by the current interface, the system will extrapolate the S2P file by 

default. In other words, all the uncovered low-frequency parameters are replaced by the first 

point in the S2P file and all the uncovered high-frequency parameters are replaced by the 

last point in the S2P file making the frequency range of the S2P file the same as the 

frequency range of the current interface. 

4. Click Close to complete the setting and click Apply Fixtures to ON to take effect. 
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Figure 7-12 Differential port match 

 

7.8.6 Differential and common port impedance conversion 

The operation of differential port impedance conversion and common port impedance 

conversion is similar to that of port impedance conversion, please refer to the instructions of the 

latter. 

7.8.7 Power Compensation 

This function adjusts the source power of a specified port to compensate for gain or loss caused 

by a particular fixture. It allows you to set the power level at the input of the device under test. 

Power compensation is achieved by adjusting the source power for gain/loss via the 2-port de-

embedding function. 

The power compensation function cannot compensate for the gain or loss introduced by the N-

port de-embedding function. Port power can be adjusted using a power offset. Calculate the 

fixture loss, use that value to set the power offset, and then set the desired power level at the 

port. 

Exercise caution when applying power compensation: Always perform test setups without 

connecting the device under test (DUT). When using an S2P file for 2-port de-embedding, first 

import the file into a VNA to check if the transmission S-parameters meet expectations; 

otherwise, it may adversely affect the port. 

 

Power compensation in fixtures 
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7.9 Adapter removal / insertion function 

Adapters are often used when the network analyzer is used to test the DUT. The vector network 

analyzer provides the function of removing and inserting adapters. Before the function of 

removing and inserting adapters is enabled, the vector network analyzer needs to carry out full 

2-port calibration. 

 

 

Figure 7-13 Adapter removal and insertion functions 

 

7.9.1 Adapter removal 

1. Connect the test cable of the vector network analyzer to the adapter, and configure the 
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parameters of the network analyzer. First, perform the full 2-port calibration. 

2. Select Cal → Adapter Removal to go to the Settings screen and select Remove in the 

Adapter tab. 

3. Remove the adaptor from the test cable, Select Cal → Adapter Removal → Calibration to 

enter the Adapter Removal configuration screen. Select the port connected to the adaptor 

to be removed, select the calibration kit type, and select the polarity of the calibration kit. 

Click Next to connect the Open, Short and Load calibration elements in turn for full 1 port 

calibration. 

4. Click Finish to complete the calibration and click Adapter Removal to ON to complete the 

Adapter Removal operation. 

 

 

Figure 7-14 Adapter removal and insertion function calibration interface 

 

7.9.2 Adapter insertion 

1. Remove any test cables from the ports of the analyzer and perform a full 2-port calibration. 

2. Select Cal → Adapter Removal to go to the Settings screen and select Insert in the Adapter 

tab. 

3. Connect the adapter on the test cable, select Cal → Adapter Removal → Calibration to enter 

the Adapter Removal configuration screen. Select the port connected with the adaptor to be 
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inserted, select the calibration kit model, select the polarity of the calibration kit, and click 

Next to connect the Open, Short, and Load calibration elements in turn for full 1 port 

calibration. 

4. Click Finish to complete the calibration and click Adapter Removal to ON to complete the 

Adapter insertion operation. 

“Adapter Rotate” is also known as the “equal exchange adapter and equal length adapter” 

calibration method. Before the unknown pass-through method was introduced, the 

switching adapter method was often used as a faster alternative to the more tedious 

adapter removal method. 

 

7.10 Ecal 

7.10.1 ECal Overview 

ECal is a new automatic calibration technology for vector network analyzers. Every ECal module 

contains electronic standards that are automatically switched into position during a 

measurement calibration. These electronic standards have been measured at the factory and the 

data stored within the memory of the ECal module. The analyzer uses this stored data, along 

with the measured data, to calculate the error terms for a measurement calibration. ECal offers 

the following advantages: 

⚫ The calibration process is simple. The electronic calibrator only needs to be connected to 

the VNA once to complete the test items required by the dual-port calibration, without the 

need for multiple calibration connections. 

⚫ A shorter time is required for calibration. 

⚫ There are fewer uncertain factors in the calibration process, and the probability of electronic 

calibration being affected by misoperation is reduced because there is no need for multiple 
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connection processes. 

 

Use ECal to perform calibration 

1. Connect the USB port on the ECal module with the USB port on the front panel of VNA via a 

USB cable. the module indicates “READY”. When you connect the module, the type of module, 

frequency range, and connector type are automatically recognized. 

2. Connect a port on the ECal module to the test port to be calibrated. 

3. Press Cal > ECal on the front panel to enter the ECal menu interface. 

 

 

Figure 7-15 ECal menu 

A. ECal Config. Select the number of ports to calibrate. 

Then select the port number configuration. 

B. Confidence Check. Check the validity of Ecal 

calibration.  

C. Orientation. Select “Auto” (the default setting) the 

VNA automatically senses the model and direction in 

which an ECal module port is connected to the VNA 

ports. Select “Manual” to manually set the specified 

port. 

D. Characterization. View the characterization 

information stored in the ECal module 

 

7.10.2 ECal Config 

Press “Cal” on the front panel , Press Cal > ECal > ECal to enter the menu interface of ECal 

setting. 
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Figure 7-16 ECal config menu 

 

A. Select the number of ports to calibrate and configure the port number. Using ECal, you can 

perform 1-Port Reflection calibration, Full 2-Port calibration, Full 3-Port calibration, and Full 

4-Port calibration. 

B. Select the Cal Type 

C. When “Orientation” is Auto, click “Next” to enter the automatic alignment directly. When 

“Orientation” is Manual, click “Next” to specify the calibration port and go to auto-calibration. 

 

7.10.3 Confidence Check 

1. Press “Cal” on the front panel, press Cal > ECal > Confidence Check to enter the menu 

interface of Confidence Check. 
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Figure 7-17 Confidence Check 

 

2. Compare the data-trace with the memory trace and verify that the measurement is correct. 

3. The steps to compare when both data and memory traces are displayed are as below: 

⚫ Press “Math” on the front panel, Press “Math” > Memory > Math > Data + Memory. 

⚫ Press “Scale” on the front panel, Press “Scale” > Scale > Auto Scale. 

⚫ Determine if the differences between trace lines are acceptable. 

 

7.10.4 Orientation 

The ECal module automatically detects the connection between SNA's test ports and ECal 

module's ports. You can turn off this function to set ports manually. 

Manual port setting procedure for Full 2-Port calibration 

1. Press “Cal” on the front panel, Press “Cal” > ECal > Orientation > Manual. 
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2. Specify a test port of the VNA. 

3. Specify an ECal port for the port of the VNA you specified. 

 

 

Figure 7-18 Manual port setting 

 

7.10.5 Characterization 

Press “Cal” on the front panel, press “Cal” > Cal > Characterization > Factory to view all the 

parameters of the stored Characterization in the ECal module. 
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Figure 7-19 The factory information of Cal Kit 

 

A. The date when the characteristics were measured 

B. The stimulus conditions when the characteristics were measured 

C. The information of the Connector type 

 

7.10.6 Characterize ECal 

The user characterization of the electronic calibration kit allows for the remeasurement of the 

calibration data of the electronic calibration kit (including the adapter). The user characterization 

data (.euc) can be used for calibration when calibrating the electronic calibration kit. 

 

Select the adapter for the electronic calibration port. If the port is not using an adapter, select 

"No adapter". 
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To calibrate the network analyzer, connect the network analyzer to the corresponding port of the 

electronic calibration device as prompted, and measure the user calibration data of the 

electronic calibration device. 

 

 

After completing the measurement, click Save to save the user calibration data (*.euc) of the 

electronic calibration kit. 
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Using user characterization data. 
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Import and delete user calibration data for electronic calibration kits. 
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8 Data Analysis 

8.1 Marker 

The marker can display defined measurement data of traces. Each trace can set nine ordinary 

markers and one reference marker. 

8.1.1 Ordinary marker: 

Press the Marker button on the front panel, click Add Marker in the Marker submenu to create a 

marker, then set the required test frequency. if there are many markers on the trace, click Select 

to select the desired marker. After the marker is created, the measurement value of the marker 

will be displayed at the top right of the window, and the value format is the same as the format of 

the trace. We can click the Delete Marker command under the marker submenu to delete the 

marker and select the marker to delete from the pop-up menu. When a trace is deleted, all 

markers on the trace will be deleted. Click the All Off command under the Marker submenu or the 

Marker Setup submenu to delete all markers on the current trace. 

 

8.1.2 Reference marker: 

Press the Marker button on the front panel, click Reference Marker in the Marker submenu, make 

the On option selected then the Reference Marker will be created. By default, the Reference 

Marker is created at the location of the current ordinary Marker. If there is no ordinary Marker on 

the current trace, the Reference Marker will be created at the center of the trace. Reference 

Markers are denoted by an R. After creating a Reference Marker, set the Reference Marker as value 

discretization, fixed marker, and coupling, we can set the data format of Reference Marker’s 

display value and view the Reference Marker’s value in the marker table, but the Reference Marker 

cannot be set as a difference (delta) marker. Click Reference Marker in the Marker submenu, select 

the Off option to delete the Reference Marker. 
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8.1.3 Marker setting: 

Press the Marker button on the front panel, set the current marker in the Marker Setup submenu, 

we can make the following settings for the currently selected marker: 

1. Difference (delta) display:  

The difference display mode is closed by default, to open the difference display mode, click 

the Delta to select the On option, then the marker’s value will display the difference between 

the ordinary marker and the reference marker, and the marker’s value is marked with "Δ". If a 

reference marker has not been added to the trace, the reference marker will be automatically 

set on the trace. To display the absolute value of the marker, click the Delta again to select 

the Off option. 

2. Value discretization:  

The value discretization mode is closed by default. Due to the limited number of sampling 

points set on the trace, the data of other points except the sampling points are based on the 

interpolation value of the sampling point data, which is approximate to the actual data, not 

the real measured data. By setting the value discretization of the marker, the value of the 

marker can only be taken at the sampling point, which ensures that the marker’s value is from 

the measurement data and not interpolated data. To open the value discretization mode, 

click the Discrete to select the On option, at this time, the data of the marker is only selected 

from the sampling points, when the coordinate value of the marker is not in the sampling 

point, the marker is automatically moved to the nearest sampling point. To turn off the value 

discretization, click the Discrete to select the Off option. 

3. Fixed marker:  

The fixed marker mode is closed by default. Fixed markers have a fixed excitation position (x-

axis coordinate), its response value (Y-axis coordinate) will change according to the trace data 
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update. To keep the fixed value of the marker unchanged, click the Type command to select 

the Fixed option, then the marker’s value will keep the current value unchanged, and the 

marker does not move up or down with the trace update. To restore the marker real-time 

update, click the Type command again to select the Normal option. 

4. Data format:  

The newly created marker uses the current trace’s data format by default. To change the 

data format of the marker, click the Format and select the corresponding data format in the 

pop-up menu. The following data formats are available:  

Trace Default  

Log/Phase  

Lin/Phase  

Re/Im  

R+jx  

G+jB  

Log Magnitude  

Lin Magnitude  

Phase  

SWR  

Delay  

Real  

Imaginary  
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Figure 8-1 Data format interface 

 

5. Marker coupling:  

The newly created marker turns off coupling by default. At this time, the marker is only set on 

a single trace, and the markers on different traces do not affect each other. If we need multiple 

markers on different traces to share settings, we can use the marker coupling function. Click 

the Coupled command, and select the range of the marker coupling in the pop-up menu for 

coupling operation. When the marker coupling mode is on, the markers of the same number 

and X-axis (such as frequency or time) on all traces in the coupling range share the settings, 

and the marker’s setting on the current trace will be used by default. If the current marker is 

not in the coupling range, the marker with the same number on the trace with the smallest 

trace number is used.  

Note: when the marker coupling mode is on, the marker on the trace within the coupling 

range will automatically move to the same X-axis coordinate.  

 

6. Marker table:  

The newly created marker closes the marker table by default. If we need to display all marker 

data in the form of a table, we can use the marker table function. Click the Marker Table to 

select the On state, a table will appear at the bottom left to display all marker’s values, click 

the Marker Table again to select the Off option to close the marker table.  

 

 

8.1.4 Marker Display 

Press the Marker button on the front panel, set the display effect for the current cursor in the 

Marker Display submenu: 
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● Show Readout: The system is turned on by default. If this switch is turned off, the cursor 

reading will be hidden. 

● Active Trc Only: The system is turned off by default. If this switch is turned on, only the cursor 

reading of the current working trace will be displayed. 

● Align: The system is turned on by default. If this switch is turned off, the cursor of different 

traces will not be aligned and displayed. 

● X Pos: Set the display position of the cursor reading on the X-axis. 

● Y Pos: Set the display position of the cursor reading on the Y-axis. 

● Decimal Places: By default, the Auto Decimal Places check box is checked. When unchecked, 

the decimal places for the stimulus value and response value of the cursor reading can be set. 

 

8.1.5 Marker function 

Press the Marker button on the front panel, use the current marker to set the excitation in the 

Marker Function submenu. Use the currently selected marker to achieve the following functions:  

⚫ Marker → Start: Set the current marker position (X coordinate) as the sweeping starting point. 

⚫ Marker → Stop: Set the current marker position (X coordinate) as the sweeping ending point. 

⚫ Marker → Center: Set the current marker position (X coordinate) as the sweeping center point. 

Note: When using this command, the sweeping boundary value far from the current marker 

will be changed to reduce the sweeping range, so that the marker position becomes the new 

sweeping center point.  

⚫ Marker → Span: This function is only available when the current marker is a difference (delta) 

marker. Set the sweeping range between the current marker position and the reference 

marker position (x coordinate). 

⚫ Marker → Ref Level: Set the response value (Y coordinate) of the current marker to the 
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reference level of the current trace. 

⚫ Marker → Delay: Referring to the phase slope of the current marker position, the line length 

is adjusted to the receiver input, this function helps to smooth the phase trace around the 

current marker. For the equipment without constant group delay in the measurement 

frequency span, another electrical delay adjustment is needed. This function can be used to 

measure electrical length or deviation from a linear phase. This function requires the 

measured phase difference, so it is only suitable for proportional measurements. 

⚫ Marker → CW Freq: Set the current marker position (frequency) to continuous wave (CW) 

frequency. This function requires the x-axis field of the current marker, otherwise, it is invalid. 

After changing CW frequency with this command, enable power or CW sweeping to apply the 

changed CW frequency setting. 

⚫ Marker → SA: If the current mode is SA, the center frequency is set to the current marker value; 

If it is not SA mode, then switch to SA mode, set the center frequency to the current marker 

value, and set span to 10 times of the previous step freq. 

 

8.2 Marker search function 

The marker can be used to search the maximum value, minimum value, peak value, and target 

value of the trace in the specified search domain. It can also search for multi-peak value, multi-

target, bandwidth filtering, and band-stop filtering. 

8.2.1 Search domain 

The search domain is the frequency span included in a marker search operation. Each marker has 

an independent search domain, and the default is full span, which is the same as the current sweep 

range. The X coordinate movement range of the marker is limited in its search domain. The user 

can set up to 16 custom search domains. The search domains are independent of each other and 
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allowed to overlap. The search field can be set for each marker, and multiple markers are allowed 

to share one search domain.  

To set a custom search domain, press the Search button on the front panel, click the Domain 

command in the Search submenu, and click the Add command in the pop-up menu. Then click 

the Domain command again, click and select the newly created custom search domain in the pop-

up menu, and enter the required values in the Start and Stop text boxes below the domain 

command. When the search domain of the current marker is not full span, the indicator "Δ" will 

appear on the x-axis to identify the search domain of the current marker. To delete a user-defined 

search domain, click the Domain command, select the search domain to be deleted in the pop-

up menu, then click the Domain command again, and then click Delete in the pop-up menu. If the 

search domain of the marker is deleted, its search domain is automatically set to full span.  

 

8.2.2 Max and min search 

Press the Search button on the front panel and click the Max Search command in the Search 

submenu to move the current marker to the maximum response value in the search domain. Press 

the Search button on the front panel and click the Max Search command in the Search submenu 

to move the current marker to the maximum response value in the search domain. Click the Min 

Search command to move the current marker to the minimum response value in the search 

domain. 

 

8.2.3 Peak search 

Press the Search button on the front panel to search the peak in the Peak submenu. Before 

searching for the peak value, the effective peak value to be searched should be defined first. The 

validity of the peak value is determined by the search domain, peak polarity, threshold, and 

deviation: 
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Peak polarity: According to the polarity, the peaks are divided into two categories: Positive and 

negative. The positive peak value refers to situations where the measured value is greater than 

the measured value at both ends of a span, and the negative peak value refers to the peak value 

that the measured value is less than the measured value at both ends of a span. Click the Peak 

Polarity command in the Peak submenu to select the peak polarity. The Both option means that 

both positive and negative peaks are regarded as valid peaks for the search.  

 

Threshold: For the positive peak, only the peak whose measured value is greater than the 

threshold is considered valid; for the negative peak, only the peak whose measured value is less 

than the threshold is considered valid; when the polarity of the peak is set to Both, the threshold 

is not used as the basis for judging the validity of the peak. To set the threshold, click the 

Threshold command in the Peak submenu to enter the required value.  

 

Deviation: The deviation value of peak value refers to the smaller difference between the 

measured value of peak value and the measured value of an adjacent peak with the opposite 

polarity. Only the peak value with a deviation greater than the rated value is considered valid. To 

set the deviation value, click the Excursion command in the Peak submenu to enter the required 

value.  

 

After determining the effective peak range and search domain, the peak search can be started. 

There are several peak searching modes available: 

⚫ Using the Peak Search command in the Peak submenu, the peak with the largest measured 

value among the effective positive peaks or the peak with the smallest measured value 

among the effective negative peaks will be included in the search according to the peak 

polarity setting. If the current peak polarity is set to Both, the peak with the largest 
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measured value among the effective positive peaks is searched. 

⚫ Use the Peak Right → Search command in the Peak submenu to search the nearest 

effective peak from the current marker position to the right.  

⚫ Use the Peak Left ← Search command in the Peak submenu to search the nearest effective 

peak from the current marker position to the left.  

⚫ Use the Next Peak Search command in the Peak submenu to search for the effective 

positive peak value next lower than the current marker measurement value or the effective 

negative peak value next higher than the current marker measurement value according to 

the peak polarity setting. If the current peak polarity is set to Both, the effective peak next 

lower than the current vernier measurement value is searched.  

 

8.2.4 Target search 

Press the Search button on the front panel to search the target in the Target submenu. Before 

searching the target, set the target value and transition type: 

Target value: The target value refers to the response value to search (Y coordinate). If the 

response value of a point on the trace is equal to the target value, then the point is the target 

point to search. To set the target value, click the Target Value command in the Target submenu 

to enter the required value.  

 

Transition type: The target points are divided into two types, positive and negative. The positive 

target conversion type means that the measured value on the right side of the target point is 

greater than that on the left side, while the negative target conversion type means that the 

measured value on the right side of the target point is less than that on the left side. Click the 

Transition command in the Target submenu to select the conversion type to search for. The Both 

option means that both positive and negative target conversion types are regarded as valid 
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targets.  

 

After the target value, transition type and search domain are determined, the target search can 

be started. The vector network analyzer has the following target search modes: 

⚫ Use the Target Search command in the Target submenu to search for the nearest effective 

target from the current marker position to the right. When no effective target can be found 

from the right, search from the starting point of the search domain to the right.  

⚫ Use the Target Right → Search command in the target submenu to search the nearest valid 

target from the current marker position to the right.  

⚫ Use the Target Left ← Search command in the Target submenu to search the nearest valid 

target from the current marker position to the left.  

 

8.2.5 Multi-peak search 

Press the Search button on the front panel to search for multiple peaks in the Multi Peak & Target 

submenu. Before searching for multiple peaks, you need to set the threshold, deviation, and 

peak polarity in the Peak Threshold, Peak Excursion and Peak Polarity commands in the 

submenu to define the peak validity. After setting the above parameters, click the Multi Peak 

Search command to search all effective peaks from the starting point of the search domain to 

the right, and mark the peaks with a marker. Since there can only be 9 common markers on a 

single trace, only the first 9 effective peaks can be found when there are many effective peaks.  

 

8.2.6 Multi-target search 

Press the Search button on the front panel to search for multiple targets in the Multi Peak & Target 

submenu. Before multi-target search, you need to set the target value and conversion type in the 
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Target Value and Transition submenu to define the target validity. After setting the above 

parameters, click the Multi-Target Search command to search all valid targets from the starting 

point of the search domain to the right, and mark the searched targets with a marker. Since there 

can only be 9 common markers on a single trace, only the first 9 valid targets can be found when 

there are many valid targets.  

 

8.2.7 Tracking search 

When using the above search function, the marker position is only based on the current sweeping 

result, and will not be dynamically updated with the trace update after the search. Tracking mode 

can be used to update search results with trace data. Press the Search button on the front panel, 

click the Tracking command, and select the search type in the pop-up menu; the search in the 

tracking mode uses the search parameter settings in the above search.  

 

8.2.8 Bandwidth search 

The bandwidth search is a function for determining the bandwidth of the trace, center frequency, 

cut-off points (on the higher frequency and the lower frequency sides), Q and insertion loss 

based on the position of the active marker or peak marker. 

Press the Search button on the front panel to search the bandwidth in the Bandwidth submenu. 

Click BW Search Enable and select the On option to search the bandwidth. After the bandwidth 

search is completed, a small triangle will be used to mark the cut-off frequency of the trace, and 

the bandwidth, center frequency, cut-off frequency, quality factor, and insertion loss will be 

displayed in the upper right corner of the window. To turn off the bandwidth search, click BW 

Search Enable again and select the Off option. You can set whether to alarm when the 

bandwidth search fails in the Sound On Fail command.  
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Figure 8-2 Bandwidth search example 

 

8.2.9 Notch search 

The notch search function is used to obtain the bandwidth, center frequency, cutoff points (high-

frequency side and low-frequency side), Q and insertion loss of a trace based on the active marker 

or peak marker position. The notch search function starts from the left side of the active marker 

position and ends when points that meet the conditions are found. 

Press the Search button on the front panel to search the band stop in the Notch submenu. Click 

the Notch Search Enable command and select the On option to perform the band stop search. 

After the band stop search is completed, a small triangle will be used to mark the cut-off frequency 

of the trace, and the bandwidth, center frequency, cut-off frequency, quality factor, and insertion 

loss will be displayed in the upper right corner of the window. To turn off the band stop search, 

click the Notch Search Enable command again and select the Off option. You can set whether to 

alarm when the band stop search fails in the Sound On Fail command.  

The following values are displayed for Bandwidth and Notch Search: 
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⚫ Bandwidth (BW): The difference in frequency between the higher frequency cut-off and 

lower frequency cut-off points (High - Low). 

⚫ Center frequency (Center): Frequency at the middle point between the lower frequency cut-

off and higher frequency cut-off points. (High + Low)/2. 

⚫ Lower frequency cut-off point (Low): Lower frequency of 2 measurement points, both 

separated by the defined bandwidth / notch value from the active marker position. 

⚫ Higher frequency cut-off point (High): Higher frequency of 2 measurement points, both 

separated by the defined bandwidth / notch value from the active marker position. 

⚫ Q: Ratio of Center Frequency to Bandwidth (Center Frequency / Bandwidth). 

⚫ Insertion loss (loss): The measured value of the position of the center frequency at the time 

the bandwidth/notch search is executed. 

 

8.2.10 Compression search 

Compression search is used to find the amplifier's 1dB (user-defined) compression point at a 

specific frequency. This function is only valid for S21 (gain) measurements using a power sweep, 

where the reference gain is the Y-axis value (S21) of the first point on the trace. 

Press the Search button on the front panel to access the Comp&Sat submenu for compression 

search. Click the Compression Search command and select the On option to enable 

compression search. Once enabled, the upper right corner of the window will display the 

compression point input power (Comp Pin), compression point output power (Comp Pout), and 

compression level (Comp Level) data. Click the Comp Level button to set the compression level. 

Click the Compression Search button to execute the compression point search. To disable 

compression search, click the Compression Search command again and select the Off option. If 

no compression point is found, the window information bar will display "Comp. Not Found". 
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The parameters displayed in the compression search results are defined as follows: 

● Comp Pin: Input power at the found compression point. 

● Comp Pout: Output power at the found compression point. 

● Comp Level: The difference between the found compression point and the first data point 

(reference point), i.e., the compression value. 

● Comp. Not Found: No compression point found. 

 

Note: Although both the Comp Level set by the user and the Comp Level value displayed in the 

upper right corner of the window are compression values, the former is the target compression 

value, while the latter is the compression value of the actual compression point found. 

Depending on the measurement environment, if the corresponding compression point is not 

found, the two may be unequal. 

 

8.2.11 Saturation search 

For traveling wave tube (TWT) amplifiers, the saturation power (PSAT) marker is used to 

determine the normal operating point where the amplifier approaches saturation. In actual 

operation, the power is typically slightly reduced by about 0.03–0.1 dB. In a TWT amplifier, its 

saturation curve will inevitably exhibit a downward bend, resulting in maximum output power. 

This function is only valid for measurements using receivers employing power scanning. 

 

Press the Search button on the front panel to access the saturation search in the Comp&Sat 

submenu. Click the Status Search command and select the On option to enable saturation 

search. Once enabled, three markers will be added to display the following three points: Marker1 

(the first data point of the trace), Marker2 (the saturation point), and Marker3 (the maximum 

output power, usually the last point of the trace). The relevant data for the saturation point and 
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maximum output power will be displayed in the upper right corner of the window. Click the 

Pmax Backoff button to set the backoff value. Click the Status Search button to execute the 

saturation search. To disable saturation search, click the Status Search command again and 

select the Off option. 

 

The parameters displayed in the saturation search results are defined as follows: 

● PSat Out: Saturation point output power (Marker 2 Y-axis value). 

● PSat In: Saturation point input power (Marker 2 X-axis value). 

● Gain Sat: Saturation point gain (Psat Out - Psat In, i.e., S21 of Marker 2). 

● Comp Sat: Saturation point compression value (Gain Sat - Gain Linear). 

● PMax Out: Maximum output power (Marker 3 Y-axis value). 

● PMax In: Maximum input power (Marker 3 X-axis value). 

● Gain Max: Gain at maximum output power (PMax Out - PMax In, i.e., S21 of Marker 3). 

● Comp Max: Saturation point compression value (Gain Max - Gain Linear). 

● Gain Linear: Linear gain at the first data point (Marker 1 Y-axis value - Marker 1 X-axis value, 

i.e., Marker 2 Y-axis value - Marker 2 X-axis value) 1 of S21). 

 

8.2.12 Normal Op Search 

The normal operating point refers to the power point obtained by offsetting the input power 

(user-defined) after finding the saturation point, and is considered to be the power range in 

which the amplifier usually operates. 

 

Press the Search button on the front panel to access the saturation point search in the Normal 
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Op Pt submenu. Click the Normal Op Search command and select the On option to enable 

normal operating point search. Once enabled, four markers will be added to display the following 

four points: Marker1 (the first data point of the trace), Marker2 (the backoff point, i.e., the 

saturation point in 8.2.11), Marker3 (maximum output power, usually the last point of the trace), 

and Marker4 (normal operating point). Relevant data for the normal operating point will be 

displayed in the upper right corner of the window. Click the Backoff button to set the backoff 

value. Click the Pin Offset button to set the power offset value. Click the Normal Op Search 

button to execute the normal operating point search. To disable normal operating point search, 

click the Normal Op Search command again and select the Off option. 

 

The parameters displayed in the search results for normal operating point are defined as follows: 

● Pnop Out: Normal operating point output power (Marker 4 Y-axis value). 

● Pnop In: Normal operating point input power (Marker 4 X-axis value). 

● Pnop Gain: Normal operating point gain (Pnop Out - Pnop In, i.e., S21 of Marker 4). 

● Pnop Comp: Normal operating point compression (Pnop Gain - Linear Gain). 

● PMax Out: Maximum output power (Marker 3 Y-axis value). 

● PMax In: Maximum input power (Marker 3 X-axis value). 

● Gain Max: Gain at maximum output power (PMax Out - PMax In, i.e., S21 in Marker 3). 

● Comp Max: Compression value at maximum output power (Gain Max - Linear Gain). 

● PBO Out: Output power at the backoff point (Marker 2 Y-axis value). 

● PBO In: Input power at the backoff point (Marker 2 X-axis value). 

● PBO Gain: Gain at the backoff point (PBO Out - PBO In, i.e., S21 of Marker 2). 

● Linear Gain (not displayed): Linear gain at the first data point (Marker 1 Y-axis value - 

Marker 1 X-axis value, i.e., S21 of Marker 1). 
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8.3 Mathematical operation 

The vector network analyzer supports saving the current data-trace in memory. It can perform 

four kinds of mathematical operations on the current data-trace and memory trace. In addition, it 

can calculate and display statistical data (mean, standard deviation, and peak-peak) on the data-

trace. In addition, through the built-in formula editor, you can use multiple types of traces from the 

same or different channels to build custom formulas. When the mathematical operation with 

memory trace needs to be carried out, the current data needs to be stored in memory first. Click 

Data → Memory to complete the storage operation. In the Display menu bar, you can select three 

display modes: Display data-trace only, display memory trace and display data-trace and memory 

trace at the same time. The four mathematical operations of data-trace and memory trace are as 

follows, in which the values on data-trace and memory trace are linear: 

● Data/Memory: Divide the measured data by the data in the stored trace. This function can be 

used to calculate the ratio of two traces (such as calculating gain or attenuation), which can 

also be regarded as the normalization operation of test data. 

● Data*Memory: The current measurement data is multiplied by the data in memory.  

● Data+Memory: Current measurement data plus data in memory.  

● Data–Memory: Current measurement data minus data in memory. For example, you can use 

this function to store measured data, the error is then subtracted from the DUT 

measurement. 

 

8.4 Conversion 

The vector network analyzer supports parameter conversion, which can convert the S parameter 

of the current trace to the required parameter mode. The vector network analyzer supports the 
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following 8 conversion types. 

⚫ Z-Reflect: Impedance in reflection measurement Zr. 

 

Z𝑟 = 𝑍𝑜𝑎 ×  
1 + 𝑆𝑎𝑎

1 − 𝑆𝑎𝑎

 

 

⚫ Z-Transmit: Impedance in transmission measurement Zt. 

 

𝑍𝑡 =  
2 × √𝑍0𝑎 × 𝑍0𝑏

𝑆𝑎𝑏
− (𝑍0𝑎 + 𝑍0𝑏) 

 

⚫ Z-Trans-Shunt: Impedance in parallel transmission Zt. 

 

𝑍𝑡 =
1

𝑌𝑡

 

 

⚫ Y-Reflect: Reflection measurement admittance Yr. 

 

𝑌𝑟 =
1

𝑍𝑟

 

 

⚫ Y -Transmit: Admittance in transmission measurement Yt. 

 

𝑌𝑡 =
1

𝑍𝑡
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⚫ Y -Trans-Shunt: Admittance in parallel transmission Yt. 

 

𝑌01 =
1

𝑍01

 

 

𝑌02 =
1

𝑍02

 

 

𝑌𝑡 =  
2 × √𝑌01 × 𝑌02

𝑆𝑎𝑏
− (𝑌01 + 𝑌02) 

 

⚫ 1/S: Reciprocal of S parameter. 

⚫ Conjugation: Convert the measured value to a complex conjugate number. 

 

 

Figure 8-3 Parameter conversion type 
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When both the fixture simulation measurement function and the port impedance function are in 

the “on” state, the system will use the value set in the port impedance conversion. In other cases, 

the system Z0 (preset value: 50 Ω) will be used. The operation steps for selecting the conversion 

type are as follows:  

1. Click Math → Analysis → Conversion enter the selection interface. 

2. Select the corresponding conversion type, effective immediately. 

 

8.5 Equation editor 

In the equation editor, we can input the algebraic formulas of standard mathematical operators 

and functions, and reference the data available in the vector network analyzer. After a valid formula 

is entered and enabled, the working trace will be displayed as the result of the set formula and 

updated in real-time. 

For example, enter the formula S21/(1 - S11). The trace is calculated by dividing each S21 data 

point by 1 and subtracting the value of the corresponding S11 data point. For a 201 points sweep, 

the calculation is repeated 201 times, once per point. In addition, suppose that the vector network 

analyzer is required to measure the directivity of a 3-port device to be tested, and the directivity 

is not the measurement parameter of the vector network analyzer, then the formula editor can be 

used to complete the measurement, and the result is the sum and difference of the traces in 

logarithmic amplitude format, that is S12 + 𝑆23 − 𝑆13 . Because the formula editor operates on 

linear complex data, the actual required formula is 𝑆12 ∗ 𝑆23/𝑆13 

Finally, the vertical axis format is set to logarithmic amplitude for display. The operation steps of 

the equation editor are as follows:  

1. Click Math → Analysis → Equation Editor enter the equation editor interface. 
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Figure 8-4 Formula editor interface 

 

2. In the formula edit box, enter functions, operators, and data to form the formula.  

3. After setting the formula, click OK to exit the formula editing interface and click the 

Equation status to On to take effect.  

 

Introduction to formula editor interface: 

⚫ Enable: Select the box to enable the currently entered formula, and clear the box to disable 

the currently edited formula. If the data traces used are from other channels instead of 

formula traces, these channels must have the same number of data points to be valid 

channels. 

⚫ Functions and Constants: It stores some commonly used functions and constants, as well as 

other functions set by the system. 

⚫ Parameter: Select the items that need to be measured only from the working channel. 
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⚫ History Equation: Used to save previously-stored formulas. 

⚫ Store Equation: Store the current input formula to facilitate subsequent use. 

⚫ : Move the cursor to the left without clearing the characters.  

⚫ →: Move the cursor to the right without clearing the character.  

⚫ Backspace: Clear the character while moving the marker to the left. 

⚫ Clear: Clear the currently entered formula. 

⚫ Numbers, operators, and constants: Numbers, common operators, and constants. 

 

Description of functions and constants in formula editor: 

Common functions Description 

Abs (complex a) Returns the sqrt(a.re*a.re+a.im*a.im) 

Acos (scalar a) Returns the arc cosine of a in radians 

Asin (scalar a) Returns the arc sine of a in radians 

Atan (scalar a) Returns the arc tangent of a in radians 

atan2 (complex a) Returns the phase of a = (re, im) in radians 

atan2 (scalar a, scalar b) Returns the phase of (a, b) in radians 

Conj (complex a) Returns the conjugate of a 

Cos (complex a) Takes a in radians and returns the cosine 

Cpx (scalar a, scalar b) Returns a complex value (a+ib) from two scalar values 

Exp (complex a) Returns the exponential of a 

Im (complex a) Returns the imaginary part of a as the scalar part of the 

result (zeroes the imaginary part) 

Ln (complex a) Returns the natural logarithm of a 

log10 (complex a) Returns the base 10 logarithm of a 
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Mag (complex a) Returns sqrt(a.re*a.re+a.im*a.im) 

Phase (complex a) Returns atan2(a) in degrees 

Pow (complex a,complex b) Returns a to the power b 

Re (complex a) Returns the scalar part of a (zeroes the imaginary part) 

Sin (complex a) Takes a in radians and returns the sine 

Sqrt (complex a) Returns the square root of a, with phase angle in the half-

open interval (-pi/2, pi/2] 

Tan (complex a) Takes a in radians and returns the tangent 

 

Constant 

e 2.71828182845904523536 

PI 3.14159265358979323846 

 

Advanced function Description 

A (complex a, complex b, complex c, complex 

d) 

F11 conversion = ((1+a)*(1-d) + b*c)/(2*b) 

A (scalar i, scalar j) returns A(Sii, Sji, Sij, Sjj) 

B (complex a, complex b, complex c, complex 

d) 

F12 conversion = Z0*((1+a)*(1+d) - b*c)/(2*b) 

B (scalar i, scalar j) returns B(Sii, Sji, Sij, Sjj) 

C (complex a, complex b, complex c, complex 

d) 

F21 conversion = (1/Z0)*((1-a)*(1-d)-

b*c)/(2*b) 

C (scalar i, scalar j) returns C(Sii, Sji, Sij, Sjj) 

D (complex a, complex b, complex c, complex 

d) 

F22 conversion = ((1-a)*(1+d) + b*c)/(2*b) 

D (scalar i, scalar j) returns D(Sii, Sji, Sij, Sjj) 
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H11 (complex a, complex b, complex c, 

complex d) 

H11 conversion = Z0*((1+a)*(1+d) - b*c)/((1-

a)*(1+d) + b*c) 

H11 (scalar i, scalar j) returns H11(Sii, Sji, Sij, Sjj) 

H12 (complex a, complex b, complex c, 

complex d) 

H12 conversion = 2*c/((1-a)*(1+d) + b*c) 

H12 (scalar i, scalar j) returns H12(Sii, Sji, Sij, Sjj) 

H21 (complex a, complex b, complex c, 

complex d) 

H21 conversion = -2*b/((1-a)*(1+d) + b*c) 

H21 (scalar i, scalar j) returns H21(Sii, Sji, Sij, Sjj) 

H22 (complex a, complex b, complex c, 

complex d) 

H22 conversion = (1/Z0)*((1-a)*(1-d) - 

b*c)/((1-a)*(1+d) + b*c) 

H22 (scalar i, scalar j) returns H22(Sii, Sji, Sij, Sjj) 

Kfac (complex a, complex b, complex c, 

complex d) 

k-factor = (1 - abs(a)^2 - abs(d)^2 + (abs(a*d - 

b*c)^2)/(2*abs(b*c)) 

Kfac (scalar i, scalar j) returns kfac(Sii, Sji, Sij, Sjj) 

MAPG (complex a, complex b, complex c, 

complex d) 

maximum available power gain = abs 

(b/c)*(kfac (a,b,c,d) - sqrt (kfac (a,b,c,d)^2 - 1)) 

MAPG (scalar i, scalar j) Returns MAPG(Sii, Sji, Sij, Sjj) 

MSG (complex a, complex b, complex c, 

complex d) 

maximum stable power gain = abs(b)/abs(c) 

MSG (scalar i, scalar j) Returns MSG(Sii, Sji, Sij, Sjj) 

mu1 (complex a, complex b, complex c, 

complex d) 

μ-factor = (1 - abs(a)^2) / (abs(d - conj(a) * 

(a*d-b*c)) + abs(b*c)) 

mu1 (scalar i, scalar j) Returns mu1(Sii, Sji, Sij, Sjj) 

mu2 (complex a, complex b, complex c, 

complex d) 

μ-factor = (1 - abs(d)^2) / (abs(a - conj(d) * 

(a*d-b*c)) + abs(b*c)) 

mu2 (scalar i, scalar j) Returns mu2(Sii, Sji, Sij, Sjj) 
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T11 (complex a, complex b, complex c, complex 

d) 

T11 conversion = -(a*d - b*c)/b 

T11 (scalar i, scalar j) Returns T11(Sii, Sji, Sij, Sjj) 

T12 (complex a, complex b, complex c, complex 

d) 

T12 conversion = a/b 

T12 (scalar i, scalar j) Returns T12(Sii, Sji, Sij, Sjj) 

T21 (complex a, complex b, complex c, complex 

d) 

T21 conversion = -d/b 

T21 (scalar i, scalar j) Returns T21(Sii, Sji, Sij, Sjj) 

T22 (complex a, complex b, complex c, complex 

d) 

T22 conversion = 1/b 

T22 (scalar i, scalar j) Returns T22(Sii, Sji, Sij, Sjj) 

Y11 (complex a, complex b, complex c, complex 

d) 

Y11 conversion = (1/Z0)*((1-a)*(1+d) + 

b*c)/((1+a)*(1+d) - b*c) 

Y11 (scalar i, scalar j) Returns Y11(Sii, Sji, Sij, Sjj) 

Y12 (complex a, complex b, complex c, complex 

d) 

Y12 conversion = (1/Z0)*(-2*c)/((1+a)*(1+d) - 

b*c) 

Y12 (scalar i, scalar j) Returns Y12(Sii, Sji, Sij, Sjj) 

Y21 (complex a, complex b, complex c, complex 

d) 

Y21 conversion = (1/Z0)*(-2*b)/((1+a)*(1+d) - 

b*c) 

Y21 (scalar i, scalar j) Returns Y21(Sii, Sji, Sij, Sjj) 

Y22 (complex a, complex b, complex c, complex 

d) 

Y22 conversion = (1/Z0)*((1+a)*(1-d) + 

b*c)/((1+a)*(1+d) - b*c) 

Y22 (scalar i, scalar j) Returns Y22(Sii, Sji, Sij, Sjj) 

Z11 (complex a, complex b, complex c, complex 

d) 

Z11 conversion = Z0*((1+a)*(1-d) + b*c)/((1-

a)*(1-d) - b*c) 

Z11 (scalar i, scalar j) Returns Z11(Sii, Sji, Sij, Sjj) 
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Z12 (complex a, complex b, complex c, complex 

d) 

Z12 conversion = Z0*(2*c)/((1-a)*(1-d) - b*c) 

Z12 (scalar i, scalar j) Returns Z12(Sii, Sji, Sij, Sjj) 

Z21 (complex a, complex b, complex c, complex 

d) 

Z21 conversion = Z0*(2*b)/((1-a)*(1-d) - b*c) 

Z21 (scalar i, scalar j) Returns Z21(Sii, Sji, Sij, Sjj) 

Z22 (complex a, complex b, complex c, complex 

d) 

Z22 conversion = Z0*((1-a)*(1+d) + b*c)/((1-

a)*(1-d) - b*c) 

Z22 (scalar i, scalar j) Returns Z22(Sii, Sji, Sij, Sjj) 

 

Channel parameter data 

data Corrected data 

data(scalar i) Corrected data of trace i (trace number) 

mem Memory data 

mem(scalar i) Memory data of trace i (trace number) 

xAxis X-axis data 

xAxis(scalar i) X-axis data of trace i (trace number) 

S11 - S44 S-parameter data 

 

Common H parameter, Y parameter, Z parameter, F parameter, and T parameter definition (2-

port network): 

1) Mixing Parameter(H) 

(
𝑉1

𝐼2
) = (𝐻) (

𝐼1

𝑉2
)      (𝐻) = (

𝐻11 𝐻12

𝐻21 𝐻22
) 

 

2) Admittance parameter(Y) 
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(
𝐼1

𝐼2
) = (𝑌) (

𝑉1

𝑉2
)      (𝑌) = (

𝑌11 𝑌12

𝑌21 𝑌22
) 

 

3) Impedance parameter(Z) 

(
𝑉1

𝑉2
) = (𝑍) (

𝐼1

𝐼2
)      (𝑍) = (

𝑍11 𝑍12

𝑍21 𝑍22
) 

 

4) Basic parameter(F) 

(
𝑉1

𝐼2
) = (𝐹) (

𝑉2

−𝐼2
)      (𝐹) = (

𝐴 𝐵
𝐶 𝐷

) 

 

5) Scattering transmission parameter(T) 

(
𝑎1

𝑏1
) = (𝑇) (

𝑏2

𝑎2
)      (𝑇) = (

𝑇11 𝑇12

𝑇21 𝑇22
) 

 

𝑎1 =
𝑉1 + 𝐼1𝑍0

2 ∙ √𝑍0

           𝑎2 =
𝑉2 + 𝐼2𝑍0

2 ∙ √𝑍0

 

 

𝑏1 =
𝑉1 − 𝐼1𝑍0

2 ∙ √𝑍0

           𝑏2 =
𝑉2 − 𝐼2𝑍0

2 ∙ √𝑍0

 

 

S parameter convert to H parameter, Y parameter, Z parameter, F parameter and T parameter 

(2-port network): 

1) S parameter convert to H parameter 

𝐻11 = 𝑍0 ∙
(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21

(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21
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𝐻12 =
2 ∙ 𝑆12

(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

 

 

𝐻21 =
−2 ∙ 𝑆21

(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

 

 

𝐻22 =
1

𝑍0
∙

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21

(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

 

 

2) S parameter convert to Y parameter 

𝑌11 =
1

𝑍0
∙

(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21

 

 

𝑌12 =
1

𝑍0
∙

−2 ∙ 𝑆12

(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21

 

 

𝑌21 =
1

𝑍0
∙

−2 ∙ 𝑆21

(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21

 

 

𝑌22 =
1

𝑍0
∙

(1 + 𝑆11)(1 − 𝑆22) + 𝑆12𝑆21

(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21

 

 

3) S parameter convert to Z parameter 

𝑍11 = 𝑍0 ∙
(1 + 𝑆11)(1 − 𝑆22) + 𝑆12𝑆21

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21

 

 

𝑍12 = 𝑍0 ∙
2 ∙ 𝑆12

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21
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𝑍21 = 𝑍0 ∙
2 ∙ 𝑆21

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21

 

 

𝑍22 = 𝑍0 ∙
(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21

 

 

4) S parameter convert to basic parameter 

A =
(1 + 𝑆11)(1 − 𝑆22) + 𝑆12𝑆21

2 ∙ 𝑆21

 

 

B = 𝑍0 ∙
(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21

2 ∙ 𝑆21

 

 

C =
1

𝑍0
∙

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21

2 ∙ 𝑆21

 

 

D =
(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

2 ∙ 𝑆21

 

 

5) S parameter convert to T parameter 

𝐷𝑠 = 𝑆11𝑆22 − 𝑆12𝑆21 

𝑇11 =
−𝐷𝑠

𝑆21

 

 

𝑇12 =
𝑆11

𝑆21

 

 

𝑇21 =
−𝑆22

𝑆21
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𝑇22 =
1

𝑆21

 

 

Description of formula editor’s operator: 

Operator Description Operator Description 

+ plus ( opening parenthesis 

- minus ) closing parenthesis 

* multiply , comma, parameter separator 

/ divide = equal 

^ power E exponent 

 

Note: operator priority: 

1. ^ 

2. *, / 

3. +, - 

 

8.6 Trace statistics 

Click Math → Analysis → Statistics, set the status to On to open the statistics function. The 

upper right corner of the interface will display the mean value, standard deviation, and peak to 

peak value of the current working trace. 
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Figure 8-5 Statistical data interface 

 

8.7 Limit test 

Limit Line is a test form that can visualize test data and results. The limit test compares the 

measured data with the defined limit and provides the qualified or unqualified judgment 

information of each measured data point. Limit line and limit test are not suitable for smith chart 

and polar coordinate display formats, and limit line and limit test functions are automatically 

disabled for these display types. 

 

Limit table setting 

Click Math → Analysis → Limit and the pop-up dialog box is shown in the figure below. Limit 

test, sound type, limit table, global pass/fail can be set in this interface. 
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Figure 8-6 Limit test interface 

 

Limit test: 

⚫ Limit test on: Check this box to compare the data with the limit and display “pass” or “Fail” 

judgment result. 

⚫ Limit line on: Check this box to display the limit on the screen. 

⚫ Sound on fail: When this box is selected, when the point on the trace fails in the limit test, a 

beep will sound. 

 

Sound type: 

⚫ Sound on fail: When this box is checked, the equipment will beep when the test fails. 

⚫ Sound on pass: When this box is checked, the equipment will beep when the test passes. 

Limit table: 

⚫ Show table: Check this box to open a table at the bottom of the screen to create and edit 
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limits. 

⚫ Load table: Call the saved limit table, the saved format of the limit table is CSV by default. 

 

Global pass / fail: 

Pass / fail indicator is a convenient way to monitor all measurement status. 

Global pass / fail on - Check this box to display the global pass / fail status. 

Policy - Select which of the following requirements must be met for the global pass/fail status to 

display “pass”: 

⚫ All tests must pass - This setting will read the results from the limit test. If all tests (limit test 

is on) pass, the global pass/fail status will be “pass”. 

⚫ All measurements must pass - Unless all measured data points are within the established 

test limits and the limit test is “on”, the global pass/fail status will be “fail”. 

Note: In this mode, if there is a test that does not set the limit test to the on state, the global pass 

/ fail will display “fail”. 

 

Limit line setting 

Click Math → Analysis → Limit Table → Limit to open the limit line setting interface, we can 

also click Math → Analysis → Limit → Show Table to open the limit line setting interface, as 

shown in the figure below. 
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Figure 8-7 Limit line setting interface 

 

Limit line type: 

⚫ Unused: Invalid limit line. 

⚫ Max: Above this limit line, the measurement fails. 

⚫ Min: Below this limit line, the measurement fails. 

⚫ Delete: Delete limit line. 

Begin stimulus: Frequency of the limit line’s starting point. 

End stimulus: Frequency of the limit line’s ending point. 

Begin response: Response of the limit line’s starting point. 

End response: Response of the limit line’s ending point. 

 

8.8 Point Limit test 

Overview 

Point Limit is a test form that can visualize test data and results. The limit test compares the 

measured data with the defined limit and provides the qualified or unqualified judgment 

information of the measured data point. Point Limit and limit test are not suitable for smith chart 

and polar display formats, and point limit and limit test functions are automatically disabled for 
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these display types. 

 

Point Limit table setting 

Click Math → Analysis → Point Limit and the pop-up dialog box is shown in the figure below. 

Point Limit Test, Sound Type, Point Limit Table can be set in this interface. 

 

Figure 8-8 Point Limit test interface 

 

Point Limit test: 

● Point Limit test on: Check this box to compare the data with the limit and display “pass” 

or “Fail” judgment result. 

● Point Limit on: Check this box to display the limit on the screen. 

● Sound on fail: When this box is selected, when the measurement point fails in the limit 

test, a beep will sound. 
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Sound type: 

● Sound on fail: When this box is checked, the equipment will beep when the test fails. 

● Sound on pass: When this box is checked, the equipment will beep when the test passes. 

 

Point Limit table: 

● Show table: Check this box to open a table at the bottom of the screen to create and edit 

point limits. 

● Load table: Call the saved limit table, The saved format of the limit table is CSV by default. 

 

Point Limit setting 

Click Math → Analysis → Limit Table → Point Limit to open the point limit setting interface, we 

can also click Math → Analysis → Limit → Point Limit→ Show Table to open the point limit 

setting interface, as shown in the figure below. 

 

Figure 8-9 Point Limit setting interface 

 

Point Limit type: 

⚫ Unused: Invalid point limit. 
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⚫ On: Open point test limit. 

⚫ Delete: Delete point limit. 

Stimulus: Frequency of the point limit. 

Lower Limit: Lower limit of response value for point limit. 

Upper Limit: Upper limit of response value for point limit. 

 

8.9 Ripple limit test 

The ripple limit test function can be performed independently of the limit test function, and the 

ripple limit can be set to evaluate whether the measurement result is qualified or unqualified. 

Ripple is defined as the difference between the maximum value and the minimum value within 

the specified excitation range. The ripple limit function is only applicable to the measured point 

value, not to the interpolation. 

Ripple table setting 

Click Math → Analysis → Limit → Ripple to open the ripple test setting interface, we can set 

ripple test, sound type, and ripple table in this interface. 
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Figure 8-10 Ripple test setting interface 

 

Ripple test: 

⚫ Ripple test on: Check this box to set the ripple test to “on” state and display “pass” or “Fail”. 

⚫ Ripple line on: Check this box to display the ripple limit line on the screen. 

⚫ Sound on fail: When this box is checked, the VNA will beep when the test fails. 

 

Sound type: 

⚫ Sound on fail: When this box is checked, the equipment will beep when the test fails. 

⚫ Sound on pass: When this box is checked, the equipment will beep when the test passes. 

 

Ripple table: 

⚫ Show table: Check this box to display a table at the bottom of the screen for creating and 

editing limits. 
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⚫ Load table: Call the saved ripple limit table. 

⚫ Save table: Save the ripple limit table, the saved format of the ripple table is CSV by default. 

 

Ripple limit line setting 

Click Math → Analysis → Limit Table → Ripple to open the ripple limit setting interface, we can 

also click Math → Analysis → Limit → Ripple → Show Table to open the ripple limit setting 

interface, as shown in the figure below. 

 

 

Figure 8-11 Ripple limit setting interface 

 

Type: 

⚫ Unused: Invalid ripple test line. 

⚫ On: Open ripple test limit line. 

⚫ Delete: Delete ripple test limit line. 

Begin stimulus: Frequency of ripple limit line’s starting point. 

End stimulus: Frequency of ripple limit line’s ending point. 

Max ripple: Maximum value of ripple test. 

Absolute: The difference between the maximum and minimum in the frequency band. 

Margin: The difference between the absolute value of ripple and the limit value. 
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8.10 Bandwidth limit test 

The bandwidth limit test function can be used to test the bandwidth of a bandpass filter. The 

bandwidth limit test can find the peak value in the bandwidth, and find the frequency points 

lower than the specified value of the peak value on the left and right sides of the peak point, and 

the frequency between these two points is the filter bandwidth, and then compare the obtained 

bandwidth with the minimum and maximum allowable bandwidth specified in advance.  

 

Bandwidth test setting 

Click Math → Analysis → Limit → Bandwidth to open the broadband test setting interface, we 

can set bandwidth test, sound type, and target bandwidth in this interface. 

 

 

Figure 8-12 Bandwidth test setting interface 

 

Bandwidth test: 

⚫ Bandwidth test on: Check this box to set the bandwidth limit test state to on. 
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⚫ Bandwidth marker on: Check this box to display the bandwidth on the screen. 

⚫ Sound on fail: When this box is selected, an alarm will sound when the bandwidth limit test 

fails. 

 

Target bandwidth: 

⚫ N dB points: Specifies the bandwidth threshold in dB. 

⚫ Min bandwidth: Enter the lower limit of bandwidth in Hz. 

⚫ Max bandwidth: Enter the upper limit of bandwidth in Hz. 

Note: If the data format is Smith chart or polar coordinate format, the bandwidth test is skipped. 

 

8.11 Time domain 

A vector network analyzer is usually used to measure the frequency domain characteristics of the 

DUT. For the time domain characteristics of the DUT, the frequency domain parameters can be 

obtained by inverse Fourier transform. The time-domain characteristics use time as the horizontal 

axis to display the measurement results. Then the characteristics of the DUT can be observed from 

two different visual angles of frequency domain and time domain by the vector network analyzer.  

 

8.11.1 Transform 

Click Math → Time Domain → Time Domain Setup → Transform to open the time domain 

transform setting interface, we can set the start time, stop time, center time, span, transform mode 

in this interface. 
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Figure 8-13 Time domain setting interface 

 

Transform switch: Check the transform switch to switch to time-domain mode.  

Start time: Set the start time of transformation displayed.  

Stop time: Set the stop time of transformation displayed.  

Center time: Set the center time of transformation displayed. 

Time span: Set the time span of the transformation displayed on the screen of VNA. 

 

Transform mode: 

● Low pass impulse:  

High resolution, suitable for viewing the small response of the device propagating low-

frequency signal. In this low pass impulse mode, the frequency expands to DC and negative 

frequency. Therefore, when we click Set Low Pass Frequencies, the starting frequency will be 

automatically adjusted, which will affect the calibration accuracy. Therefore, it is necessary to 

calibrate after setting the time domain measurement parameters.  

● Low pass step:  
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The simplest way to determine the discontinuities caused by inductors and capacitors in 

equipment that propagate low frequency signals.  

● Bandpass:  

The simplest method, which can be used with any frequency sweep, it is most useful when 

measuring devices with limited bandwidth. Capacitance and inductance reactance will not 

be shown. For the same frequency range and number of points, the bandwidth of bandpass 

mode is twice that of impulse mode, which will hide the closely spaced response and reduce 

the response resolution. The measurement range is inversely proportional to the frequency 

step. 

 

Set low pass frequencies:  

It can only be used in low pass mode. After clicking Set Low Pass Frequencies, the measurement 

range is inversely proportional to the starting frequency. Recalculate the start frequency and step 

frequency as the harmonics of the starting frequency. Calculate the starting frequency according 

to the formula of low pass start frequency = stop frequency/points. The calculated value must 

not be less than the minimum frequency of the vector network analyzer. The number of points or 

stop frequency may change. 

 

8.11.2 Gating 

The gating function of a vector network analyzer is the most useful feature in time domain 

transform. When the time domain characteristics of the equipment need to be viewed, the 

gating function can only choose the required time-domain response, eliminate unnecessary 

time domain response, and then view the frequency domain characteristic curve of the required 

response through Fourier transform. The gating function enables the DUT to be characterized 

without connectors or adapters. 
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Click Math → Time Gating → Gating Setup → Gating to open the gating setting interface, then 

we could set the start time, stop time, center time, span, gate type, and gate shape in this 

interface.  

 

 

Figure 8-14 Gating setting interface 

 

Gating on: Open or close the gating function. 

Start time: Set the start time of gating. 

Stop time: Set the stop time of the gate. 

Center time: Set the center time of the gate. 

Time span: Set the time span of the gate. 

Gate type: Sets the type of filtering performed by the gating function. 

⚫ Bandpass: Keep the response in the gating span. 

⚫ Notch: Remove response using the gating span. 
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Gate shape: Set the filter characteristics of the gating function. There are four options: minimum, 

normal, wide, and maximum. 

 

The parameter definition of the gating function is shown in the figure below: 

Bandwidth ripple

Sidelobe level

Gate shape

Gate marker

-6dB

T1

Gate start ti me Gate stop tim e

 

Figure 8-15 Diagram of gating 

 

Parameter description of gating function: 

Gate shape Bandwidth ripple Sidelobe level 

Minimum ±0.1 dB -25dB 

Normal ±0.1 dB -45dB 

Wide ±0.1 dB -52dB 

Maximum ±0.01 dB -80dB 

 

8.11.3 Window 

There will be sudden changes in the start and stop of frequency domain parameter 

measurement, which will lead to overshoot and ringing in the time domain. The window function 

is helpful to reduce the overshoot and ringing in the process of frequency domain and time 

domain conversion.  

 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  223 

Click Math → Time Gating → Gating Setup → Window to open the window setting interface, we 

can set the window size, The size of the window should be balanced between response 

resolution and dynamic range. Setting the minimum window can get the best response resolution, 

and setting the maximum window can get the maximum dynamic range.  

 

 

Figure 8-16 Window setting interface 

 

Three methods of setting window size: 

⚫ Minimum-maximum: Use the mouse or touch screen to move the slider to change the 

window size. 

⚫ Kaiser Beta: Use the value of Kaiser Beta to change the window size. 

⚫ Impulse width: Use the value of impulse width to change the window size. 
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Figure 8-17 Diagram of maximum and minimum window 

 

8.11.4 Coupling 

Trace coupling allows to change the measured time-domain parameters and make all other 

measured parameters in the channel change the same. For example, to view the frequency-

domain and time-domain measurement parameters at the same time, first turn on the coupling 

switch and select all the gating parameters in the coupling setting interface, at the same time, the 

parameters of gate span are changed in time domain measurement, the frequency-domain 

measurement parameters will be changed automatically to reflect the effect the time domain gate 

span parameters are modified. The trace coupling is only applicable to Y-axis scale / reference 

settings. The results of trace coupling do not change the measured data.  

 

Click Math → Time Gating → Gating Setup → Coupling to open the coupling setting interface, 

we can set transmission parameters and gating parameters in this interface. 
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Figure 8-18 Coupling setting interface 

 

Coupling on: Click to enable coupling. At this time, all measurements in the channel are coupled. 

The following conversion parameters and gating parameters can be used for coupling. 

 

Transform parameters: 

⚫ Stimulus: Setting of the start time, stop time, center time, and span. 

⚫ State(On/Off): State of the transform. 

⚫ Window: Kaiser Beta and pulse width parameter. 

⚫ Mode: Low pass pulse, low pass step, bandpass. 

⚫ Distance marker unit: When selected, all measured distance marker units are coupled. 

 

Gating parameters: 

⚫ Stimulus: Setting of the start time, stop time, center time, and span. 

⚫ State (On/Off): Switch of gating function. 
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⚫ Shape: “Minimum”, “normal”, “wide” and “maximum”. 

⚫ Type: Bandpass and notch filtering. 

 

8.11.5 Marker 

When a marker is added to a time-domain parameter, the distance parameter is automatically 

displayed in the marker reading. These settings only affect the display of all markers of the active 

measurement (Unless the distance marker unit is coupled in the trace coupling box). 

Click Math → Time Gating → Gating Setup → Marker to open marker setting interface. Set the 

marker mode, units, and velocity factor in this interface. 

 

 

Figure 8-19 Marker setting interface 

 

Marker mode: Specify the marker mode to determine the correct marking distance displayed. 

Generally, Auto can be selected when measuring S parameter, and Reflection or Transmission 

can be selected when measuring any ratio parameter. 

⚫ Auto: If the measurement parameter is S parameter, Reflection or Transmission will be 
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selected automatically. If the measurement parameter is a non-S parameter, Reflection 

will be selected automatically. 

⚫ Reflection: Displays the distance from the source to the receiver and the return path, 

then divides by 2 (compensated return path). 

⚫ Transmission: Displays the distance from the source to the receiver. 

Units: Specifies the unit for the displayed marker distance value, there are three options: meter, 

feet, and inches. 

 

Velocity factor: Set the velocity factor of the transmission line, where the value of PE is 0.66, PTFE 

is 0.7 and the corresponding value of vacuum is 1.  

 

8.11.6 Advance 

Description 

In time-domain low-pass pulse and step transformation modes, users can choose to use the 

automatic extrapolation function provided by the instrument to determine the DC component 

value, or customize the extrapolation value. 

 

DC Value 
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DC Value Setting 

Entry: Math → Time Domain → Time Domain Setup → Advance → DC Value 

Auto Extrapolate Switch: (Auto Extrapolate) Used to turn on or off the automatic extrapolation 

processing of the instrument. 

User Manual Entry: Users can manually enter custom DC values or click on the Extrapolate 

button to obtain the values extrapolated by the instrument based on the latest data. In addition, 

the UI also provides convenient input of Open, Short, and Load configuration values, allowing 

users to freely choose appropriate extrapolation values based on the DUT type. 

8.12  DTF(Distance-to-Fault) 

8.12.1 DTF Overview 

The essence of DTF (Distance-to-Fault) is to accurately locate the fault points (such as open 

circuit, short circuit, impedance mutation) in the cable, antenna or transmission line through the 

combination of time domain reflectometry (TDR) and frequency domain to time domain signal 
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conversion. 

8.12.2 DTF Measurement Principle 

The implementation principle of DTF is as follows: 

 

 

8.12.3 Performing DTF Measurements 

8.12.3.1 Enabling DTF and Parameters Configuration 

Press Math >DTF on the front panel to enable the DTF function, as shown in the figure below. 

(1)The VNA transmits a sweep signal

(2) Signal propagation along cable → reflection at fault point

(3) The VNA captures the S11 frequency domain data

(4) Use IFFT funtion→ Generate Time Domain waveform

(5) Peak detection → Calculate the distance of the fault point
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1.Frequency Range Configuration 

Adjust the frequency range according to cable length for optimal results: 

 For Extended-range cables (>100 meters):  

Set 1 MHz (start) to 100 MHz (stop) for optimal signal integrity 

 For Short-range cables (<10 meters) : 

Set 1 GHz (start)to 3 GHz (stop)for enhanced resolution 

2. Critical Parameters 

○A Velocity Factor: 0.66 (typical for coaxial cables) 

○B Cable Attenuation: Input the cable loss value based on specifications 

    ○C DTF Window: Press Math>Time Domain>TD Mode to configure the Time Domain Mode. 
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Low-Pass mode reduces high-frequency noise and the Band-Pass mode maintains signal 

details. Then select a suitable window function to minimize spectral leakage. 

Window Function Description 

Hamming 
Prioritizes clarity over resolution (ideal for long-distance/noisy 

environments) 

Kaiser Beta 
Maximizes resolution with potential false peaks (recommended for short-

distance analysis) 

OFF No window applied 

 

○D Kaiser Beta: Adjust between 0–13 for precision tuning. 

○E Start Dist: set the start distance, default 0 m. 

○F Stop Dist：set the maximum measurable distance (for example, 50 meters). 

○G Units: Meters (m), Feet (ft), or Inches (in). 

8.12.3.2 VNA Calibration Procedure 

Navigate to the VNA calibration menu and select the single-port OSL calibration. 

Sequentially connect Open, Short, and Load calibration standards to VNA Port 1, and follow the 

prompts to complete calibration. 

Validate calibration results: Observe whether the S11 curve in the frequency domain is smooth. 

8.12.3.3 Execute DTF Measurements 

1. Connect the Device Under Test (DUT) to  VNA Port 1, set the trigger to single or continuous 

sweep mode, and observe the time-domain trace. 

2. Horizontal axis: Distance (meters); Vertical axis: Reflection coefficient (logarithmic 

magnitude format) or VSWR (Voltage Standing Wave Ratio format) 

8.12.3.4 DTF Measurement Result Analysis 

The maximum peak in the trace corresponds to the fault location, with the fault distance directly 
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displayed on the UI. Users may also utilize the marker function to label the peak and read the 

fault distance. 

Fault Type Determination: 

 A positive reflection peak indicates an open circuit or high-impedance discontinuity in the 

cable 

 A negative reflection peak indicates a short circuit or low-impedance discontinuity in the 

cable. 
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9 Save and Recall 

The vector network analyzer supports save and recall functions for files of various formats. Press 

the Save/Recall button on the front panel and select file, data, calibration data, and images to 

save or recall, in the menu bar on the right side of the screen.  

 

Figure 9-1 Operating interface 

 

Description of supported file formats: 

⚫ CSA file: Save the status information and calibration data of the equipment. 

⚫ STA file: Save device status information. 

⚫ CSV file: Save trace data information. 

⚫ CAL file: Save calibration data. 

⚫ SnP file: also known as Touchstone file. Touchstone file is a standard format file used for 

various simulation software. The simulation software calls this file to represent a device 

or circuit. TouchStone file names all have a. snp extension. N represents the number of 
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ports S2p represents a 2-port network. S4p represents a 4-port network. Taking a 

TouchStone file from a two port network as an example. This file is a plain text file that 

can be opened directly with Notepad.The S parameters of the two port network have a 

total of 9 columns, arranged in the order of frequency, amplitude S11, phase S11, 

amplitude S21, phase S21, amplitude S12, phase S12, amplitude S22, and phase S22. 

The frequency is arranged in ascending order from top to bottom, with no strict 

spacing in between, but must be in ascending order.It is worth noting that in the 

TouchStone file measured with VNA, there is no DC point, which means there is no 0 

frequency, and it cannot be directly called by simulation software. It needs to be edited 

to supplement the 0 frequency and corresponding S parameter values. In this example, 

dB in the first row represents the expression of complex numbers, where dB represents 

amplitude in dB and phase in angle. If MA is displayed at this position in the file, it 

means that both amplitude and phase are represented by actual numerical values. R50 

represents a reference resistance of 50 ohms for matching. 

⚫ PNG/JPG/BMP files: Save screenshots. 

 

9.1 Recall 

⚫ Recall State: Use the Recall State command in the Recall submenu and select to call the 

desired device state in. sta file format. 

⚫ Recall State + Cal…: Use the Recall State+Cal command in the Recall submenu, select 

to call the required device status and calibration data in. csa file format. 

⚫ Recall Register: Use the Recall Register command in the Recall submenu to select the 

register data to be called. 

⚫ Recall Cal…: Use the Recall Cal command in the Recall submenu and select to call the 

required calibration data in. cal file format. 
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9.2 Save State 

 Save Status: Immediately save the device's status and calibration data to the selected 

filename, depending on the "Save Type". 

 Save Status As…: Open the "Save As" dialog. 

 Save Register:  Save the device's status information to a specified register (Registers 1–8), 

depending on the "Save Type". Data will be lost after device restart if saved to a register. 

 Save Type: 

Status: Save device status with a” .sta “filename. 

Status + Calibration Data: Save device status and calibration data with a “.csa “filename. 

 

9.3 Recall Data 

 Recall Data: Use the Recall Data command in the Recall submenu and select to call data as 

a CSV file or SNP file. You can choose to load file data into the current channel, create a new 

channel, or select the current trace in the dropdown menu of Recall Data. 

 Interpolation: When calling data, optimize trace data by setting whether to interpolate 

based on the difference between the number of data points in the file and the number of 

channel scanning points. 

 

9.4 Save Data 

 Save Trc Data…: Save active trace data on the working channel in CSV format (.csv 

extension) 

 Save Multiple Traces…: 
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For single-trace channels: Save the selected trace. 

For multi-trace channels: A dialog opens to select traces. 

 

Figure 9-2 Select traces interface 

 

All: Toggle selection of all traces in the current channel. 

In material measurement mode: Traces with measurement types μ (permeability) or ε 

(permittivity) automatically save results (relative permittivity, loss tangent, etc.).Non-μ/ε 

traces follow standard CSV saving procedures. 

Note: Trigger a single measurement before saving to ensure the VNA channel is in a "Hold" 

state for complete data capture. 

CSV Format: Determines the format of the data: 

▪ Auto (adapts to current display format) 

▪ Linear Mag/Angle 

▪ Log Mag/Angle 

▪ Real/Imaginary 

▪ Displayed Data 

Note: "Auto" mode defaults to Real/Imaginary format if the active trace uses display formats 

beyond Log Mag, Linear Mag, or Real/Imaginary. 

 Save SnP:  
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user can save the working trace data on the working channel in snp format (file 

extension *.snp). The SnP file is mainly used to Save the measured S-parameter. In 

order to facilitate the user to save the required S-parameter, you can select the port. 

Click the submenu item of "Save SnP", and shown as the following dialog: 

 

Figure 9-3 Choose ports interface 

 

If the user selects the corresponding port, the corresponding S parameter can be 

saved. The data obtained during the balance measurement is the balance S parameter. 

In order to facilitate the user to Save the corresponding balance S parameter during the 

balance measurement, you can click the submenu item of "Save SnP" after selecting the 

balance measurement track. At this time, the option on the port selection interface is 

logical port, which is associated with the set port topology. After selecting the 

corresponding balance port, the corresponding balance S parameter can be saved.  

 SnP Format:  

▪ Auto - Data is saved in LogMag or LinMag if one of these is the currently 

selected format. If format is other than these, then data is saved in 

Real/Imag. 

▪ LogMag, LinMag, Real/Imag - Select output format.  The imaginary 

portion for all LogMag and LinMag data is output is in degrees. 

 



SNA5000A&SNA5000X-E User Manual 

238                                                                                   int.siglent.com 

9.5 Save Other 

 Screenshot…: Use the Screenshot command in the Save Other submenu to save the 

screenshot. You can set the default path in the pop-up dialog box and save the 

screenshot in PNG/JPG/BMP file format. 

 Save Cal…: Use the Save Cal command in the Save Other submenu to save channel 

calibration data in”. cal” format. 

File management: 

Click File Browser command to open the file browser, File management can be carried out in the 

file browser. 

 

Figure 9-4 File management interface 
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10 Time Domain Reflectometry (TDR) 

10.1 Overview 

Measured frequency responses can be transformed to the time domain to analyze the time-

domain characteristics of the DUT. The TDR option provides the time domain 

reflection/transmission analysis functions and eye diagram simulation function, which can help 

users save time and money by minimizing the need for other test equipment Time domain 

analysis also has some irreplaceable advantages: 

1. Time-domain analysis shows the positions and properties of the impedance discontinuities 

on DUT. It can be easy to acquire the impedance value at any point on the transmission line 

by analyzing the time domain reflection characteristics. It's helpful to locate the faults on 

transmission lines. 

2. Using the time domain gating function to remove the influences of the impedance 

discontinuities, it becomes possible to simulate the frequency domain characteristics of 

DUT after the faults are removed. 

3. The eye diagram simulation function doesn't need any external waveform generators. The 

VNA uses a built-in virtual bit pattern generator to provide the input signal. It's a very 

important tool for signal integrality analysis. 

4. If you want to design a compensation network for high-speed digital signal transmission by 

emphasis/ de-emphasis or equalization, the advanced waveform function in TDR waveform 

will be of vital use for you. You don't need to change the DUT connection or any extra 

devices, it's easy to simulate the eye diagrams with the different compensation methods. 

5. You can directly inject jitter into the input signal for eye diagram simulations. A statistical eye 

diagram is introduced to simulate the probability density of the output signals. 

 

When using the TDR option, there are some notes: 
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1. When opening the TDR option or switching the DUT topology, calibration and deskew data 

will be cleared. Please finish the calibration wizard before measuring to get the correct results. 

Save the calibration data and recall it when required, which can avoid unnecessary calibration 

operations. 

2. Please operate in the bottom toolbar of the TDR menu as far as possible. The function in the 

TDR option desends on the time domain transform, so changing settings in the right toolbars 

can lead to incorrect transform results. 

3. Don't close the eye diagram module while the eye diagram is drawing, or an unexpected 

error might occur. Unless necessary, don't switch between the TDR/TDT module and the eye 

diagram module, for the last eye diagram will be drawn when it's switched to the eye 

diagram module, which might take a long time. 

4. It's NOT recommended to add too many traces, or the trace data update will be slow. 

5. If there are too many windows or too much information in a window to observe the 

information or traces, it will be useful to maximize the window or trace. 

 

10.2 Open/Close/Preset TDR 

Option TDR must be enabled. 

To switch on the TDR option, use the order Math->TDR->TDR, then the button "On" will be 

selected. The TDR toolbar will appear at the bottom of the screen, and the TDR option function 

will be open to the user. If you have the trial license for the TDR option, an information dialog will 

appear to notify you that the trial times will decrease. If the trial times expire, a permanent 

license is needed to switch on the TDR option. 
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Figure 10-10-1 TDR Option interface 

 

To close the TDR option, use the order Math->TDR->TDR again, then the button “Off” will be 

selected, VNA will restore the state before the option opened. Click the  button at the top 

right corner of the TDR toolbar will close the TDR option too. 

Click the Preset button in the Basic bar of the Setup tab in the TDR toolbar and the VNA will preset 

the TDR option: Clear the calibration data, allocate the traces and windows automatically, and 

reset the settings in the option. After the TDR option is started, the calibration wizard will need to 

be run again. 

 

10.3 TDR Setup Wizard 

The TDR setup wizard pops up when the TDR option is switched on for the first time. Click the 

checkbox “Show this wizard next start-up” to decide whether the wizard pops up when opening 

the option or not. The wizard can be opened by clicking the Setup Wizard button in the Basic bar 
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of the Setup tab in the TDR toolbar. 

 

 

Figure 10-10-2 TDR Setup Wizard 

 

The wizard will guide you to finish the DUT topology selection, port extension setup, DUT length 

measurement, and stimulus rise time setting. The calibration type can be selected in the Error 

Correct bar on the first page of the wizard, and the wizard will also guide you to finish the 

calibration you select. The calibration operation will be illustrated in detail in the section “TDR 

calibration”. 

If you don't need to finish the setup in the wizard immediately, you can close the wizard. But the 

calibration is necessary before accurate measurement or analysis. 

 

10.4 Calibration for TDR Option 

There are two calibration types in the TDR option: Deskew or Deskew & Loss Compensation. The 

former only moves the reference plane to the end of the cables connected to the ports of VNA, 
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ignoring the signal loss in the cables. And the latter tries to compensate the loss in the cables. 

 

 

Figure 10-10-3 TDR Calibration Tab 

 

10.4.1 Deskew 

Click the Deskew button in the Basic bar of the Setup tab in the TDR toolbar to open the Deskew 

dialog. Connect all cables and fixtures to the VNA, and connect the other ends of the fixtures to 

nothing or the OPEN calibration kit. Then click the Deskew button in the dialog, and click the Finish 

button after a  mark appears at the Deskew button to finish the Deskew calibration. 

 

Click the Option button to open the Deskew Option dialog, in which you can select the 

calibration type or operate the calibration one-by-one for each port. The calibration type can be 

selected by the Standard Type pull-down menu. It's set to Open by default. If you choose the 

Short option, you should connect the SHORT calibration kit to the port to finish the calibration. 

You can calibrate only one port at a click on the corresponding Port button, but you should finish 

the calibration of all ports to finish the task in the dialog. 
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Figure 10-10-4 TDR Deskew Wizard 

 

10.4.2 Deskew & Loss Compensation 

Click the Deskew&Loss button in the Basic bar of the Setup tab in the TDR toolbar to open the 

Deskew & Loss Compensation wizard. The wizard can be divided into 3 steps, which guide you to 

finish the Deskew and Loss Compensation calibration. 

At the first step, a Deskew calibration is required. The method is the same as the operation 

introduced in the section “Deskew”. 

At the second step, the calibration operation depends on the correct DUT topology. Under the 

topology Single-Ended 1 Port, you need to connect the cables and fixtures to the VNA, connect 

the other ends of the fixtures to nothing or an OPEN calibration element. Click the Measure button 

in the wizard, wait for the  mark to appear at the Measure button to finish the second step of 

calibration. Under other DUT topologies, you need to connect two cables and fixtures, which are 

connected to the ports as the wizard instructs, to both ends of a THRU calibration kit. Click the 

Measure button in the wizard, wait for the  mark to appear at the Measure button, then execute 
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the next operation. If under Single-Ended 4-Port or Differential 2-Port, you will need to execute 

the operation as stated above once for each page of the wizard respectively to finish the second 

step. 

At the third step, you can connect the LOAD calibration element to every port, and click the 

corresponding Port button to execute the calibration step. The step is optional, so it's not 

necessary to finish the calibration wizard. 

If you finish all necessary calibration operations, click the Apply button to save and apply new 

calibration data, and click the Finish button to close the wizard.  

 

 

Figure 10-10-5 TDR Deskew & Loss Wizard 

 

At any step of the wizard, it's allowed to execute a calibration operation repeatedly, new 

measured data will replace original data. You can click the Close button to close the wizard, 

which will give up all data measured in the wizard unless you have clicked Apply button to save 

them. 
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10.5 TDR Channel Setup 

When the TDR function is activated, the current state is saved, and all existing traces and 

channels are deleted, and a new channel is added for the option. When the option is closed, all 

traces and the channel being used are deleted, and the instrument is returned to the state 

before TDR was opened.  

The current channel settings can be changed in the TDR toolbar at the bottom of the screen, 

usually in the Setup tab. 

 

Figure 10-10-6 TDR Setup Tab 

 

10.5.1 DUT Topology 

In addition to the Setup wizard, the DUT topology can be changed in the DUT topology pull-down 

menu in the Basic bar of the Setup tab. The traces and windows are allocated automatically 

according to the DUT topology. 

If the DUT topology is changed, the calibration and deskew data will be cleared. Recalibration 

becomes necessary before an accurate measurement or analysis. If the calibration data is hoped 

to be held, save the state in time and recall it when required. 

 

10.5.2 DUT Length 

The DUT length means the time that the signal takes to transmit through the DUT or reflect the 
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incident plane and is required to show the time-domain responses of DUT in full. The sweep 

frequency span and points of the channel are set according to the DUT length, and the span of the 

transformation is automatically calculated by the DUT length when the time domain traces are set 

in the time axes. It's not recommended to change the sweep settings by other methods. 

 

 

Figure 10-10-7 DUT Length measure wizard 

 

In addition to the Setup wizard, the DUT length can be set in the DUT Length textbox in the Basic 

bar of the Setup tab. It's a convenient way to set the suitable value by measuring the DUT length 

in the DUT Length dialog. Click the Auto button on the left of the textbox to open the dialog, 

connect the DUT according to the picture and instructions in the dialog, click the Measure button 

and wait for the  mark to appear, click the Finish button to close the dialog, and finish the DUT 

length setting. If the measurement result is out of the default range, an information dialog will pop 

up to notify the users that the DUT length will be set to the maximum or minimum. 
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10.5.3 Stimulus Magnitude in Time Domain 

The stimulus magnitude in the time domain can be set in the Stim. Ampl. textbox in the Basic 

bar of the Setup tab, which defines the magnitude of the impulse or step stimulus signal for the 

time-domain responses of the traces under the format Volt. 

 

10.5.4 Port Impedance 

The port impedance can be set in the Ref. Z textbox in the More Function bar of the Setup tab, 

which defines the reference impedance to calculate the impedance values of the traces under 

the format Impedance. 

 

10.5.5 Velocity Factor & Dielectric Constant 

The velocity factor is the ratio of the velocity of the electric signal in the DUT to that in the vacuum. 

VNAs calculate the distances by the transmission or reflection time based on this factor, which 

provides the accurate positions of the impedance discontinuities. There is a functional relationship 

between the velocity factor and the dielectric constant of the materials. When either is changed, 

the other will be calculated by the equation below: 

Velocity Factor =
1

√𝐷𝑖𝑒𝑙𝑒𝑐𝑡𝑟𝑖𝑐 𝐶𝑜𝑛𝑠𝑡𝑎𝑛𝑡
 

 

The velocity factor and dielectric constant can be set in the Velocity Factor and Dielectric Const. 

textboxes in the More Function bar of the Setup tab. 

 

10.5.6 Power Level 

The power level is the power of the test signal transmitted to the DUT, which can be set in the 
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Source Power spinbox in the More Function bar of the Setup tab. 

 

10.5.7 Average 

The average function means that the final measure results are equal to the average of the measure 

results in the several sweeps in the same setting, and the number of sweeps needed depends on 

the averaging factor. The average function can decrease the random errors to some degree, but 

slow down the update of trace data. It's necessary to keep the characteristics and connection of 

the DUT unchanged during an average sweep. 

To enable or disable the average function, click the Averaging checkbox in the Average tar of the 

Setup tab. The average factor can be set in the textbox to the right of the checkbox. 

 

 

Figure 10-10-8 Avg/BW setting 

 

10.5.8 IF Bandwidth 

The IF bandwidth is the bandwidth of the intermediate-frequency filters in the receivers. A 

narrow IF bandwidth leads to lower trace noise levels and longer sweep times. 

The IF bandwidth can be set in the IF Bandwidth textbox in the Average tar of the Setup tab. 

 



SNA5000A&SNA5000X-E User Manual 

250                                                                                   int.siglent.com 

10.5.9 Trigger Mode 

The trigger mode gates the channel sweep state change when the trigger signal is detected. The 

trigger mode Hold/Stop means that sweep can't be started even if the trigger signal is detected. 

Single means that only one sweep is triggered by the trigger signal. Upon sweep completion, the 

trigger mode is set to Hold/Stop. Continuous/Run means that the trigger signal starts and 

continuously sweeps. 

To switch the trigger mode to Continuous/Run, click the Run button at the top of the TDR 

toolbar. To switch the trigger mode to Single, click the Stop/Single button at the top of the TDR 

toolbar. 

 

10.6 TDR Trace Setup 

Without taking the set coupling into account, the settings as follows are applied to a single trace. 

Usually, the traces in the TDR option are in a time-domain coupling and marker coupling, meaning 

that the correlated settings are applied to all the traces. In addition, there is a set of default trace 

configurations for every DUT topology. 

 

10.6.1 Select a Trace 

In addition to clicking the trace or trace information bar on the screen, the Trace pull-down menu 

at the top of the TDR toolbar has the same function. 

 

10.6.2 Scale Management 

In the TDR option, there are several automatic scale settings to use, and it is allowed to change 

the scale or reference value manually. 
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10.6.2.1 Auto Scale 

To apply the automatic scale settings, click the Auto Scale button at the top of the TDR option and 

click the suitable option in the pull-down menu. Every option in the menu represents a set of 

automatic scale settings. 

Option X means that the horizontal axis of the current trace is set automatically. For the traces in 

the time domain, the scale and reference value are calculated by the DUT length. For the traces 

in the frequency domain, the horizontal axis is set to the frequency sweep setting of the channel. 

Option Y means that the vertical axis of the current trace is set automatically. The scale and 

reference value are calculated by the maximum and minimum of the trace data. 

Option X&Y means that the horizontal and vertical axes of the current traces are set 

automatically. The method is the same as introduced above. 

All Trace means that the horizontal and vertical axes of all the traces are set automatically. The 

method is the same as introduced above. 

 

10.6.2.2 Manual Scale Setup 

Manual calibration Settings are implemented through the Scale setting option in the TDR menu. 

Horizontal is used to set the Horizontal coordinate and the reference point position, Vertical is 

used to set the Vertical coordinate and the reference value. Users click the corresponding edit 

box to enter the value through the number button on the front panel. 
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Figure 10-10-9 Scale Setup by manual 

The vertical axis of the traces in the frequency domain has no concern with the sweep setting of 

the channel, only to set the displayed span of the trace data. 

 

10.6.3 Memory Trace Management 

Memory trace management is in the Data/Mem pull-down menu at the top of the TDR toolbar. 

Click the Data->Mem order in the menu, and the current trace data is saved to the memory 

trace. Other orders in the menu are display modes of the data trace and the memory trace for 

the current trace: The option Off means the data trace and the memory trace are invisible. The 

option Memory means only the memory trace shows in the window. The option Data means only 

the data trace shows. The option Data&Mem means both of them are visible. 

 

10.6.4 Measure Parameter & Format 

The measurement parameters and formats of the traces can be set in the Parameter tar of the 

TDR/TDT tab. 

The physical significance of measurement parameters and formats in the frequency domain is 

the same as the general parameters of the VNA. In the time domain, T parameters are used as 

measurement parameters, meaning that the ratio of the magnitudes of the response signals 

received to the stimulus signals when a unit step / impulse stimulus signal is transmitted to DUT 

at time zero, in a span. For a specified DUT, S parameters are functions of the signal frequency, 

while T parameters are functions of the time under a specified stimulus type. T parameters show 

the unit step / impulse response of the DUT, which is of vital importance in the time domain 

system analysis. 
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Figure 10-10-10 measure parameter setting 

 

The formats of T parameters include Log Mag, Lin Mag, and Real, which are the same as S 

parameters; moreover, Impedance and Volt are added. T parameters show the time domain 

responses, so the values are always real numbers. In the other words, the imaginary parts are 

always zero. Therefore, Imaginary or phase formats aren't provided for T parameters in the TDR 

option. The magnitude of Log Mag and Lin Mag formats is intrinsically the absolute values of the 

real parts of T parameters. 

Impedance format is usually used for the reflection T parameters under a unit step stimulus. It 

calculates the impedance value of each point in the signal transmitting path by the reflection T 

parameters (reflection coefficients) under the unit step stimulus, which is on the base of the port 

impedance. The distances are calculated by the delay of transmission and the velocity factor. In 

the Impedance format, the positions and properties of impedance discontinuities in the DUT are 

shown on the traces visually, which provides a piece of important information for fault detection 

and removal. In the Impedance format, the TDR option regards the T parameters as the 

reflection coefficients ρ, and calculates the impedance by the equation as follow: 

 

 

Volt format means the trace shows the time domain waveform of the response signal received 

under the specified stimulus. The magnitude of the stimulus signal is defined by the value in the 

Stim. Ampl. textbox in the Basic bar of the Setup tab. Intrinsically, the Volt format means the 

trace data is a product of the T parameters and the magnitude of the stimulus signal. 
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Click the measure parameter button in the grids on the left of the Parameter bar, the 

measurement parameter of the current trace switches to the corresponding parameter. To 

switch on or off the time domain transform of the current trace, click the pull-down menu in the 

left of the Measure line. To switch to balance or unbalance parameters, click the pull-down menu 

in the right of the Measure line. To change the format, click the Format pull-down menu. 

 

10.6.5 Stimulus in Time Domain 

The stimulus type can be set in the Stimulus pull-down menu in the Parameter bar of the 

TDR/TDT tab. There are two stimulus types to choose: The option Lowpass Step means T 

parameters show the unit step responses and the option Lowpass Impulse means T parameters 

show the unit impulse responses. 

The rise time or impulse width of the stimulus signal can be set in the Rise Time or Impulse Width 

textbox. Intrinsically, it controls the beta value of the Kaiser window function applied in the time 

domain transformation to weaken the sidelobes. Because the transformation is based on the 

finite frequency domain data, the data truncation at the end of frequency domain data leads to 

some problems, such as the extension of the rise time or impulse width of the responses signal 

and the appearance of sidelobes, which is called "truncation effect". Applying the Kaiser window 

lowers the sidelobe levels, but aggravates the extension of the rise time or impulse width and 

brings down the resolution ratio of transformation. The longer the rise time or impulse width of 

the stimulus signal, the larger the beta value of the Kaiser window function, the stronger effects 

explained above are introduced into the transformation. 

 

10.6.6 Smoothing 

The smoothing function makes the trace data smooth by replacing the original trace data with 

the average of the data nearby. If the local change ratios of trace data are relatively large, the 
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smoothing leads to large data errors. Therefore, the smoothing function is available for the traces 

whose measure parameters are reflection S parameters. 

To switch on or off the smoothing function, click the Smoothing checkbox in the Parameter bar 

of the TDR/TDT tab. 

 

10.6.7 Trace Allocation 

The TDR option will delete all existing traces and windows, allocate all the traces and windows 

automatically for the DUT topology, and set the traces to default settings if the trace allocation 

function is activated. The operation deletes all original traces and their settings, but the channel 

settings remain. There are three allocation methods to choose from: The option Mixed means 

that the traces in the time and frequency domain are allocated. The option All T means that only 

traces in the time domain are allocated. The option All S means only traces in the frequency 

domain. Note that in Single-ended 1 Port topology, only the option Mixed is available. 

To use the trace allocation function, click the button of the corresponding method in the 

Allocation box in the Trace Control bar of the TDR/TDT tab. 

 

 

Figure 10-10-11 Trace Control Tab 

 

10.6.8 Trace Setup Coupling 

In the TDR/TDT Tab of TDR, users can select the Coupling box of the Scale, Marker, or Gating 

menu option to enable Time domain setting coupling, Marker coupling, or Gate coupling for 
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traces. 

10.6.9 Time Domain Gating 

The time-domain gating function transforms the time domain response into the frequency 

domain after removing a part of the response. Usually, the function is used to simulate the 

expected frequency domain response after removing some faults by removing the abnormal 

responses resulting from the impedance discontinuities. The operation procedure includes 

enabling the time domain transformation, setting the parameter to remove partial time-domain 

responses, observing the other traces in the frequency domain whose gating settings are 

coupled with the trace, or close the time domain transformation to observe the frequency 

responses. 

The time-domain gating settings in the TDR option can be changed in the Gating bar of the 

TDR/TDT tab. 

 

Figure 10-10-12 TDR Gating Tab 

To switch on or off the time domain gating function, click the Gating checkbox. 

To change the function type of the gating range, click the ratio button in the Type box. The 

option Notch means that the responses in the gating range will be ignored, while the option 

Bandpass means that the responses beyond the gating range will be ignored. 

The scroll-wheel and textbox can be used to change the start and stop position of the time 

domain gating range. 
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10.6.10 DC Value 

Description 

In time-domain low-pass pulse and step transformation modes, users can choose to use the 

automatic extrapolation function provided by the instrument to determine the DC component 

value, or customize the extrapolation value. 

 

DC Value Setting: 

Entry: TDR → TDR/TDT → DC 

Auto Extrapolate Switch: (Auto Extrapolate) Used to turn on or off the automatic extrapolation 

processing of the instrument. 

User Manual Entry: Users can manually enter custom DC values or click on the Extrapolate 

button to obtain the values extrapolated by the instrument based on the latest data. In addition, 

the UI also provides convenient input of Open, Short, and Load configuration values, allowing 

users to freely choose appropriate extrapolation values based on the DUT type. 

 

10.7 TDR Data Analysis & Output 

The general marker search function is available in the TDR option for data analysis, and there are 

some shortcuts provided at the top of TDR toolbar for marker management and search for 
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maximum/minimum with tracking. In addition, the functions of the rise time search and delta 

time search are introduced as the time domain trace data analysis tools in the TDR option. 

To correct the errors of impedance calculation resulting from the complicated distribution of 

mismatches in the DUT, a peeling algorithm is introduced to reveal the actual impedance value 

of every point on the passive DUTs. 

The shortcuts to save/recall the state files, output the trace data to the files, and save the 

screenshot are provided in the File pull-down menu at the top of the TDR toolbar. 

 

10.7.1 Marker Setup 

In addition to the general ways to manage the markers in the VNA, the Marker pull-down menu 

at the top of the TDR toolbar is a way to add or delete markers. 

The order in the first group of the Marker Search pull-down menu is shortcuts to manage the 

common marker tracking marker. The option Off closes the search function of the current 

marker, while the Max or Min starts the tracking search for maximum or minimum. 

 

10.7.2 Rise Time Search 

Rise time search is only available for the trace in the time domain, which searches for the rising 

or falling edge, sets a label to the start and stop, and displays the transition type and time at the 

top left corner of the window if successful. It's a tracking search, the results update if the trace 

data changes. 

To switch on or off the rise time search, click the Rise Time (10-90%) or Rise Time (20-80%) 

option in the Marker Search pull-down menu. Selecting the suitable search type depends on the 

requirements. 
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10.7.3 Delta Time Search 

Delta time search is only available for the trace in the time domain, which searches for the 

difference between the time where two traces rise or fall to a specified relative level in respective 

transition edge. If successful, a label will be set to the relative level on both traces, and the results 

will be displayed at the top left corner of the window that contains the start trace of the search. 

It's a tracking search, the results update if the trace data changes. 

Click the △Time... order in the Marker Search pull-down menu to open the △Time dialog, and 

the settings of delta time search can be changed here. 

Click the Trace (Start) pull-out menu to change the start trace of the search, click the Trace (Stop) 

pull-out menu to change the stop trace. A trace in the time domain can start one search at most 

as a start trace, while it's allowed that more than one searches set the same trace as the stop 

trace. 

The target relative level of the search can be set in the Position (%) textbox in the dialog. 

To switch on or off the search, click the △Time Enable checkbox. 

 

10.7.4 Peeling 

If there are two or more impedance mismatches on the DUT, a part of the incident wave is 

reflected at the first mismatch, the incident energy arriving at the next mismatch reduces, so the 

reflection at the next mismatch might seem weaker than that in reality. Calculating impedance 

using reflection coefficients might lead to obvious errors after the first mismatch. To avoid the 

effect of the masking phenomena explained above, a new approach to calculate impedance, 

called the peeling algorithm, is introduced in the TDR option. The algorithm divides the DUT into 

many sections, calculates the impedance of the next section by the impedance of the last 

section as the reference value, and the incident and reflected energy in reality. 

The algorithm presupposes that the energy sum of input equals that of output at any points on 
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the path the signal transmits through, which means that the signal transmits through the DUT 

without loss. This is an imperfection of the algorithm, and transmission loss always decreases the 

accuracy. Because of the recurrence method in the algorithm, the accuracy also decreases with 

the distance increases. 

If the peeling function is enabled, the TDR option calculates impedance in the way explained 

above, instead of the traditional way. The function is available only if the format of the trace is 

Impedance of the reflection T parameters. To switch on or off the function, click the Peeling 

checkbox in the Parameter bar of the TDR/TDT tab. 

 

10.7.5 File & Data Output 

In the File pull-down menu at the top of the TDR toolbar, there are some shortcuts for file 

operation and data output. 

The order Save State... is used to save the current state and calibration data as a ..CSA file, and 

Recall State... is used to restore them from the files. 

The order Save Trc Data... is used to save the current trace data to .CSV file, and Save SnP... saves 

all available S parameters data as an .SNP file whose format depends on the DUT topology. 

Screenshot... is used to save the screenshot as a .PNG file. 

 

10.8 Eye Diagram Simulation 

10.8.1 Overview 

Eye diagrams are used to analyze the influence of the intersymbol interference and noise on 

transmission performance, which is an important tool for signal integrity analysis. The eye 

diagram simulation function, included with the TDR option, is built on a virtual digital signal 
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generator and the frequency characteristics of the DUT. It simulates that a virtual input digital 

signal transmits through the DUT, and analyzes the output signal to get an eye diagram. This is 

different from the traditional way of using an oscilloscope to draw eye diagrams. There is no 

need to provide an external digital signal to the input port of the DUT. To simulate different input 

signals, change the stimulus settings in the eye diagram module. 

 

 

Figure 10-10-13 Eye/Mask Tab 

 

The data analysis of eye diagrams in the option will try to get the numerical characteristics of the 

diagram and mark them on the diagram if required, which is designed to help the users obtain 

the key information quickly. 

The jitter injection and statistical eye diagram function are provided to analyze the influence of 

the jitter in the input signal on the transmission performance. 

The mask test on the eye diagram and preinstalled mask patterns are a convenient method of 

estimating whether the eye diagram meets the design requirements. 

To start an eye diagram simulation after completing the simulation settings, click the Draw Eye 

button in the Trigger box of the Eye/Mask tab. 

 

10.8.2 Stimulus Bit Pattern 

There are 3 bit pattern types to choose in the option: Pseudo-Random Binary Sequence (PRBS), 

K28.5 comma code, and the user's bit pattern. 
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For more information about PRBS, refer to the section Bit Pattern Length. K28.5 comma code is 

defined in an industry-standard developed by IBM which includes comma (control) characters. 

The user's bit pattern is imported from the user-defined files. The introduces of the bit pattern 

types in the table as follow: 

Type Bit Pattern Length Generator 

PRBS 
Depends on the users,  

limited in 2n-1, n = 3,5,7,9,11,13,15 
Generated by a virtual PRBS generator 

K28.5 20 “00111110101100000101” (20 bits) 

User limited between 2 and 8192 Imported from a user-defined file 

 

10.8.2.1 Bit Pattern Type 

To change the input bit pattern types, click the Type pull-down menu in the Stimulus box of the 

Eye/Mask tab. 

The option Statistical in the menu is used to switch on the statistical eye diagram mode, which 

cannot change the bit pattern types for the normal eye diagram simulation. 

 

10.8.2.2 Bit Pattern Length 

The bit pattern length of K28.5 code is 20 bits, and that of the user pattern depends on the text 

in the file. Only the length of PRBS can be changed in the eye diagram simulation module by 

clicking the Length pull-down menu in the Stimulus box. 

A set of Linear Feedback Shift Register (LFSR) is simulated to generate virtual PRBS, whose 

maximum period is selected to equal the bit pattern length. The maximum of the period of 

PRBS, generated in a set of LFSR of n level, is 2n-1. In the other words, in ideal conditions, the 

sequence will iterate all possible binary numbers of n bits. The initial condition of the LFSR is 
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random, PRBS generated becomes random to find the worst bit pattern of n bits for 

transmission performance. Eye diagram simulation always includes all n-bit input patterns to 

show the worst transmission performance of DUT, if PRBS is set as the input signals. So it's 

recommended to use PRBS as a bit pattern to draw eye diagrams. 

The bit pattern length of PRBS is limited in 2n-1, and n = 3, 5, 7, 9, 11, 13, 15. That means the bit 

pattern will be generated by LFSR of n level, to include the worst condition as far as possible. The 

larger length is selected, the degree of the simulation perfection for intersymbol interference 

becomes better, but running time becomes longer. 

10.8.2.3 User Pattern 

If the eye diagram is required to simulate the specific bit pattern as the input signal, select the 

option USER in the Type pull-down menu, and click the User Pattern button to open the Bit 

pattern Editor dialog to set the user-defined pattern. In the dialog, you can load .txt files to 

import the text as the bit pattern and edit the bit pattern in the textbox. Close the dialog after 

loading or saving the bit pattern file, the pattern will be used for the next eye diagram simulation. 

The text file to load must contain 0 and 1, but any other characters; and the length of text must 

be between 2 and 8192.  

 

10.8.3 Stimulus Signal Setup 

10.8.3.1 Logic Level 

To change the logic level of the input signal, set the value in the One Lv. or Zero Lv. textbox in the 

Stimulus box.  

 

10.8.3.2 Data Rate 

The data rate of the signal is the number of bits transmitted per second, which reflects the base 
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frequency of the signal. Considering the lowpass characteristics of transmission systems in 

reality, the transmission becomes bad with a large data rate, and the signal integrity analysis 

becomes important. 

To change the data rate of the input signal, set the value in the Data Rate textbox in the Stimulus 

box. 

 

10.8.3.3 Rise Time 

The rise time of the signal reflects the steepness of the transition edge. The smaller rise time 

means the higher degree of steepness, the larger proportion of high-frequency parts, and the 

more serious high-frequency losses can be during transmission. It's effective to widen the eye by 

reducing the rise time properly. But too small a rise time leads to ringing phenomena at the logic 

level of the output signal, resulting in the decrease of the eye height. 

To change the rise time type or value of the input signal, operate the Rise Time pull-down menu 

or textbox in the Stimulus box. 

10.8.4 Eye Diagram Analysis 

During the eye diagram simulation, the option analyzes the eye diagram automatically and try to 

get the numerical characteristics as follow: Rise Time, Fall Time, Jitter, Crossing Percent, 

Opening Factor, The Ratio of Signal to Noise, Duty Cycle Distortion, Level One, Level Zero, Level 

Mean, Amplitude, Height, Width. And Rise Time, Fall Time, Jitter (peak-peak value), Amplitude, 

Height, Width are allowed to be marked on the eye diagram to conveniently obtain the 

characteristics of the eye diagram. 

 

10.8.4.1 Analysis Result Overlay 

To switch on or off the data analysis markers on the diagram, click the Overlay checkbox in the 

Result bar. 
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10.8.4.2 Rise Time in Data Analysis 

To change the rise time type for data analysis of eye diagrams, click the Rise Time Def. pull-

down menu in the Result bar. 

 

10.8.5 Eye Diagram Scale Management 

By default, the eye diagram is displayed in the automatic scale settings, which show the details 

as clearly as possible. They can also be manually changed.   

The scale settings in the vertical axis can be changed manually. But those in the horizontal axis 

depend on the data rate of the input signal, which can't be changed after the simulation starts. 

To switch to a scale setting mode, click the Auto Scale or Manual radio button in the Scale/Mask 

bar. 

To change the scale or offset values in Manual scale mode, set the value in the Scale/Div or 

Offset textbox. The Offset value here is the value that the center vertical scale line refers to. 

 

Figure 10-10-14 Eye/Mask setting 

 

10.8.6 Mask Test for Eye Diagram 

Mask patterns are some areas where the eye diagram is forbidden to pass, which transfer the 

design requirements of the transmission systems into the numerical characteristics of eye 

diagrams. They usually rule the tolerance of logic 0, 1 level and rise or fall time. If the eye diagram 

passes through the areas, the TDR option judges that the eye diagram can't meet the 
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requirement, leading to the failure of the mask test. According to different communication 

standards, or at the different nodes in a communication system, different mask patterns should 

be applied. The first step to mask test is to select or design a suitable mask pattern based on the 

requirements. 

To select or change the mask pattern applied, click the Mask Pattern button in the Scale/Mask 

bar to open the Mask Pattern dialog. 

In the File tab of the dialog, preinstalled standard patterns or user-defined mask files (.MSK 

format) can be loaded. In the Scale tab, the Margin of the mask, start Position of a bit, Delta time 

of a bit, and Logic Level can be set in textboxes. In the Edit tab, the positions of vertices in the 

mask pattern can be changed by set values in the textboxes. Dragging the vertices in the left 

window also makes sense, but it's recommended to drag with a mouse connected to the VNA, 

because the points may be too close together for easy entry using touch operation. 

Close the dialog after saving the modifications to a mask file, the new pattern will be applied to 

the next mask test. 

To switch on or off the mask test, click the Mask Test checkbox in the Scale/Mask bar. 

 

10.8.7 Jitter & Statistical Eye Diagram 

Jitter is the transient deviation from the corresponding ideal position of a signal over successive 

trigger events. High jitter worsens the transmission performance. It's divided into the 

Deterministic Jitter (DJ) and the Random Jitter (RJ). RJ is generated by some unpredictable 

factors and is independent of the input bit patterns. The models for RJ usually have a Gaussian 

distribution, and the magnitudes are represented in root mean square (RMS) values. DJ is 

generated by some repeatable and predictable factors and usually has a finite magnitude value. 

The jitter related to the input bit patterns in DJ is called the Data Dependent Jitter (DDJ), while 

the other jitter in DJ is called the Periodic Jitter (PJ). 

To change the settings of the jitter injection, click the Advanced Waveform button in the 
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Stimulus box of the Eye/Mask tab, or click the buttons in the Adv Waveform bar of the Setup tab, 

to open the Advanced Waveform dialog. Click the Jitter button at the top of the dialog to switch 

to enter the jitter setting interface. 

 

 

Figure 10-10-15 Eye jitter setting 

 

To change the jitter type injected into the input signal, click the Random or Periodic ratio button 

in the Type box. To set the jitter parameters, set the values in the corresponding textboxes. 

To select the jitter magnitude units, click the Jitter Unit pull-down menu. The unit UI means that 

the time difference value between the zero time of two adjacent transition edges in the signal, 

which is the default jitter magnitude unit. 

To set the probability limit to display in the statistical eye diagram, click the Display Limit pull-

down menu. If the probability of the signal appearing is lower than the display limit, it will be 

ignored and set to zero in the statistical eye diagrams. 

To switch on the jitter injection for the next simulation after completing the jitter settings, click 
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the Enable checkbox in the jitter setting interface. When the jitter injection function is switched 

on, the statistical eye diagram mode is enabled at the same time, the input bit pattern type is 

switched to Statistical. 

To switch to the statistical eye diagram mode in manual, select the option Statistical in the Type 

pull-down menu in the Stimulus box. In the statistical mode, the input bit pattern is set to PRBS 

with a fixed length, so the statistical eye diagrams might be slightly different in several 

simulations of the same settings. The probabilities are represented by colors in the statistical eye 

diagrams: Warm colors indicate a large probability, red represents the largest ones; cold colors 

indicate a small probability, with deep blue representing the smallest values. 

10.9 TDR Advanced Waveform Function 

The Advanced waveform function is applied in both modules of the TDR option, TDR/ TDT 

analysis, and eye diagram simulation, which includes viewpoint setting, emphasis/ de-emphasis, 

de-embedding, and Continuous Time Linear Equalization (CTLE). 

The corresponding settings in the Advanced Waveform dialog, which can be opened by clicking 

the buttons in the Adv Waveform bar of the Setup tab or the Advanced Waveform button in the 

Stimulus box of the Eye/Mask tab. 

To switch the dialog to the interface for setting the specified function, click the corresponding 

button at the top of the dialog. 

 

10.9.1 View point 

To switch the viewpoint of the waveform to stimulus or responses, click the corresponding View 

ratio button at the top of the dialog. 

Click the ratio button before the DUT icon, switch the viewpoint to stimulus, and the trigger 

mode is set to Hold /Stop, the transmission parameters show the stimulus signal only processed 
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by emphasis /de-emphasis, which is the signal transmitted to the DUT. Setting the trigger mode 

to Continuous /Run, the viewpoint will be set to responses automatically. 

Click the ratio button after the DUT icon, switch the viewpoint to responses, and set the trigger 

mode to Continuous /Run. The transmission parameters show the responses processed by 

emphasis /de-emphasis, DUT, and equalization. 

 

10.9.2 Emphasis/De-emphasis 

Because of the lowpass characteristics of transmission systems, the high-frequency components 

in the signal have higher losses than those at lower frequencies and the phenomenon becomes 

more serious as the transmission distance increases. The phenomenon is the main contributor 

to signal distortion during transmission. To control this distortion, the emphasis /de-emphasis 

technology is introduced to compensate for these additional losses by increasing the relative 

levels before the transmission. Transition edges in the time domain represent high-frequency 

components in the frequency domain. Emphasis /De-emphasis technology is designed to 

increase the level variation of the edges by adjusting the levels of the bits close to the edges. The 

parameters to adjust the levels of the first bit before or after the edges, and those for the two bits 

after the edges, are provided in the TDR option and are defined as Pre Cursor, Post 1 Cursor, 

Post 2 Cursor. By changing these parameters, it's easy to simulate the influence of the different 

emphasis/de-emphasis strategies on the transmission performance in eye diagram simulations. 
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Figure 10-10-16 Emphasis setting 

 

To change the parameters, set the value in the textbox in the Emphasis interface, and click the 

Enable checkbox to enable the function. The function is available in transmission parameters 

measurement and eye diagram simulations. 

 

10.9.3 De-embedding 

The TDR option provides a port de embedding function, which is the same as the port de 

embedding function in the fixture measurement function. 

By clicking the Enable button on the left side of the De embedding tab, the TDR option port de 

embedding function main switch can be turned on/off. 

 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  271 

 

Figure 10-10-17  

Then, select the port to be de embedded through the port in the image or the radio box on the 

right, click the Load button to load the SNP file that records the embedded network 

characteristics, and click the Enable checkbox on the right to enable the de embedding function 

on the selected port. 

 

10.9.4 Equalization 

To control the signal distortion resulting from the additional loss of high-frequency signal 

components, equalization technology is introduced to amplify the high-frequency parts properly 

after receiving the signal to balance the loss over various frequency spans. A high-pass filter and 

a continuous-time linear equalizer (CTLE) can be implemented. The CTLE simulation function in 

the TDR option allows the user to adjust the system function of the equalizer, to simulate the 

effect of the equalization on the transmission performance in eye diagram simulations. 
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Figure 10-10-18 Equalization setting 

 

The equalizer system function provided by the TDR option is as follows:; By adjusting the DC gain 

and zero pole position, the system function of the equalizer can be modified to simulate and 

evaluate different linear equalization strategies. 

H(s) =
K(s + ωz)

(s + ωp1)(s + ωp2)
 

 

The TDR option also provides a solution to describe the characteristics of the equalizer using the 

frequency response recorded in the CSV file: The TDR option simulates the equalizer using the 

frequency response recorded in the CSV file, The response value of the equalizer at the scanning 

frequency is obtained using amplitude phase linear interpolation method (when it exceeds the 

frequency range recorded in the file, the response value at the minimum frequency is taken when 

it is less than the minimum frequency, and the response value at two frequencies from low to 

high is taken when it is greater than the maximum frequency). The file format can refer to the 

following examples: 

!SIGLENT Technologies 

!VNA TDR-option Equalization File 

# Hz dB 
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1000000000,-1.53E+01,-3.27E-01 

2000000000,-1.52E+01,-7.34E+01 

3000000000,-1.03E+01,-8.63E+01 

4000000000,-9.88E+00,-1.00E+02 

 

Notes: 

1.  The data format is indicated by the line starting with "#" (the data format is not case 

sensitive), with the first data in each line being the frequency, and the last two data representing 

the response value (complex) of the equalizer at that frequency. If the second data of the 

response value is omitted, the default value is zero. Support the following data formats to 

express frequency response. If the format description is omitted, the default is MA: 

DB: The previous data represents the frequency response amplitude in logarithmic form, 

while the latter data represents the phase of the response in angular format. 

MA: The previous data represents the amplitude of the frequency response, while the latter 

data represents the phase of the response (angle based). 

RI: The previous data represents the real part of the response value, while the latter data 

represents the imaginary part of the response value. 

2.  The comment should start with '!' and ignore the comment content when reading. 

3.  The frequency is required to be arranged in ascending order. If the frequency of a row is 

lower than the previous row, the data in that row will be ignored. 

4.  The frequency response recorded in the file should include at least 2 frequency points, but 

not more than 10000 frequency points. 

 

Set the relevant parameters through the fine-tuning box in the Equalization tab, or load a CSV 

file, select the radio box in the Type box on the left to describe the characteristics of the 
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simulation equalizer, and select whether to enable the equalization function through the Enable 

check box on the left. This function is only effective for transmission parameter measurement 

and eye graph simulation. 

 

10.10 Hot TDR 

10.10.1 Overview 

When conducting measurements, VNA usually assumes that the zero input response of the DUT 

is zero. That is to say, assuming that all signals received by the port receiver are triggered by test 

signals sent by the port transmitter to the DUT; The signal received by a receiver at a certain port 

should be equal to the sum of the signal vectors transmitted and reflected by the test signals 

sent by the transmitters at each port on the DUT to reach that port. According to the above 

assumption, VNA obtains the response generated by the test signal excitation at each port 

through measurement, and calculates the S parameter matrix of the DUT based on this. 

 

If the zero input response of the DUT is not zero, when using VNA measurement, the signal 

received by the port receiver is equal to the vector sum of the response caused by the test signal 

sent by VNA and the zero input response of the device. Based on this, calculating the S 

parameter may result in significant errors. Therefore, such interference may reduce the accuracy 

of VNA measurement and can be suppressed in some cases. 

 

If the zero input response amplitude of the DUT is small, the VNA power level can be 

appropriately increased without damaging the equipment and DUT, and the response amplitude 

caused by the VNA test signal can be increased, which can have a certain inhibitory effect on 

such interference. 
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If the zero input response of DUT obeys some statistical law, and the mean value in the time 

domain is zero (such as obeying Normal distribution); The average function can be enabled and 

the average frequency can be appropriately increased to suppress the impact of such 

interference on the measurement by averaging the responses measured multiple times. 

 

If it is necessary to use VNA to measure the device in operation, and the tested device sends a 

digital signal with a known data rate to the test port during operation; In this case, the zero input 

signal of the DUT is not zero, and using the above method may not achieve good interference 

suppression effect. In frequency domain measurement, as interference signals are generally 

concentrated on a few frequencies, the impact on the entire frequency domain measurement 

may not be severe; In the TDR option, due to the superposition of interference signals in the time 

domain and actual input responses, the time-domain measurement results will be severely 

distorted. 

 

Using the Hot TDR mode in the TDR option to measure such devices can suppress the impact of 

such interference on time-domain measurements. Due to the fact that VNA always scans several 

frequency points during frequency domain measurements to estimate the frequency 

characteristics of DUT within the testing frequency range; When the scanning frequency point 

coincides with the frequency of the interference signal, the test results at that frequency point 

will be affected by interference. In Hot TDR mode, VNA will search for scanning frequency 

settings to avoid interference signals based on their data rate, thereby eliminating the impact of 

interference signals on frequency domain measurement results. 
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10.10.2 Usage Guidelines 

Before using the Hot TDR mode to measure equipment in operation, it is necessary to ensure 

that the test signal sent by VNA to the equipment does not cause equipment malfunction. 

Properly select the VNA power level to prevent excessive testing signal amplitude from 

damaging the tested equipment; Observe the changes in the reflected signal received by VNA 

during the process of reducing the power level. If there is a significant change in the reflected 

signal, the power level should be significantly lowered to prevent equipment failure. 

 

When conducting measurements, if it is found that there are peaks in the frequency domain 

measurement results with constantly changing amplitudes at some frequencies, the time 

domain measurement results will fluctuate severely; It can be determined that the device's own 

signal output causes serious interference to time-domain measurement, and Hot TDR can be 

used to eliminate it. 

 

On the right side of the Setup tab on the bottom toolbar of TDR, you can set the Hot TDR mode. 

Enter the data rate of the signal emitted by the device in the Data Rate fine-tuning box; If the 

data rate of the signal emitted by the device is unknown, an approximate value can be obtained 

using the cursor on the frequency measurement results. The data rate error should be less than ± 

0.5% to prevent failure in searching for scan frequencies that avoid interference. 

 

Then, click on the "Avoidance Spurious" button and click "Yes" in the pop-up dialog box; VNA will 

check whether the current scan is affected by interference and search for scan frequency 

settings to avoid interference signals after confirming interference. If no interference is detected 

with the current scanning frequency, it will prompt that the interference signal has not been 

detected and continue to use the current scanning frequency setting for measurement. If a 

suitable scanning frequency is not found, it will prompt that a suitable scanning setting has not 
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been found; This may be due to incorrect input data rates or excessive frequency components of 

interference signals, making it difficult to completely eliminate them. If the search is successful, 

the TDR option will enable the Hot TDR mode and use the scan frequency found for 

measurement. When the Hot TDR mode is enabled, the Avoid Spurious button will change to the 

Close Hot TDR button, which is used to turn off the Hot TDR mode; A mark  will appear on 

the right side of the button indicating that the Hot TDR mode is enabled. 

 

After enabling the Hot TDR mode, due to changes in the original scanning frequency setting, 

recalibration may be necessary to obtain more accurate measurement results. In addition, after 

changing the DUT length or scanning frequency setting in Hot TDR mode, the original Hot TDR 

setting becomes invalid and may need to be reconfigured to eliminate the influence of 

interference signals. 

 

Figure 10-19 Hot TDR setting 
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10.11 TDR Switch Matrix 

TDR supports the expansion of measurement ports via the switch matrix. After connecting the 

VNA to the switch matrix, enable the TDR extended port feature by navigating to Setup > Switch 

Matrix > Ext Port Enabled. Even without connecting the switch matrix, it enables the extended 

port, allowing users to flexibly designate VNA ports for measurement. 

 

Figure 10-20 TDR Switch Matrix Setup 

 

10.11.1 Port Connection 

For determining the port connections between the switch matrix and the VNA, as well as for test 

port numbers. 

 

10.11.2 Port Selection 

Select the measurement ports based on the current DUT topology. When the DUT topology is 

Single-Ended 1-Port, one port is available; when the DUT topology is Single-Ended 2-Port / 

Differential-1-Port, two ports are available; when the DUT topology is Single-Ended 4-Port / 

Differential 2-Port, four ports are available. 

When ports are improperly selected, the following message appears: 

⚫ The number of TDR ext ports does not correspond to the topology: The number of selected 

ports does not match the port count defined by the DUT topology. 

⚫ There are measurement types that cannot be constructed: The selected ports cannot form 
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valid measurements. For example, if extension port 1 and port 2 are both connected only to 

VNA port 1, measurements such as S12 and S21 cannot be performed. 

After selecting the ports, the trace measurement types are reorganized according to the new 

port numbering sequence. For example, if the original ports are Port1/Port2/Port3/Port4 and the 

new ports are Port5/Port6/Port7/Port8, then S11 becomes S55, S23 becomes S67, and so on. 

The de-embedding function will also be updated accordingly. 

 

Figure 10-21 TDR Switch Matrix Ports Selection Interface 

 

10.11.3 Characterize 

Allows the user to characterize the switch matrix to obtain de-embedding data. 

This function is unavailable when no switch matrix is detected. 

 

10.11.4 De-embed 

Allows the user to perform de-embedding on the switch matrix. This function is unavailable 

when no switch matrix is detected. 

In TDR mode, when the DUT topology is Single-Ended 1-Port, the calibration type is forced to be 

OSL. When the DUT topology is Single-Ended 2-Port, Differential 1-Port, Single-Ended 4-Port, 

or Differential 2-Port, the calibration type is forced to be SOLT. The de-embedding port is forced 
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to be the extended port in use. 

After specifying the characterization switch matrix data once, subsequent port switching will use 

this data to de-embed the switch matrix, allowing users to quickly perform accurate 

measurements on multiple ports. 
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11 Spectrum Analyzer 

11.1 Overview 

Spectrum Analysis function is based on the VNA hardware, by adjusting the local oscillator signal 

and mirror suppression algorithm processing to obtain the signal spectrum, so as to achieve 

spectrum analysis function. 

11.2 User Interface 

 

 

A. Active Entry 

B. Indicate the main working state of state, the port of RF input, Attenuation mode, Average 

Type, Current Marker operation. 

C. Display the SA setting dialog box, SA parameter reset, SA processing flow chart 

D. SA Measurement items. 
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E. Indicate and control the main sweep parameters, such as frequency, resolution. 

F. Status bar. 

 

11.3 Create a Spectrum Analysis Channel 

Option SA must be enabled. 

Press [Meas] > S-Params > Mode > SA, The SA channel selection dialog box will display after the 

SA measurement mode was selected. Select “Active Channel” (delete the existing measurement) 

or “New Channel” then click OK. A Spectrum Analysis measurement is displayed on the current 

channel or on a new channel and New Window. 

 

Figure 11-11-1 SA mode channel selection dialog box 

In the interface of the SA channel selection dialog box, the “show setup dialog” check box is 

selected by default. when user clicks “OK”, a SA Setup dialog box will be displayed that can set 

related parameters. As figure shown below: 
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Figure 11-2 SA Setup dialog box 

If the show Setup Dialog check box is deselected, the SA Setup dialog box will not be displayed 

when the SA function is enabled. If the user wants to modify the SA parameters, there are two 

ways to enter the SA Setup dialog box. 

⚫ Press [Sweep] > Sweep > SA Setup… to recall the SA Setup dialog box. 

⚫ Press [Power] > Power > SA Setup… to recall the SA Setup dialog box. 

11.4 Spectrum Analyzer Settings 

The SA Setup dialog box has three tabs: SA Tab, Source Tab and Advanced Tab. 

The SA Tab configures the SA frequency range, CF step, sweep points, RBW, VBW, Average type 

and RF Input Receiver. 

The Source Tab is the configuration of signal parameters when uses the internal source for 

spectrum analysis. 

The Advanced Tab the configuration of relevant parameters related to signal processing. 
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Figure 11-3 The SA Tab setting interface 

11.4.1 SA Setting Tab 

SA Tab Setting is mainly related to Spectrum analysis frequency setting. which can be set through 

the SA Setup dialog box or by pressing the [Freq] key on the front panel to enter the frequency 

setting menu, as the figure shown below. If the frequency is changed, the frequency sweep will 

restart. 
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Figure 11-4 [Freq] key to set SA frequency parameters 

The frequency range of a channel can be expressed by three parameters: Start Frequency, 

Center Frequency and Stop Frequency. If any of the parameters change, the others will be 

adjusted automatically in order to ensure the coupling relationship among them: 

𝑓𝑐𝑒𝑛𝑡𝑒𝑟 = (𝑓𝑠𝑡𝑎𝑟𝑡 + 𝑓𝑠𝑡𝑜𝑝)/2, 𝑓𝑠𝑝𝑎𝑛 =  𝑓𝑠𝑡𝑜𝑝 −  𝑓𝑠𝑡𝑎𝑟𝑡 

11.4.1.1  Start Frequency 

Set the start frequency of the Spectrum Analyzer. The start frequency and the stop frequency will 

display at the bottom of the grid respectively. 

⚫ The span and center frequency vary with the start frequency when the Span does not 

reach the minimum.  

11.4.1.2 Stop Frequency 

Set the stop frequency of the Spectrum Analyzer, the start frequency and the stop frequency will 

display at the bottom of the grid respectively. 

⚫ The span and center frequency vary with the stop frequency.  
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11.4.1.3 Center Frequency 

Set the center frequency of the Spectrum Analyzer.  

⚫ Modifying the center frequency will modify both the start frequency and stop frequency 

when the span is constant (except when the start frequency or stop frequency reaches 

the boundary). 

11.4.1.4 Span 

Set the span of the Spectrum Analyzer. Any changes of the span will restart the sweep. 

Pay attention to the following points when set the span: 

⚫ The start and stop frequency vary with the span when the center frequency is constant. 

⚫ The span can be set down to 100 Hz and up to the maximum bandwidth. 

⚫ Modifying the span may cause an automatic change in both CF Step Size and RBW if 

they are in Auto mode. Besides, the change of RBW may influence VBW (in Auto VBW 

mode). 

⚫ Variation in the Span, RBW or VBW would cause a change in the sweep time. 

11.4.1.5 CF Step Size 

Setting the value of CF step will change the direction key step of center frequency, start 

frequency, stop frequency and frequency offset. 

When Auto mode is selected, the Center frequency step Size is 5% of the current span. That is, 

𝑓𝐶𝐹 𝑆𝑡𝑒𝑝 =   𝑓𝑆𝑝𝑎𝑛 ∗ 5%. Each press of the ▲|▼ arrows on the front panel or click the up and down 

sign of the SA Setup’s center box. The center frequency 𝑓𝐶𝐹 𝑆𝑡𝑒𝑝 increases or decreases by the CF 

step size. 

When Manual mode is selected, Users can customize the size of CF Step. Each press of the ▲|▼ 

arrows on the front panel or click the up and down sign of the SA Setup’s center box. The center 

frequency 𝑓𝐶𝐹 𝑆𝑡𝑒𝑝 increases or decreases by the CF step size. 
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11.4.1.6 Num of Points 

The number of sweep points represents the number of sweep and trace displayed points (1~20001) 

More sweep points will improve the resolution of waveform, but also affect the minimum sweep 

time, and increase the time of data processing and remote access to data, and reduce the 

response rate. 

11.4.2 SA Tab Processing setup 

The SA processing setup is to config the signal’s parameters. User can set the parameters via the 

SA Setup dialog, or by pressing [AvgBW] > BW to enter the spectrum analysis signal processing 

parameters setting menu, as the shown figure below. 

 

Figure 11-5 Spectrum analysis signal processing setup menu 

11.4.2.1 RBW 

Set the RBW (resolution bandwidth) in order to distinguish between signals which has frequency 
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components that are near one another. 

⚫ Reducing the RBW will increase the frequency resolution. but lead to a longer sweep 

time (influenced by both RBW and VBW when the sweep time is in automatic mode). 

⚫ RBW varies with the Span/RBW setting in Auto RBW mode. 

11.4.2.2 VBW 

Set the video bandwidth in order to filter out the noise outside the video band.  

⚫ Reducing the VBW will smooth the trace and helps to highlight small signals from noise, 

but it will also increase the sweep time (Sweep Time is affected by a combination of 

RBW and VBW when it is in Auto mode). 

⚫ VBW varies with RBW when it is in Auto mode. While in Manual mode, VBW is not 

affected by RBW. 

11.4.2.3 Averaging Type 

Average type refers to the processing mode of intermediate frequency data in data detection 

and display detection, which affects the effect of trace average and detection average. 

Power

（V^2）

RBW Voltage

LogPower

Detect

Avg Type

VBW Trace
 

Figure 11-6 Flow chart of Average type 

 

1. Log Power 

Select the logarithmic (decibel) scale for all filtering and averaging processes. This scale is 

“Video” because it is the most common display and analysis scale for the video signal within 
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analyzer. This scale is excellent for finding Sine/CW signals near noise. 

2. Power Average 

In this average type, all filtering and averaging processes work on the power (the square of 

the magnitude) of the signal, instead of its log or envelope voltage. This scale is best for real-

time power measurement of complex signals. 

3. Voltage Average 

In this Average type, all filtering and averaging processes work on the voltage of the 

envelope of the signal. This scale is suitable for observing rise and fall behavior of AM or 

pulse-modulated signals such as radar and TDMA transmitters. 

11.4.2.4 RF Input Receiver 

Select the receiver port for RF signal input. 

11.4.3 Source Tab 

The Source Tab of SA Setup is the configuration for internal sources as signal sources. 
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Figure 11-7 Source Tab 

Port Powers Coupled (checked) the power levels are the same at each test port. Set power at any 

test port and all test ports change to the same power level. 

By default, only one of the multiple ports in VNA can be set as the source port for outputting 

excitation signals. For the LO Board>=A9 version of the four port vector network analyzer, two 

signal sources are set internally, with port 1 and port 2 sharing the same signal source, and port 3 

and port 4 sharing the same signal source. It is possible to output two signals simultaneously, but 

only one port corresponding to each signal source can be set as the excitation port. Setting one 

port as the output will turn off the output of the other port of the same source. 

 

SA Source Setup 

 

 

Figure 11-8 SA Source Setup 

⚫ State: If the “On” parameter is selected, the port source power is enabled 

⚫ Type (Sweep): 

1. CW: The source is set to a CW frequency. 

2. Linear Freq: The source is set to a power sweep. 
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3. Power: The source is set to a power sweep. 

4. LinFreq + Power: The source is set to sweep from the Start to Stop frequency and power 

sweep. 

⚫ Frequency: Set the sweep Frequency of the source. 

⚫ Power: Set the power level of the source. 

When the internal source is used for the Spectrum analysis signal sources, the sweep type, 

source frequency and the port power level of the source can also be set by pressing the [Power] 

key on the front panel to enter the port power setting menu. As the figure shown below: 

 

 

Figure 11-9 Press the [Power] key to enter the source’s setting menu 

11.4.4 Advanced Tab 

The Advanced Tab is the configuration of parameters related to signal processing for Spectrum 

analysis. Which can be set through the SA Setup dialog box or by pressing the [AvgBW] > BW on 

the front panel to enter the setting menu, as the figure shown below. 
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Figure 11-10 Advanced Tab setting menu 

11.4.4.1 RBW/VBW 

Sets the ratio of Resolution Bandwidth to Video Bandwidth when the Video Bandwidth is in Auto 

mode. 

11.4.4.2 Span/RBW 

Sets the ratio of Span to Resolution Bandwidth when the Resolution Bandwidth is in Auto mode. 

11.4.4.3 Image Reject Type 

The signal is mixed with the local oscillator to get an intermediate frequency signal, and the 

mixer may produce a mirrored frequency signal. Therefore, it is necessary to change the local 

oscillator or intermediate frequency to collect multiple groups of spectral data, and filter out the 

image through the image suppression algorithm. 

None: Selects 1 acquisitions, and mirror suppression is not performed. 

Min: Selects 3 acquisitions. 

Normal: Selects 4 acquisitions. 

Better: Selects 5 acquisitions. 

Max: Selects 6 acquisitions. 
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Note: Only 3 sets of data can be acquisitions at most when the frequency point is below 40MHz. 

11.4.4.4 Attenuation mode  

Set the maximum power or voltage that can be currently displayed in the trace window. The 

value is displayed at the upper left corner of the screen grid. 

The reference level is an important parameter of the spectrum analyzer, which indicates the upper 

limit of the current dynamic range of the spectrum analyzer. When the energy of the signal to be 

measured exceeds the reference level, nonlinear distortion or even overload alarm may be 

generated. The user should understand the nature of the signal to be measured and choose the 

reference level carefully. The reference level is too large to ensure full utilization of the linear range 

of the ADC, nor too small to be higher than the noise of the ADC. By setting a suitable reference 

level, the best measurement results can be obtained while protecting the spectrum analyzer. 

According to the amplitude of the input signal, the user can set the RF front-end attenuation 

mode of the response, which is to avoid the display distortion when the input signal is large and 

reduce the noise when the input signal is small. 

Input attenuation can be set up to Auto, Low Noise and Standard mode. 

⚫ Auto: The attenuation value is automatically adjusted according to the state of 

preamplifier and the current reference level. 

⚫ Low noise: The minimum attenuation mode, the average noise level is lower. 

⚫ Standard: The maximum attenuation mode, the average noise level is higher. 

11.4.5 Trace setup  

Click the trace status area on the upper left corner of the interface, and the trace setting drop-

down menu will pop up for trace setting operations. 
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Figure 11-11 The trace Settings drop-down menu 

11.4.5.1 Select Trace 

Before operating on the Trace, the user needs to specify and only specify one trace at a time. 

The number of the selected trace will appear as selected in the status bar (with a yellow 

highlighted border). 

11.4.5.2 Trace Type 

There are four trace types: Clear/write, Max Hold, Min Hold, Average. Different trace types 

represent different processing methods of the trace data of a new frame on the historical frame 

data: 

⚫ Clear/write Erases any data previously stored in the selected trace, and display the data 

sampled in real-time of each point on the trace. The type identifier is “W”. 

⚫ Max Hold Retain the maximum level for each point of the selected trace. Update the 

data if a new maximum level is detected in successive sweeps. Max Hold is very 

effective when measuring events that may take successive scans to measure accurately. 

Some common applications include FM Deviation, AM NRSC, and frequency hopping or 
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drift. The type identifier is “M”. 

⚫ Min Hold Display the minimum value from multiple sweeps for each point of the trace 

and update the data if a new minimum is generated in successive sweeps. The type 

identifier is “m”. 

⚫ Average Set the averages times of the selected trace. The type identifier is “A”. 

More averages can reduce the noise and the influence of other random signals, thus highlighting 

the stable signal characteristics. The larger the averages times is, the smoother the trace will be 

enabling averaging will take more time to collect the full spectral information because the 

analyzer needs to sweep the set average count. The displayed data is averaged in a first-in-first-

out fashion. 

11.4.5.3 Trace State 

There are four trace states: active, view, blank, and background. Different trace states indicate 

the refresh and display states of traces: 

⚫ Active: Refreshed and displayed trace data. 

⚫ View: The trace data will not be refreshed, and the current latest trace will be displayed 

in a fixed frame. 

⚫ Background: Refreshed trace data but no display. 

⚫ Blank: Trace data is no longer refreshed or displayed 

11.4.5.4 Detector 

The analyzer displays the sweep signal on the screen in the form of a trace. For each trace point, 

the analyzer always captures all the data within a specific time interval and processes (Peak, 

Average, etc.) the data using the detector currently selected, then it displays the processed data 

(a single data point) on the screen. 

Select an appropriate detector type according to the actual application in order to ensure the 
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accuracy of the measurement 

The available types are Positive Peak, Negative Peak, Sample, Normal and Average. The default is 

Normal. 

⚫ Positive Peak: For each trace point, Positive Peak detector displays the maximum value 

of data sampled within the corresponding time interval 

⚫ Negative Peak: For each trace point, Negative Peak detector displays the minimum 

value of data sampled within the corresponding time interval. 

⚫ Sample: For each trace point, Sample detector displays the transient level 

corresponding to the central time point of the corresponding time interval. This 

detector type is applicable to noise or noise-like signal. 

⚫ Average: For each trace point, Average detector displays the average value of data 

sampled within the corresponding time interval. 

⚫ Normal: Also known as normal detection or “rosenfell” detection. Using conventional 

detection traces, the trace data is paired in pairs, with odd points displaying the 

maximum value at the sampling points and even points displaying the minimum value 

at the sampling points. This can intuitively reflect the amplitude range of the signal 

(background noise), but due to implementation reasons, there may also be a certain 

signal frequency deviation 

 

In practical implementation, conventional detection belongs to secondary detection, which uses 

two adjacent pairs (a group) of positive and negative peaks for comparison. If the actual signal 

appears at an even point position, in order to achieve the display effect of "odd point displays the 

maximum value in the sampling point, and even point displays the minimum value in the 

sampling point", the order of the data in that group will be reversed, resulting in frequency 

deviation. 

User can manually select an appropriate detection type based on actual requirements and 
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application scenarios to ensure measurement accuracy, or set the detection type to automatic. 

11.5 Spectrum Analysis measurement 

11.5.1 Marker → SA 

During S parameter measurement, if the user wants to have a quick view of the specific frequency 

point’s spectrum, spectrum analysis can be opened by means of Marker → SA. That is to create a 

new SA channel in full frequency span based on the S parameters, and a marker is created on the 

trace at the same frequency as the S parameter channel marker. 

The same receiver that is used for the S parameter channel is used for the SA channel. For 

example, if a marker is opened in the S11 channel, a SA measurement is created using the 

receiver “A” of port1 after “Marker → SA”. 

How to open Marker → SA: 

1. Make an S parameter measurement, such as S44, set the center frequency as 1GHz and 

Span as 50MHz. and mark the S44 trace by pressing the [Marker] key on the front panel; 

2. Press [Marker] > Marker Function > Marker → SA to enable the SA function. You can view 

the frequency spectrum of 1GHz point of the S44, as figure shown below: 
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Figure 11-12 Marker → SA 

Press [Sweep] > Sweep > SA Setup… can recall the SA Setup dialog box If the user needs to 

modify the SA parameter settings. 

11.5.2 Channel Power 

Measure the power and power density within the specified channel bandwidth. When this 

function is enable, the span and resolution bandwidth are automatically adjusted to smaller 

values. Select “Channel Power” and click “Meas Setup” to set the corresponding parameters. The 

two vertical lines on the trace perpendicular to the X-axis represent the integration bandwidth. 

The Y-axis value is set to the measured power value, and displays on the upper right corner. 
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Figure 11-13 Channel Power measure 

11.5.2.1 Integration BW 

Set the frequency width of the channel to be tested and the power of the channel is the power 

integral within this bandwidth. You can use the numeric keys, knob or direction keys to modify 

this parameter. 

11.5.2.2 Info Table 

When the information table is “On”, click other menu options and the measurement result table 

will not be closed. When the status of the information table is “Off”, the measurement result 

information table will be closed 

Channel power measurement results include: Channel power and power spectral density. 

The measurement of the specified channel power is centered on the central frequency point of 

the channel, and the frequency Span of the test channel is adjusted. The channel power is the 

integral of this frequency span, and the bandwidth of the specified channel is called the integral 

bandwidth. The value of the integral bandwidth is related to Span but ≤ Span. 
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⚫ Channel Power: Power within the integration bandwidth. 

chPow =  ∑ (
watt

rbw
) ∗ (itgBW/(stop − start))

stop

start

 

 

chPow : Channel power, in watts 

start, stop : The start and stop frequency of channel. 

watt : Absolute power converted from sweep point data, in watts 

rbw : resolution bandwidth 

itgBW : integration bandwidth. 

 

⚫ Power Spectral Density: Power (in dBm/Hz) normalized to 1Hz within the integration 

bandwidth 

nspd = chPow/itgBW 

nspd : Power Spectral Density 

itgBW : Integration bandwidth. 

11.5.3 ACPR 

Measure the power of the main channel and adjacent channels as well as the power difference 

between the main channel and each of the adjacent channels. When this function is enabled, the 

span and resolution bandwidth of the analyzer are adjusted to smaller values automatically. 

Select ACPR and click “Meas Setup” to set the corresponding parameters. 

The main channel and the left and right adjacent channels are specified, the main channel is 

centered on the central frequency point, and the left and right adjacent channels are symmetric 

with respect to the main channel. Channel parameters can be changed by setting the bandwidth 

of the primary channel, the bandwidth of the neighboring channel, and the interval between the 
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neighboring channel and the center point of the primary channel. The power of each channel is 

calculated by the same method as the channel power algorithm. The ratio of the power of the 

adjacent channel to the power of the main channel is the ratio of the power of the adjacent 

channel. 

 

 

Figure 11-14 ACPR measurement 

11.5.3.1 Main Channel 

Set the bandwidth of the main channel, and its power is integrated within this bandwidth. 

11.5.3.2 Adj Chn  

Set the bandwidth of adjacent channels. 

11.5.3.3 Adj Chn Space 

Center frequency spacing between the main channel and neighboring channels. Adjusting the 

adjacent channel spacing will adjust the distance between the previous channel and the back 

channel and the main channel at the same time. 
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11.5.3.4 Info Table 

When the information table is “On”, click other menu options and the measurement result table 

will not be closed. When the status of the information table is “Off”, the measurement result 

information table will be closed. 

ACPR measurement results include: Main CH Power, Left channel power and Right channel 

power. 

⚫ Main CH Power: Displays the power within the bandwidth of the main power 

⚫ Left channel power : Displays the power of left channel and the power difference between 

the left channel and the main channel (in dBc) 

⚫ Right channel power: Display the power of the right channel and the power difference 

between the right channel and the main channel(in dBc) 

 

11.5.4 Occupied BW 

Integrates the power within the whole span and calculates the bandwidth occupied by this 

power according to the specified power ratio. The OBW function also indicates the difference 

(namely “Transmit Freq Error”) between the center frequency of the channel under measurement 

and the center frequency of the analyzer.  

Select “Channel Power” and click “Meas Setup” to set the corresponding parameters. The two 

vertical lines on the trace perpendicular to the X-axis represent the occupancy span of the 

power percentage. The value on the Y-axis is the power occupying the bandwidth, and displays 

on the upper right corner. 
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Figure 11-15 Occupied BW measurement 

 

11.5.4.1 Occ BW Percent 

Specifies the percentage of total power measured within occupied bandwidth for the current 

measurement. 

 

11.5.4.2 Info Table 

When the information table is “On”, click other menu options and the measurement result table 

will not be closed. When the status of the information table is “Off”, the measurement result 

information table will be closed. 

⚫ Occupied Bandwidth: Integrates the power within the whole span and then calculates 

the bandwidth occupied by the power according to the specified power ratio. 

⚫ Power: the power according to the specified power ratio. 

⚫ Total Power: the whole span power. 
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⚫ Transmit Freq Error: The difference between the center frequency of the channel and 

the center frequency of the analyzer. 

 

11.5.5 TOI 

11.5.5.1 TOI Overview 

TOI is the function that is automatic measurement of IP3 (Third order Intercept Point), including 

the power of fundamental wave and the Third order in the power, and calculate the adjustable 

Intercept Point. After entering the SA mode, select the TOI function, then the measurement is 

automatically performed without setting parameters. 

 

Figure 11-16 TOI measurement 

 

If the user needs to modify the TOI related parameter settings, they can set the relevant 

parameters by pressing Setup, as shown in Figure 11-16. Tone is used to set the acquisition 

method for the fundamental frequency signal. When Tone is set to automatic, it analyzes the 
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information of the input signal and selects the two peak signals with the highest amplitude to 

obtain the amplitude and frequency of the fundamental frequency signal. When Tone is set to 

manual, users use "Lower Tone" and "Upper Tone" to input the frequency of the fundamental 

frequency signal. At this time, relevant information will be calculated based on the power value at 

the input frequency point, and it will not determine whether the signal at the set frequency point 

is a peak signal. 

 

In automatic mode, TOI searches for positive peaks within the sweeping range, and takes the first 

two peaks as the fundamental frequency and marks them as f2 and f3, corresponding to the 

amplitude p2 and p3. If no peak value meets the conditions, the test is considered to have failed. 

The message "Two peaks are not found." is displayed, which can be found in the message bar. If 

two peaks are found, the Frequency point of the intermodulation component f1 = 2* f2-F3, f4 = 

2* F3-F2. If a point in f1 and f4 exceeds the scanning range, the prompt "Frequency of toi is out 

of range." will be displayed, and this information can be found in the message bar. If f1 and f4 are 

in the sweeping range, the corresponding power is denoted as p3 and p4, and the crossover 

interception point is calculated according to the above information: 

IP3_Lower = (p2 –p1)/2 + p2 

IP3_Upper = (p3 –p4)/2 + p3 

The calculation process for manual mode and automatic mode is the same, but the process of 

finding the fundamental frequency signal is omitted. 

 

11.5.5.2 TOI Info Table 

When the information table is "On", click other menu options, the result information table will not 

close, Otherwise close the result information table. If all the information of the third-order 

crossover is successfully calculated, the result information table displays the calculation result of 

the third-order crossover. Otherwise,” – “is displayed. The result information table contains the 
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following contents: 

⚫ Lower 3rd: Low frequency component of TOI. 

⚫ Lower Tone: The lower frequency fundamental signal of the input signal. 

⚫ Upper Tone: The Upper frequency fundamental signal of the input signal. 

⚫ Upper 3rd: Upper frequency component of TOI. 

⚫ Frequency: The frequency of each item in the TOI calculation. 

⚫ Amplitude: 

⚫ dBc: Decibels of the ratio of the intermodulation component to the power of the 

fundamental frequency signal 

⚫ TOI: Third-Order Intercept Point 

After the information of the TOI is successfully calculated, the smaller of the two TOI points 

and the corresponding dBc is displayed separately. 

 

11.5.6 CNR 

11.5.6.1 CNR Overview 

Measure the power of the carrier and noise of the specified bandwidth and their ratio. Select 

CNR measure and click Meas Setup menu to set the corresponding parameters. 
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Figure 11-17 CNR measurement  

 

Carrier BandWidth: Set the bandwidth of the carrier to be measured. Carrier bandwidth is 

correlated with Span, Noise bandwidth and Frequency offset. 

Noise BandWidth: Set the bandwidth of the noise to be measured. Noise bandwidth is correlated 

with Span, Carrier bandwidth and Frequency offset. 

Frequence Offset: Set the difference between carrier center frequency and noise center 

frequency. Frequency offset is correlated with Span, Carrier bandwidth and. Noise bandwidth. 

11.5.6.2 CNR Info Table 

When the information table is "On", click other menu options, the result information table will not 

close, Otherwise close the result information table. 

⚫ Carrier Power: the total power of the carrier bandwidth. 

⚫ Noise Power: the total power of the selected noise bandwidth. 
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⚫ Carrier Noise Ratio: the ratio of Carrier Power to Noise Power. 

 

11.5.7 Spectrum Monitor 

11.5.7.1 Spectrum Monitor Overview 

Display the power of the swept spectrum as an intensity color map commonly referred to as a 

waterfall chart. Select Spectrum Monitor measure and click Meas Setup menu to set the 

corresponding parameters. 

 

Figure 11-18 Spectrum Monitor 

 

Monitor Length: Set the length of the Monitor. The minimum value is10 and the maximum value 

is 800. 

Restart: clear the measurement and then restart it. 

Spectrum Monitor Run/Pause: User can choose whether to run/pause the spectrum monitoring. 
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If the current state is running, click the "Spectrum monitoring" menu to pause the monitoring, 

and the spectrum monitoring chart will not be refreshed. If the current state is pause, click the 

"Spectrum monitoring" button to start the monitoring, and the spectrum monitoring chart will 

continue to refresh after the previous suspended state. 

 

11.5.7.2 Spectrum Monitor Info Table 

When the information table is "On", click other menu options, the result information table will not 

close, Otherwise close the result information table. 

⚫ The horizontal is the frequency axis, the vertical is the time axis, and the color represents 

the energy magnitude of the spectrum. 

⚫ It is used to monitor the frequency spectrum of discontinuity. Through the frequency 

spectrum monitoring, the change of the signal in a period of time can be observed. 

⚫ The spectrum monitoring chart is refreshed from the bottom up, and the number marked 

on the left indicates the maximum number of monitoring frames that can be displayed in 

the current spectrum display window. Note that the frame number may be less than the 

monitoring length set by the user, and the monitoring length does not conflict with the 

maximum number of monitoring frames that can be displayed. If the length of the spectrum 

monitoring chart is less than 40, and the left side will not display the numbers. 

⚫ The maximum and minimum values of the measurement level in the current trace window 

are displayed at the left and right ends of the reference color bar, and the reference color 

bar is aligned with the spectrum monitoring chart in the center. When the spectrum display 

window is less than a certain value, the measurement level value is not displayed, and only 

the color bar is displayed. 

⚫ The spectrum monitoring chart is aligned with the frequency of the trace window to 

indicate the one-to-one correspondence between the spectrum monitoring chart and the 

frequency. 
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11.5.8 Harmonic Analysis 

Harmonic analysis measures the power of each harmonic of a carrier signal and the total 

harmonic distortion. The maximum number of harmonics that can be measured is the 10th 

harmonic. If you need to modify the relevant parameter settings for harmonic analysis, you can 

do so through the Setup function, as shown in the figure below. 

 

Fundamental Frequency: Sets the frequency of the fundamental signal. The actual fundamental 

signal frequency is determined by combining this setting with the frequency offset. 

Frequency Step: The offset of the harmonic signal. Combined with the actual fundamental signal 

frequency and harmonic number, this determines the high-frequency harmonics to be 

measured. 

Frequency Offset: Sets the fundamental signal offset. The actual fundamental signal frequency is 

determined by combining this setting with the fundamental frequency. 

Harmonic Number: Sets the maximum harmonic number of the measured carrier wave, used to 

calculate the total harmonics. 
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After completing the basic data scan, the VNA combines the broadband scan information and 

the above configuration parameters to determine the number of narrowband frames and the 

center frequency band, and performs multiple scans to obtain the power values corresponding 

to each harmonic frequency. The total harmonic distortion (THD) is then calculated using the 

narrowband frame scan information. 

THD =
√∑ 𝑉𝑖

2𝑛
𝑖=2

𝑉1

 

When the Result Information Table is on, clicking other menu options will not close the Result 

Information Table. When the Result Information Table is off, it will close. If the harmonic distortion 

information is successfully calculated, the Result Information Table will display the calculation 

results; otherwise, it will display "---". The contents of the Result Information Table are as follows: 

● The first line displays the frequency and power value of the fundamental signal. 

● The other rows display the frequency of the harmonic signal and the power difference 

between it and the fundamental signal. 

● THD is displayed in dB and as a percentage. 

 

11.6 SA Trace operation 

The vector network analyzer supports mathematical operations between traces or between 

traces and specified offsets in SA mode, and its results are displayed using another trace. As 

shown in the figure: 
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In the function expression z=f (x, y), two identical input traces can be set, but the output trace 

cannot be set as the input trace at the same time. The input and output settings in different 

mathematical relationships are independent of each other. VNA provides four types of 

mathematical budgeting in SA mode: 

⚫ Power subtraction: 𝑇𝑟𝑍 = 10 𝑙𝑜𝑔(10𝑇𝑟𝑋 10⁄  −  10𝑇𝑟𝑌 10⁄ ) 

⚫ Power addition: 𝑇𝑟𝑍 = 10 𝑙𝑜𝑔(10𝑇𝑟𝑋 10⁄  +  10𝑇𝑟𝑌 10⁄ ) 

⚫ Logarithmic offset: 𝑇𝑟𝑍 = 𝑇𝑟𝑋 + 𝑂𝑓𝑓𝑠𝑒𝑡 

⚫ Logarithmic subtraction: 𝑇𝑟𝑍 = 𝑇𝑟𝑋 - 𝑇𝑟𝑌 + 𝑅𝑒𝑓 

 

In the above formula, 𝑇𝑟𝑍 refers to the output trace, 𝑇𝑟𝑇𝑟𝑌 refers to the input trace, 𝑂𝑓𝑓𝑠𝑒𝑡 refers 

to the specified offset, 𝑅𝑒𝑓 refers to the reference, and the data units are all in dBm. Note: When 

the same trace is associated with multiple sets of mathematical relationships, VNA performs 

operations in the order of the output trace numbers, which poses a certain risk and makes the 

results difficult to understand. In addition, for the same trace, "mathematical operations", 

"memory operations", and "analysis" functions cannot run simultaneously. After opening the 
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memory operation and analysis function, the mathematical operation function will prompt 

"Conflicted with analysis." or "Conflicted with memory." After opening the mathematical 

operation function, the other two functions will prompt "Conflicted with calculation.". 

 

 

11.7 Correct 

Correction supports correcting the measured values on the y-axis on a specific x-axis.  

There are currently 6 amendments, all of which are in effect simultaneously. 

 

 

Correct configuration guide 

 

Corrections enable: is the main switch for correction, used to control whether the correction 

function is effective. If this switch is turned off, the correction function cannot be effective; 

Select correction: is used to select a correction for processing, and VNA currently has 6 

corrections set; 
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Corr enable: indicates the enabled situation selected for correction; 

Save file and Recall file: are used to quickly load correction data. For the correction function, a. 

cor file has been added to record the offset terms corresponding to the amplitude of each 

frequency. After correcting the enable, calculate the amplitude offset term based on the input 

frequency to offset the signal "Save file" and "recall file" are used to save and call relevant 

correction data. 

Edit corrections: is used to edit the selected correction item data, as shown in the figure: 

 

 

 

Correction function menu guide 

 

The data in the correction table is the correction term, and the correction data is saved in the 

form of<freq, cor value>. "Select corrections" is used to select corrections. VNA supports 6 

corrections, each corresponding to a correction table. Selecting corrections is used to edit the 

corresponding correction table. "Add Corr", "insert Corr", "delete Corr", and "delete all 

Corrections" are used to quickly edit correction items in the correction table. When editing the 
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correction table, if the current measurement format is logarithmic, a blue line will be displayed in 

the center of the screen as a reference, indicating 0dB. The inner column of the left scale axis 

displays relevant scale information based on the position of 0dB and the scale value for 

reference. 

 

11.8 Power calibration in SA mode 

The vector network analyzer undergoes source power calibration and receiver power calibration 

before leaving the factory. However, power calibration before leaving the factory may not 

guarantee sufficient accuracy in any scenario used by users, so users can perform a power 

calibration before testing to improve the accuracy of the test. As shown in the figure: 

 

 

Power calibration guide 

 

The measurement data after on-site calibration is still affected by factors such as cables, fixtures, 

and adapters. In order to input accurate signals at the input end of the DUT and improve the 

accuracy of power measurement results at both ends of the DUT, users need to perform 
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calibration again and move the calibration surface to both ends of the test piece. The steps for 

power calibration in SA mode are as follows: 

1) Click on power calibration to enter the power interface; 

2) Choose whether to perform receiver power calibration; 

3) Select the power meter access port, set power calibration information, connect the port to 
the power meter, and click "take SWP" to scan; 

4) If receiver power calibration is not performed, click finish to complete the source power 
calibration of the port. If receiver power calibration is performed, click next to enter the basic 
calibration interface; 

5) Enter the basic calibration interface, select the relevant parameters for basic calibration, and 
perform port calibration; 

6) After configuring the basic calibration parameters, click next and follow the interface prompts 
to connect the relevant calibration components. After measuring the relevant data, click finish 
to complete the source power calibration and receiver power calibration for the basic 
calibration port. 

 

 

 

Power Compensation guide 

 

After completing power calibration, configure the relevant options to set the enabling status of 
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calibration data. It should be noted that only by using at least one port as the source port output 

signal can the enable status of source power calibration be set, otherwise relevant information 

cannot be set. 

 

11.9 Fixture measurement in SA mode 

For the DUT to be measured in the fixture, the traditional power calibration method can not 

move the reference plane of the receiver to the two ends of the DUT to be measured. In order to 

improve the accuracy of power measurement, the measured data can be processed by 

impedance transform, port matching, two-port de-embedding and port extension, thus, the 

measuring reference plane is consistent with the plane of the DUT to be measured. 

Power calibration in spectrum analysis mode, port extension processing by referring to “Port 

extension” chapter, and configuration of relevant parameters of fixture measurement by 

referring to “Fixture measurement function” chapter, the accurate power value can be measured. 
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12 Frequency Offset Measurement 

12.1 Overview 

Generally with network analyzers, the frequency must be the same both at the signal source and 

at the receiver, so frequency-translating devices such as mixers or converters cannot be 

measured. To enable the analyzer to measure frequency conversion devices, the receiver 

frequency must be synchronized with a frequency consisting of the input frequency and a certain 

added offset, which is called frequency-offset sweep. The frequency offset sweep function of 

SNA5000A&SNA5000X-E can be used for mixers related measurement. 

The SNA5000A&SNA5000X-E provides not only this frequency-offset sweep but state-of-the-

art mixer calibration features: scalar-mixer calibration. Scalar-Mixer Calibration performs high-

accuracy measurement for the magnitude and reflection parameter of mixer conversion loss. 

Moreover, the SNA5000A&SNA5000X-E supports an absolute measurement function. The 

network analyzers normally measure the ratio of the test signal's magnitude and phase to the 

reference signal. In contrast, the absolute measurement function performs a measurement of 

the absolute value of the test signal's magnitude. In combination with the frequency-offset 

function, the absolute measurement function provides measurements that include 

measurement of harmonic distortion. It also provides high-accuracy measurement when 

combined with Power Calibration and Receiver Calibration. 

 

12.2 Frequency Offset Mode 

Frequency Offset Mode (FOM) enables the instrument internal RF signal source and instrument 

port receiver to operate at different frequencies. To realize the measurement of nonlinear 

characteristics of the device. 
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12.2.1 Frequency Offset settings 

Press [Freq] > Freq Offset… to enter the frequency offset function setting dialog box. 

 

 

 

A. Frequency Offset (ON/OFF) Enables Frequency Offset Mode on ALL measurements that are 

present in the active channel. When frequency offset function is not enabled, all frequencies 

are the same as the Primary frequency. 

B. Sources and Receivers 

⚫ Primary the current Active Channel settings. When a Source or Receiver is coupled to 

the Primary settings, its Sweep Type is the same as that of the Primary. The frequency 

settings of the coupled range are mathematically derived from the Primary settings 

using the Multiplier, Divisor and offset values. With this approach, only the Primary 

settings need to be changed in order to affect change in the coupled Sources and 

Receivers. Changes to the Primary channel settings occur when Frequency Offset is 

checked ON. 
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Primary settings are only used when Sources and Receivers are Coupled. It is often 

easier to Uncouple, then set Sources and Receivers independently. 

⚫ Source the internal source signal of the VNA. 

⚫ Receivers All receivers that are used in the channel, including Reference receivers, are 

tuned to the specified frequency settings. 

C. Mode 

⚫ Coupled Source and Receiver settings are mathematically derived from the Primary 

settings using Multiplier, Divisor, and Offset values. 

⚫ Uncoupled Source and Receiver settings are entered independently, without reference 

to Primary settings. When Uncoupled, Source and Receiver Ranges can use separate 

sweep types. 

D. Sweep Type Click to change the type of sweep for each range. Only available for Primary 

and Uncoupled Sources and Receivers. 

E. Settings To change settings click IN the appropriate Settings cell, then will pop up the 

corresponding settings dialog box that can be edited. If coupled, invokes the Coupled 

dialog. If uncoupled or Primary invokes the Uncoupled settings dialog. 

F. X-Axis Annotation Select the settings to be displayed on the X-Axis. 

G. X-Axis Point Spacing Only available when a Segment Sweep Type is selected as the X-Axis 

display. 

 

Coupled settings dialog box 
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A. Multiplier Specifies (along with the divisor) the value to multiply by the stimulus. The value is an 

integer from -100 to 100. 

B. Divisor Specifies (along with the multiplier) the value to multiply the stimulus. The value is an 

integer from -100 to100. 

C. Offset Specify the absolute offset frequency (Hz). For the mixer, this will be the LO frequency. 

The range is [-5000GHz, 5000GHz]. 

D. Start Freq = [Primary Start x (Multiplier / Divisor)] + Offset 

E. Stop Freq = [Primary Stop x (Multiplier / Divisor)] + Offset 

 

Primary and Uncoupled settings dialog box 
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A. Sweep Type The settings dialog box is vary depending on the sweep type. 

B. Frequency Type Select Start / Stop or Center / span. 

C. Start Freq Enter values. 

D. Stop Freq Enter values. 

E. Sweep Point (Primary only) Enter number of data points for the sweep. 

 

Tip: 

When sweep type is Segment Sweep, the segment table edits are made exactly like the standard 

segment table. In segment sweep mode: 

⚫ The OK button is NOT available until the total number of data points for all segments 

matches the number of Primary data points. 
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⚫ Independent IF Bandwidth and Independent Sweep Time are available ONLY on the Primary 

(channel) and the Uncoupled Receivers - NOT Sources. 

⚫ Independent Power is available ONLY on the Primary (channel) and the Uncoupled Sources - 

NOT Receivers. 
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13 Mixer Measurement (Only for SNA5000A) 

There are two measurement modes for VNA mixer measurement: 

⚫ Scalar mixer (SMM): Measurement parameters include scalar transmission 
characteristics, vector reflection characteristics, and mixer input and output 
power. Connect the DUT and VNA according to the following diagram during 
measurement. 

 

⚫ Vector mixer (VMM): The measurement parameters include vector S parameters, 
which can measure the group delay of the mixer. VNA uses the alternating frequency 
conversion method to measure the vector transmission characteristics of DUT, as 
shown in the following figure. If the DUT operates at down conversion, the calibration 
mixer needs to operate at up conversion, and vice versa. Connect the DUT, 
calibration mixer/filter combination, power divider, VNA, and external source (if 
necessary) according to the following diagram. 
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Before conducting mixer measurements, sufficient preheating is required, followed by the 

following steps: 

1. Turn on the mixer measurement mode 

2. Configure mixer related parameters 

3. Perform source power calibration in SMM/VMM mode (optional) 

4. Perform scalar mixing calibration/vector mixing calibration 

5. Conduct mixer measurement 

 

13.1 How to activate the mixer measurement 

Option SMM provides Scalar Mixer Measurements. 

Option VMM provides Vector Mixer Measurements. 

By pressing the buttons on the front panel, press【Meas】> S-Params > Mode > SMM / 

VMM, and the user can select "Active Channel" or "New Channel". After clicking OK, the mixer 

measurement function can be turned on in the current channel or new channel. 
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The “show setup dialog” checkbox is selected by default, indicating that every time the 

mixer is turned on for measurement, a Mixer Measure Setup dialog box will pop up for users to 

set mixer related parameters, as shown in the following figure. 

 

 

If the “show setup dialog” checkbox is unchecked, the Mixer Measure Setup dialog box will 

not pop up simultaneously when the user opens the mixer measurement function. If the user 

needs to modify the mixer parameter settings again, they can access the Mixer Measure Setup 

dialog box by pressing the front panel excitation condition buttons 【Start】/【Stop】/

【Freq】/【Power】/【Sweep】> mixer measurement. 

13.2 Configure mixer related parameters 

There may be difficulties configuring the Mixer Measure Setup dialog box for the first 

time. When users encounter invalid configurations during the parameter configuration process, 

corresponding warning prompts will be displayed at the bottom of the dialog box. 
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The following are effective mixer configuration/sweep type combinations: 

Sweep Type RF(input） LO(Local） IF(Output） SMM VMM 

Linear 

Start/Stop Start/Stop Fixed √ √ 

Start/Stop Fixed Start/Stop √ √ 

Fixed Start/Stop Start/Stop √ ⅹ 

CW Time 

Power 
Fixed Fixed Fixed √ √ 

 

Vector mixer requires embedding a calibration mixer/filter combination. When the DUT 

output is fixed, the calibration mixer input is fixed and LO is scanning. In this working mode, it is 

impossible to obtain the S2P file of the calibration mixer/filter combination. 

Although you may quickly become familiar with configuring the relevant mixer in these tabs, 

it is best to perform mixer measurement configuration in the following order when using them 

for the first time. 

1. Mixer Conversion Mode Configuration tab: Determine the number of mixer conversion 

stages. 

2. Scan Configuration tab: Determine the scan type. 

3. Mixer Frequency Configuration tab. 

4. Power Configuration tab. 

5. Mixer Power Configuration tab. 
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13.2.1 Sweep tab 

 

 

Sweep Type： 

⚫ Linear Frequency: Perform linear sweep within the specified frequency range. 

⚫ Segment Sweep: Sweep according to the segment sweep table. 

⚫ CW Time: All ranges are set to a fixed (CW) frequency and display data relative to 

time. 

⚫ Power Sweep: Sweep input or LO power. 

X-Axis Display：When the scanning type is Segment Sweep, X-Axis Point Spacing can only 

be selected, and all measurement points will be evenly distributed along the X-axis after 

selection. 

Sweet Point: The number of data points measured during scanning 
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IF Bandwidth: Set the intermediate frequency bandwidth. 

 

A. The mixer measurement returns to default settings. 

B. Save the current mixer measurement settings in “.mxr/.csv” format. 

C. Load the mixer measurement settings. 

D. Apply mixer settings and close the dialog box. 

E. Cancel the mixer settings and close the dialog box. 

F. Apply mixer configuration. 

G. Open the scalar mixing/vector mixing help document. 

 

13.2.2 Power tab 

The Power tab of the Mixer Measure Setup dialog box is used to configure the power output 

of the DUT Input (SMM)/Calibration Mixer Input (VMM) and DUT Output ports. 
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Power On(All Channels): Select to open all internal RF sources of VNA channels. 

 Port Power Coupled: Select to open the INPUT OUTPUT port source power coupling. 

DUT Input Port (SMM) / Calibration Input Port(VMM): Users can select the input port for DUT 

Input (SMM)/Calibration Mixer Input (VMM) signals based on the actual connection situation, and 

then set the power level of that port. 

DUT Output Port: Users can select the output port of the DUT based on its actual 

connection status, and then set the power level of that port. 

DUT Input Port Power Sweep (SMM) / Calibration Input Port Power Sweep (VMM): When the 

sweep method is power sweep, the Start Power and Stop Power editing boxes can be used for 

editing settings. 

DUT Output Port Power Sweep: When the sweep method is power sweep, the Start Power 

and Stop Power editing boxes can be used for editing settings. 

 

13.2.3 Mixer Frequency Tab 

13.2.3.1 Mixer Frequency 

The frequency parameters set in this tab are all for the DUT. In VMM mode, the frequency 

parameters for calibrating the mixer are automatically calculated by the DUT and do not need to 

be set by the user. 

Input: The excitation frequency input to the DUT. 

LO (Local Oscillator): Local oscillator frequency of the DUT. 

Output: The response frequency of the DUT after up or down conversion. 
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Mixer Single Frequency Conversion Tab 

 

The frequency format can be selected as "Start/Stop", "Center/Span" or "Fixed". For linear 

sweep and segment sweep type, at least one of them must be 'Fixed'. When the sweep type is 

"CW Time" or "Power Sweep", all items must be "Fixed". 

 

A. DUT input frequency format setting. 

B. LO frequency format setting. 

C. DUT output frequency format setting. 

D. DUT variable frequency selector. When "+" is selected, it represents the sum of the input 

frequency and LO frequency; When "-" is selected, it represents the difference between 

the input frequency and the LO frequency. 

E. Calculate the input frequency setting based on the user's other DUT settings, such as 
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setting the frequency range of DUT LO (Local) and output, and click "Calc Input" VNA to 

calculate and display the input frequency. 

F. Input>LO indicates that when the DUT selects down conversion and the input 

signal>local oscillator signal, this checkbox must be selected in order to calculate the 

output frequency by clicking the "Calculate" button. 

G. Calculate the LO frequency setting based on the user's other DUT settings, such as 

setting the frequency range for input and output. Clicking on "Calc Local" VNA will 

calculate and display the LO frequency. 

H. Calculate the output frequency setting based on the user's other DUT settings, such as 

setting the frequency range of input and LO (Local), and click "Calc Output" VNA to 

calculate and display the output frequency. 

When a secondary frequency converter is used, IF (intermediate frequency) serves as the 

output of the first-stage frequency converter and the input of the second-stage frequency 

converter. The intermediate frequency is automatically calculated based on the frequency 

conversion, requiring no user configuration. 

 

Mixer Secondary Frequency Conversion Tab 
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13.2.3.2 Segment Sweep Frequency Tab 

When selecting segment sweep on the Sweep tab, the "Mixer Frequency" tab will display the 

following settings. 

 

Segment Mixer Frequency Tab 

 

How to configure segmentation: 

1. Click "Add" to add the number of scanned segments. 

2. Click "Delete" to delete a segment and renumber all subsequent segments. 

3. The default state of 'Segment Enable' is open. When not selected, it means closed, and 

the scan will not include the segment. 

4. Configure frequency settings for input, LO, and output ranges. 
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⚫ For each segment, the frequency configuration rules of the mixer should also be 

followed. 

⚫ Allow segmented input, LO, and output frequencies to overlap with other segments. 

At this point, please configure the segmentation order correctly to fully display the 

scanning frequency on the frequency axis. 

⚫ Scan all segments in either forward (start<stop) or reverse (start>stop) direction. 

Mixing scanning directions is not allowed. 

⚫ The following settings can be set separately for each segment: 

a) Points: The total number of points for all segments is limited to the maximum 

number allowed by VNA. 

b) IF bandwidth. 

c) Port power: input, output, LO, these settings will override the settings on the 

power tab. 

⚫ The following settings apply to all segments: 

a) LO source selection. 

b) All input and LO product factor settings. 

c) Source regulation. 

d) X-axis display (input, LO, output). 

e) Distance between X-axis points. 

⚫ Save the mixer segmentation settings information to the "*. mxr" file. 

 

13.2.4 Mixer Power Tab 

Configure the local oscillator power of the mixer. 
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Mixer Power Tab 

 

A. Whether local oscillator power is enabled. 

B. LO1 local oscillator name. Displays "Not Controlled" when not controlled; displays "Port X" (X 

represents the source output port) when using an internal VNA source; displays the external 

source name when using an external source. 

C. LO1 local oscillator power level, valid during non-power scan. 

D. LO1 local oscillator power start and stop levels, valid during power scan. 

E. LO2 local oscillator (when secondary frequency conversion is present). 
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13.2.5 Mixer Setup Tab 

 

Mixer Setup Tab 

 

A. Mixer frequency conversion count. 

B. Add external source. Connect the external source to any USB port of the VNA using a USB 

cable, and then click the "External Source" option. After the VNA successfully recognizes the 

external source, the external source device information will appear in the "External Source" 

dialog box. When an external source is selected for LO, the VNA will refer to the Local 

frequency and power configuration and control the external source to provide the specified 

local oscillator frequency output during scanning. 

C. Select the VNA port to connect to the DUT input. 

D. Select the VNA port to connect to the DUT output. 
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E. LO1: You can choose between Uncontrolled, Internal Source mode, and External Source 

mode. Selecting "Not Controlled" means the external source always provides a fixed 

frequency and power LO output. Selecting "Port X" means the internal source provides a 

variable LO output. Selecting other options allows the VNA to control the external source to 

provide a variable LO output. 

F. LO2 (when secondary frequency conversion is present). 

G. The combination of fractional product factors (numerator/denominator) forms a fractional 

value, which is multiplied by the input frequency and the LO frequency to calculate the 

frequency of the DUT output. The numerator and denominator of the fractional product 

factor range from -100 to +100, and the denominator cannot be set to 0. 

 

The example of fraction multiplication factors: 

Example 1: The operation of the third harmonic mixer can be replicated using the LO 

fraction multiplication factor. When the input frequency and LO frequency are known, VNA can 

accurately calculate the receiver frequency. 

 

 

In the Mixer Measure Setup dialog box, under the Mixer Frequency tab, make the following 

settings: 

⚫ Input start：1GHz 

⚫ Input Stop：3GHz 
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⚫ Local Fixed：1.5GHz 

⚫ Selection of frequency converter for mixer: difference ("-") 

⚫ Input score multiplication factor: 1/1 

⚫ LO score multiplication factor: 3/1 

⚫ Click on 'Calc Output' 

⚫ The calculation result is: output start frequency of 3.5GHz, output stop frequency of 

1.5GHz 

 

Example 2: When the input frequency, LO frequency, and output frequency are known, using 

a fractional product factor can tune the VNA receiver frequency to the second harmonic of the 

mixer's 8 GHz base output. 

 

 

In the Mixer Measure Setup dialog box, under the Mixer Frequency tab, make the following 

settings: 

⚫ Input Fixed：1GHz 

⚫ Local Fixed：3GHz 

⚫ Selection of frequency converter for mixer: Sum ("+") 

⚫ Input score multiplication factor: 2/1 

⚫ LO score multiplication factor: 2/1 
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⚫ Click on 'Calc Output' 

⚫ The calculation result is: output Fixed 8GHz 

 

Example 3: When the input frequency and LO frequency are known, using the LO fraction 

multiplication factor can replicate the operation of the "divide by 2" mechanism within the mixer 

packet. After completing this operation, VNA can accurately calculate the frequency of the 

receiver. 

 

 

In the Mixer Measure Setup dialog box, under the Mixer Frequency tab, make the following 

settings: 

⚫ Input start：50MHz 

⚫ Input Stop：100MHz 

⚫ Local Fixed：600MHz 

⚫ Selection of frequency converter for mixer: Sum ("+") 

⚫ Input score multiplication factor: 1/1 

⚫ LO score multiplication factor: 2/1 

⚫ Click on 'Calc Output' 

⚫ The calculation result is: the output start frequency is 350MHz, and the output stop 

frequency is 400MHz. 



SNA5000A&SNA5000X-E User Manual 

340                                                                                   int.siglent.com 

 

13.2.6 Mixer Configuration Rules 

The warning message at the bottom of the dialog box indicates that one or more of the 

following settings are invalid: 

 

13.2.6.1 Frequency configuration rules 

● The DUT must have at least one of its input frequency, LO frequency, and output frequency 

within a fixed frequency range, or all three must be within a fixed frequency range. 

● The DUT's input frequency, LO frequency, and output frequency must satisfy a frequency 

conversion relationship. 

● During segment scanning, the starting frequency of all segment input frequencies, LO 

frequencies, and output frequencies must either be less than or greater than the ending 

frequency. 

 

13.2.6.2 Port configuration rules 

● When the VNA can provide two sources, ports 1 and 2 use the same source, and ports 3 and 

4 use the same source. 

 

13.3 Noise suppression (optional) 

The "noise suppression" function of the mixer can prevent unnecessary mixing products 

from appearing on the VNA screen. When performing scalar mixer measurements, noise 

suppression is turned off by default. Press the【Cal】key on the front panel → Mixer Cal... → 

Avoid Spur to enable it. The vector mixer has built-in noise suppression function, which does not 
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require user operation. To obtain more accurate measurement results as much as possible, 

please ensure that the state of noise suppression during calibration is consistent with that during 

measurement. 

 

13.4 Source power calibration (optional) 

In the mixer measurement mode, connect the power meter to the VNA port, press the

【Cal】button on the front panel -> power calibration ->perform source calibration related 

configuration ->"Take Cal Sweep", and perform source power calibration. 

 

13.5 Mixer calibration 

13.5.1 Scalar mixer calibration 

13.5.1.1 Overview 

VNA has scalar mixing calibration function, which can be used to measure frequency 

conversion equipment. 

By using a combination of calibration standards (open circuit/short circuit/load) and a power 

meter for calibration, scalar mixing calibration allows for higher accuracy measurement of the 

amplitude, reflection parameters, and power parameters of the frequency conversion loss of the 

mixer. 

For the measurement of frequency conversion losses in frequency conversion equipment, 

conventional full 2-port calibration cannot be utilized due to the frequency difference between 

the excitation port and the response port. Therefore, scalar mixing calibration compensates for 

mixer measurements using a corrected full 2-port error model. By using scalar mixing 

calibration, the following error components can be corrected: 
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⚫ Reflection (vector error correction) between the output port of the network analyzer and 

the input port of the tested mixer. 

⚫ Reflection (vector error correction) between the output port of the tested mixer and the 

input port of the network analyzer. 

⚫ Transmission frequency characteristics at different frequencies (scalar error correction). 

⚫ Network analyzer source power, excitation port, and receiver port receiver power. 

Due to the fact that the transmission tracking error term in the error model used for scalar 

mixing calibration is a scalar value, the phase portion of the compensated transmission 

measurement result is invalid. 

 

13.5.1.2 Calibration steps 

In SMM mode, use scalar mixing calibration to compensate for source power, receiver, and 

S-parameter measurements. In SMM mode, press the "Cal" button on the front panel>Mixer 

Calibration>Mixer Calibration... to enter the mixer calibration wizard interface. Follow the wizard 

instructions to connect the calibration kit, and click the corresponding kit name on the UI to 

perform scalar mixing calibration. 
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Scalar mixer calibration activation interface 

 

A. Electronic calibration is used for all two-port calibration. 

B. Power meter required. If unchecked, a power meter is not required; ideal power 

derivation error is used. This option can be left unchecked if the instrument is factory 

calibrated accurately, significantly reducing calibration time; otherwise, the 

measurement results after calibration may be inaccurate. 

C. Power calibration: The mixer input and output ports are connected to power meters 

independently. 

D. "Noise suppression" mode during calibration. 

 

13.5.1.3 Check the error calibration status of the channel 

After the calibration of the scalar mixer is completed, the trace status area on the UI will 

display the symbol of the error calibration type that the trace has performed. After calibration of 
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the scalar mixer, all two port calibration, excitation receiving port receiver calibration, and 

excitation receiving port source power calibration are effective for correction. After calibration, 

the S parameter trace status identifier displays "[F2]". 

 

Trace status identification 

 

13.5.2 Vector mixer calibration 

13.5.2.1 overview 

VNA has vector mixing calibration function, allowing for higher precision measurement of 

mixer S parameters. Through vector transmission characteristics, the group delay characteristics 

of the mixer can be obtained. When measuring vector mixing, a calibration mixer/filter 

combination is introduced. In order to obtain the characteristics of the DUT separately, the 

calibration mixer and filter have the following basic requirements: 

⚫ The operating frequency range of the calibration mixer should be greater than or equal 

to the DUT. 

⚫ Vector mixing measurement eliminates the influence of the calibration mixer/filter 

combination when measuring DUT through the method of de embedding. Therefore, it 

is necessary to obtain the S parameters of the calibration mixer/filter combination, 

which requires the calibration mixer to have reciprocity, that is, S21=S12. For passive 

mixers, this is consistent. 

⚫ The filter suppresses the input signal of the calibration mixer by calibrating the output 

signal of the mixer. 
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Vector mixing calibration first performs full two port calibration, then characterizes the 

calibration mixer/filter combination to obtain S parameters, and finally embeds the corrected full 

two port calibration error model. By using vector mixing calibration, the following error 

components can be corrected: 

⚫ Reflection (vector error correction) between the output port of the network analyzer and 

the input port of the calibration mixer. 

⚫ Reflection (vector error correction) between the output port of the tested mixer and the 

input port of the network analyzer. 

⚫ The S parameter introduced by calibrating the mixer/filter combination. 

 

13.5.2.2 Calibration steps 

In VMM mode, use vector mixing calibration to compensate for S-parameter 

measurements. In VMM mode, press the "Cal" button on the front panel>Mixer Calibration>Mixer 

Calibration... to enter the mixer calibration wizard interface. Follow the wizard instructions to 

connect the calibration kit, and click the corresponding kit name on the UI to perform vector 

mixing calibration. 
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Characterization calibration mixer/filter combination configuration interface 

When characterizing the calibration mixer/filter combination, its S parameters can be 

obtained through the calibration wizard, or the S2P file can be imported through "Import S2P 

File" for characterization. 

 

Characterization and calibration of mixer/filter combination, save S2P interface 
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After calibrating the mixer/filter combination, the characterization parameters can be saved 

through "Save Calibration Mixer/Filter S2P Flie" for direct loading next time. 

 

13.5.2.3 Check the error calibration status of the channel 

After the calibration of the vector mixer is completed, the trace status area on the UI will 

display the symbol of the error calibration type that has been executed for the trace. The vector 

mixer calibration is a corrected two port calibration, so after calibration, the S parameter trace 

status identifier displays "[F2]". 

 

Trace status identification 
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14 Pulse Measurement (Only for SNA5000A) 

14.1 Overview 

Pulse measurements are used to test devices that cannot be tested using continuous signals, 

such as GSM power amplifiers. 

 

14.2 Open/Close Pulse Measurement 

Option PM must be enabled. 

To switch on/off the PM option, use the order Sweep->Pulse Setup. If you have the trial license 

for the PM option, an information dialog will appear to notify you that the trial times will 

decrease. If the trial times expire, a permanent license is needed to switch on the PM option. 
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Figure 14-1 The Pulse Measurement setting interface 

 

14.3 Pulse Measurement Settings 

14.3.1 Pulse Measurement 

Off: Source and Receivers are NOT pulsed 

Standard Pulse: With pulsed RF, the instrument can be configured to sweep in frequency, power 

sweep, and CW time. 

Pulse Profile: Pulse profile measurements provides a time domain (CW frequency) view of the 

pulse envelope. 
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Figure 14-2 Profile Pulse 

 

14.3.2 Pulse Timing 

PLL Locked ON IFBW OFF Delay3 PLL

Ts1

Td0

Ta

Tp

Sweep 
Config

1st Point 2nd Point

Step enable

 Source 
Pulse

Delay1 Delay2

 Acq
Pulse

Ta

Td1

Ts0

 

 

Pulse Width: Sets the width of the source pulse (Ts1). 

Pulse Period: The time to make one complete pulse (Tp). 
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Pulse Frequency: The reciprocal of Period (1/ Period). 

Pulse Delay: The delay between the start of the pulse and the generation of the pulse (Td1). 

 

14.3.3 Properties 

RF&IF Path Gain: Click to launch the RF&IF Path Gain dialog. 

Autoselect Profile Sweep Time: This function is enabled only in pulse profile mode. When 

checked, only the source pulse width can be set. The pulse period is automatically set to 2 times 

the pulse width, and the pulse signal is placed in the middle of the whole signal. This allows you 

to see a complete pulse in the center of the screen. 

Number of Points: 

⚫ Standard Pulse: Sets the number of data points for the measurement. 

⚫ Pulse Profile: Disable the number setting function, only for display. 

IFBW: Select the IFBW for the measurement. The value of IFBW in Profile mode is affected by 

pulse width and pulse period. 
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14.3.4 Measurement Timing 

PLL Locked ON IFBW OFF Delay3 PLL

Ts1

Td0

Ta

Tp

Sweep 
Config

1st Point 2nd Point

Step enable

 Source 
Pulse

Delay1 Delay2

 Acq
Pulse

Ta

Td1

Ts0

 

 

Measurement Delay: 

⚫ Standard Pulse: Receiver delay (Td0). 

⚫ Pulse Profile: Disabled and has no practical significance. 

Measurement Width: Receiver pulse width (Ts0), whose value depends on the selected IFBW 

value. 

Pulse Trigger Source: Set the pulse trigger source. 

Autoselect Width and Delay: This function is enabled only in Standard mode. When checked, 

only pulse period and pulse frequency can be set, and the source pulse width can be adjusted to 

approximately 75% of the pulse period, with 20% delay. This leaves approximately 5% of the 

source pulse ON after the acquisition is completed. 
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14.4 RF&IF Path Gain dialog 

 

Figure 14-3 RF&IF Path Gain dialog 

 

Receiver: Choose the receiver to be set. 

Path Gain: 

⚫ Low: The minimum attenuation mode, the average noise level is lower. 

⚫ Medium: The medium attenuation mode, the average noise level is normal. 

⚫ High: The maximum attenuation mode, the average noise level is higher. 

Couple all paths: Check to make the same setting for all receivers.  
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15 Material Measurement (Only for SNA5000A) 

15.1 Overview 

Material measurement can provide key parameter information for many electronic applications, 

mainly involving the measurement of permittivity and permeability.  A sample to be measured 

is placed in a waveguide measuring device, and both ports of the waveguide device are 

connected to a calibrated network analyzer through waveguide coaxial converters, as shown in 

the following figure. Measure parameters S11, S22, S21 and S12 respectively. By selecting an 

appropriate data processing method and substituting the S parameter value to calculate the 

complex relative permittivity and complex relative permeability, the material measurement can 

be completed. 

 

Vector Network 

Analyzer

Waveguide Coaxial 
Converter

Waveguide Coaxial 
Converter

Waveguide Device 
for Placing Tested 

Sample

 

Figure 15-1 Test Schematic Diagram 

 

In order to obtain accurate measurement results, after the waveguide coaxial converter is 

connected to the VNA port, the VNA should be fully preheated before the material is measured, 
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and the following steps are carried out to realize the material measurement: 

1. Create a MT measurement; 

2. Configure the Material Measurement Setup; 

3. Do the waveguide TRL calibration in material measurement mode; 

4. Connect the waveguide and the waveguide coaxial converter to measure the material. 

 

15.2 Create a MT Measurement 

Option MT must be enabled. 

Press [Meas] > Mode > MATERIAL. After selecting the MATERIAL measurement mode, the user 

can choose whether to check "New Channel" or not then click OK. A Material measurement is 

displayed on the current channel or on a new channel and New Window. 

 

Figure 15-2 MATERIAL mode channel selection dialog box 

 

In the interface of the MATERIAL channel selection dialog box, the “Show Setup Dialog” check   
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box is selected by default. when user clicks “OK”, a Material Measurement Setup dialog box will 

be displayed that can set related parameters. As figure shown below: 

 

Figure 15-3 Material Measurement Setup dialog box 

 

If the Show Setup Dialog check box is deselected, the Material Measurement Setup dialog box 

will not be displayed when the MATERIAL function is enabled. If the user wants to modify the 

MATERIAL parameters, You can call up the Material Measurement Setup dialog box by pressing 

【Meas】> Meas Setup > Meas Setup. 

 

15.3 Configure the Material Measurement Setup 

The Material Measurement Setup dialog box interface has four tabs: Preset tab, Measurement 

Model tab, Sample Holder tab and Waveguide Gap Correction tab. 
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15.3.1 Preset Tab 

 

 

Figure 15-4 Preset Tab 

 

Select Ports:  

⚫ 1st Port: Select the port as the forward port for connecting the waveguide holder 

converter. 

⚫ 2nd Port: Select the port as the reverse port for connecting the waveguide holder 

converter. 

 

Sweep:  
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⚫ Sweep Type: Set the sweep type, and you can choose Linear Frequency or Log Frequency. 

⚫ Start Freq: Set the sweep start frequency.  

⚫ Stop Freq: Set the sweep stop frequency.  

⚫ Sweep Points: Set the sweep points.  

⚫ IFBW: Set the IF bandwidth.  

 

 

Power： 

⚫ Port1 Power: Set the power level of the forward port. 

⚫ Port2 Power: Set the power level of the reverse port. 

⚫ Coupling: Set whether the power levels of the forward and reverse ports are 
consistent. 

 

Quick Setting: Based on the information of the waveguide fixture, quickly set the relevant 

parameters. Click Lookup... to jump to the Lookup Table tab dialog box. The Lookup Table 

provides relevant data of commonly used waveguide fixtures, allowing for quick selection and 

setting of waveguide fixture related parameters. Then click Apply, and the corresponding items 

will be changed. 
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Figure 15-5 Lookup Table Tab 

 

Lookup Table: 

⚫ Band: Waveguide bandwidth type.  

⚫ Width(mm): The width of the waveguide holder.  

⚫ Cut-off Freq(GHz): Cut-off frequency of waveguide holder. 

⚫ Operating Freq Range (GHz): Sweep frequency range. 

⚫ Set to Nominal: Indicates whether to quickly set relevant parameters according to 

waveguide information; if it is selected, the parameters of the corresponding item will be 

set; otherwise, the parameters will not be set.  

a) Start/Stop Freq.: Start/Stop frequency.  

b) Cut-off Freq.: Cut-off frequency.  
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c) Air Gap Params.: Air gap parameter. When checked, the width of waveguide holder 

will be displayed according to the selected waveguide holder. 

 

15.3.2 Measurement Model Tab 

 

 

Figure 15-6 Measurement Model Tab 

 

Measurement Model: There are several different measurement models to choose from, and each 

model has different advantages and limitations. 

⚫ Ref/Tran μ&ε: The complex relative permittivity and complex relative permeability of 

materials are calculated by NRW algorithm, which will be affected by the half-wave 

syntony of materials, and used to measure the permittivity and permeability of materials. 
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⚫ Ref/Tran ε Precision: The complex relative permittivity of nonmagnetic materials is 

calculated by NIST algorithm, which is used to measure the permittivity of materials. 

⚫ Verify Estimate: Indicates the initial estimated value, which is only displayed under the 

Ref/Tran ε Precision measurement model.  

➢ Premittivity: Indicates the dielectric constant of the material, and is used to set the 

initial estimated value of the dielectric constant of the material. 

⚫ Tran ε Fast: The non-iterative algorithm is used to quickly calculate the complex relative 

permittivity for non-magnetic materials, which is used to measure the permittivity of 

materials. 

 

Calculate Type: 

⚫ Average Only: After using forward and reverse calculation of material parameters, 

calculate the average value to obtain the final result. 

⚫ Forward Only: Use the transmission coefficient and reflection coefficient of the forward 

port to calculate material parameters. 

⚫ Reverse Only: Use the transmission coefficient and reflection coefficient of the reverse 

port to calculate material parameters. 

 

15.3.3 Sample Holder Tab 

The sample holder tab interface allows you to define sample holder and sample. 
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Figure 15-7 Sample Holder Tab 

 

Sample Holder Length: Sets the length of the sample holder.  

Distance To Sample: Sets the distance between the sample and the reference plane of the 

forward port.  

Sample Thickness: Sample length. 

 

Sample Holder: Select the sample holder.  

⚫ Waveguide: Waveguide model. 

 

Waveguide: Waveguide-related parameter settings, you can use the Find… button to quickly set 

waveguide information.  
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⚫ Cutoff Frequency: The cutoff frequency of the waveguide, which will be automatically 

calculated according to the waveguide width.  

⚫ Waveguide Width: Waveguide width.  

⚫ Find: Give the information of all optional waveguides, and select the corresponding 

waveguide item to quickly set the information of waveguides. 

 

15.3.4 Waveguide Gap Correction Tab 

 

 

Figure 15-8 waveguide Gap Correction Tab 

 

Small Width of Waveguide: Waveguide height.  

Small Width of Sample: Sample height.  

Correction On: After being checked, the calculation result is corrected according to the height 
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information of waveguide and sample. 

 

15.4 Waveguide TRL Calibration  

Because the waveguide measurement needs an external adapter, it is necessary to calibrate the 

VNA and move the calibration reference plane to both ends of the waveguide coaxial adapter. 

The two-port TRL calibration method does not need to know the index parameters of the 

calibration kit, and all the error items in the error model of the test device can be figured out 

through three simple connection methods. TRL calibration scheme will use the THRU straight 

through calibration element, reflection calibration kit (Open or Short), and a small section of 

transmission line. 

 

Operating steps: 

1. Preset vector network analyzer; 

2. Switch to MATERIAL mode and set the corresponding waveguide holder, sweep points, power 

level and other parameters; 

3. Select Cal → Basic Cal to enter the Settings screen, as shown in the figure below: 

 

 

Figure 15-9 Calibration Wizard Interface 
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4. Select both Port 1 and Port 2, select the required waveguide calibrator in Cal Kit, select TRL 

in the Cal Type, and click Next to proceed to the next step; 

 

 

Figure 15-10 Calibration Wizard Interface 

 

5. Connect waveguide coaxial adapters to Port1 and Port2 respectively, and the calibration 

plane A and the calibration plane B are directly connected together and fixed with screws. 

Click Thru to complete the through calibration of Port1 and Port2; 
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Figure 15-11 Schematic Diagram of Waveguide Calibration Connection 

 

6. The calibration plane A is connected with the short calibration element, and fixed with screws. 

Click the Reflect item of Port1 to complete the reflection calibration of Port1; 

7. The calibration plane B is connected with the short calibration element, and fixed with screws. 

Click the Reflect item of Port2 to complete the reflection calibration of Port2; 

8. Connect the 1/4Line calibration element between the calibration plane A and the calibration 

plane B, fix it with screws, and click the corresponding Line item to complete the calibration 

of Port1 and Port2 transmission lines; 
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Figure 15-12 Calibration Wizard Interface 

 

9. After the calibration, click Finish to exit the calibration interface, complete the calibration, and 

save the calibration data. 

 

15.5 Sample Measurement 

15.5.1 Sample Installation 

Sample installation steps are as follows: 

Load the sample into the waveguide from the waveguide port. Be careful when loading the 

sample to avoid sample damage. After loading, the plane of one side of the sample should be 

flush with the waveguide reference plane, as shown in the following figure: 
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Figure 15-13 Schematic Diagram of Sample Installation 

 

15.5.2 Sample Electromagnetic Parameter Measurement 

The electromagnetic parameters of the tested sample are measured as follows: 

1. In the material measurement mode, set parameters in the Preset tab interface, or you can 

quickly set related parameters through Quick Setting; 

2. Calibrate the vector network analyzer; 

3. Put the sample to be tested into the holder, and connect the sample holder to the calibration 

reference plane and fix it with screws, as shown in the following figure: 
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Figure 15-14 Schematic Diagram of Equipment Connection 

 

4. Set Measurement Model and Calculate Type in the Measurement Model tab interface. If the 

Measurement Model is set to Ref/Tran ε Precision, you need to set the initial estimated value 

of permittivity; 

5. Set the sample holder, sample and waveguide related parameters on the interface of Sample 

Holder tab and Waveguide Gap Correction tab; 

6. When measuring the permittivity, set the measurement mode to ε and the data format to the 

Real. The measurement results are shown in the following figure: 
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Figure 15-15 Permittivity Measurement Results (PEI Material) 

 

7. When measuring magnetic permeability, the Measurement Model should be set to Ref/Tran 

μ&ε, the measurement mode should be set to μ, and the data format should be set to Real. 

The measurement results are shown in the following figure: 
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Figure 15-16 Permeability Measurement Results (PEI Material) 
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16 Gain Compression Measurement (Only for SNA5000A) 

16.1 Overview 

An amplifier has a region of linear gain, where the gain is independent of the input power level. 

This gain is commonly referred to as small signal gain. As the input power is increased to a level 

that causes the amplifier to approach saturation, the gain will decrease. The 1 dB gain 

compression is defined as the input power level that causes amplifier gain to drop 1 dB relative 

to the linear gain. The gain compression function (GC) measures the compression power of the 

amplifier and various parameters of the amplifier at the compression point. 

 

16.2 Create a GC Measurement 

Option GC must be enabled. 

Press [Meas] > Mode > Gain Compression. After selecting the Gain Compression measurement 

mode, the user can choose whether to check "New Channel" or not then click OK. A GC 

measurement is displayed on the current channel or on a new channel and New Window. 
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Gain Compression mode channel selection dialog box 

 

In the interface of the GC channel selection dialog box, the “Show Setup Dialog” check box is 

selected by default. when user clicks “OK”, a Gain Compression Setup dialog box will be 

displayed that can set related parameters. As figure shown below: 
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Gain Compression Setup dialog box 

 

If the Show Setup Dialog check box is deselected, the Gain Compression Setup dialog box will 

not be displayed when the GC function is enabled. If the user wants to modify the GC 

parameters, You can call up the Gain Compression Setup dialog box by pressing  

[Start]/[Stop]/[Freq]/[Power]/[Sweep] > GC Setup…. 

 

16.3 Gain Compression Parameters 

 Parameter Description 

Linear  

S-parameters 

S11 Input Match 

S21 Gain 

S12 Reverse Isolation 

S22 Output Match 

Compression CompIn21 Input power at the compression point. 
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Parameters CompOut21 Output power at the compression point. 

CompGain2

1 
Gain at the compression point. 

CompS11 Input Match at the compression point. 

RefS21 

Linear Gain value used to calculate the compression 

level.  This is calculated differently depending on the 

compression method. 

DeltaGain21 CompGain21 MINUS Linear Gain (in Log Mag format). 

 

16.4 Configure the Gain Compression Setup 

16.4.1 Frequency Tab 

 

GC Setup Frequency Tab 

 

Sweep Type: Choose a linear sweep or a logarithmic sweep. 
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Data Acquisition Modes: The GCA offers three modes for data acquisition: Two 2D sweep 

modes, and SMART sweep. 

⚫ SMART Sweep: SMART Sweep is usually the fastest and most accurate method to 

measure Gain Compression. Unlike the 2D acquisition modes which measure all of the 

specified frequency / power points, SMART Sweep performs a series of power search 

iterations. At each frequency, an 'intelligent guess' of input power is made to find the 

compression level that is within tolerance. This guess is further refined with each 

successive power search iteration sweep.   

⚫ Sweep Power per Frequency(2D): Input power is stepped from Start to Stop at each 

specified frequency.  From the following example you can see that the device is 

exposed to the highest power level (p3) at the first frequency (f1). This could heat the 

device early in the measurement and affect compression results. 

 

⚫ Sweep Frequency per Power(2D): Frequency is swept from start to stop at each 

specified power level as follows: 

 

⚫ In SMART Sweep, the number of iterations and the percentage of compression points 

found will be displayed next to the channel information in the lower left corner of the 

window, as shown in the figure below. 

 

 

In the figure above, "Itr 15" means that 15 iterations have been completed, and the 

percentage behind it means that 100% of the compression points have been found. 
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When performing a 2D sweep, the sweeping progress will be displayed here, as shown 

in the figure below, indicating that the sweeping progress has been completed by 25%. 

Frequency Setting: Configure the frequency axis, including frequency sweep points, frequency 

range and IFBW. 

 

16.4.2 Power Tab 

 

GC Setup Power Tab 

 

Port Setting: Configure the input port and output port for connecting the VNA to the DUT, and 

set the linear input power and reverse power. 

⚫ Linear Input Power: The input power that yields the linear gain of the DUT. The linear 
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gain is used as the reference gain when calculating the Compression from Linear Gain.  

Input match is also measured at this power level. 

⚫ Reverse Output Power: Sets power level into the output of the DUT for reverse sweeps. 

Port power is automatically uncoupled. Reverse power is applied to the DUT ONLY 

under the following conditions. Otherwise, this setting is ignored. 

1. When Linear Output Match or Linear Reverse Isolation parameters are requested. 

2. When Full 2-port correction is used. You can perform a full 2-port cal and downgrade 

to an Enhanced Response Cal to prevent reverse power from being applied to the DUT. 

Power Setting: Configure the power axis, including power sweep points and power range. 

 

16.4.3 Compression Tab 

 

GC Setup Compression Tab 

 

Compression Method: GCA offers the following methods to find the compression point of an 
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amplifier using GCA: 

⚫ Compression from Linear Gain: The specified compression Magnitude Level is 

measured from the linear gain. The linear gain is measured using the Linear Input Power 

that is specified on the Power tab. 

⚫ Compression from Max Gain: The specified compression level is measured from the 

maximum gain level. In SMART sweep, the Max Gain value is updated as each iteration 

occurs. To increase the chances of measuring the actual maximum gain of the amplifier, 

Safe Sweep should be invoked using low Coarse and Fine increments. 

⚫ Compression from Back Off: This compression method uses the Compression Level and 

Back Off values for finding the compression point. 

⚫ X/Y Compression: This compression method uses the specified parameters (X and Y) as 

the criterion for finding the compression point. 

⚫ Compression from Saturation: Similar to Compression from Max Gain, except the 

specified compression level is measured from the maximum power out level. Use this 

method to better find the compression point when measuring amplifiers with non-

monotonic gain. In SMART sweep, the Max power out value is updated as each iteration 

occurs. To increase the chances of measuring the actual maximum power out of the 

amplifier, Safe Sweep should be invoked using low Coarse and Fine increments 

SMART Sweep: 

⚫ Tolerance: Specifies an acceptable range for measuring the compression level. 

Reducing this value can significantly increase the number of iterations that are required 

to find the compression point. 

⚫ Maximum Iterations: Specifies the maximum number of power search iterations SMART 

Sweep is allowed. Reducing this value can cause SMART sweep to terminate before all 

compression levels are found to within the specified tolerance. 

⚫ Show Iterations: When checked, the compression parameter traces are updated at the 
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completion of each power search iteration. When cleared, compression parameter 

traces are updated when SMART Sweep completes the power search iteration process. 

⚫ Safe Mode: Enable smart sweep safe mode, see “SMART Sweep Safe Mode” for details. 

2D Sweep - Compression Point Interpolation: When a 2D Sweep is selected (on the Frequency 

tab), check this box to calculate and display interpolated compression traces. The Target gain is 

calculated using a complex linear ratio between the two closest measured values. All 

compression parameters are then interpolated using this same ratio. Clear the box to display 

compression parameters for the closest compression point, either high or low, to the level 

specified in the Compression Method setting. 

End of Sweep Condition: Specifies the power level applied to the DUT at the completion of a 

GCA measurement. Choose from: 

⚫ Default: Use the default VNA method. 

⚫ RF OFF: RF power is turned off when GCA completes a measurement cycle. 

⚫ Start Power: RF power is set to the start power level. 

⚫ Stop Power: RF power stays at the stop power level. 

Settling Time: Used ONLY in SMART Sweep when Back Off or X/Y compression algorithms are 

selected. This setting allows additional dwell time when the input power changes from the back-

off level to the compression level. 

 

16.5 SMART Sweep Safe Mode 

For use with SMART Sweep ONLY. When enabled, Safe Sweep increases the input power to the 

DUT by the specified amounts, allowing the compression point to be achieved gradually. While 

this will increase the number of iterations required to achieve compression, it also minimizes the 

possibility of driving the DUT too far into compression.   
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Safe Mode 

 

Safe Mode (Enable): Check to enable Safe Sweep. 

Coarse Increment: Sets the maximum change in input power, up or down, which will be applied 

to the DUT from one iteration to the next. Default = 3.0 dB. Without Safe Sweep, the maximum 

change in input power can be the entire Backoff or X value when using these compression 

methods. 

Fine Increment: Once the Fine Threshold has been achieved, this becomes the maximum 

change in input power, up or down, which will be applied to the DUT. Default = 1.00 dB 

Fine Threshold: Specifies the compression level in which Safe Sweep changes from the COARSE 

to the FINE increment. Default = 0.5 dB. This means that, by default, the VNA uses the Fine 

Increment adjustment when compression reaches 0.5 dB. 

Max Output Power: To protect the VNA from damage, when the VNA port that is connected to 

the DUT Output measures the specified value, the input power to the DUT is no longer 

incremented at that frequency. In these cases, the compression point would probably not be 

achieved. 
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16.6 Gain Compression Calibration 

The GCA Calibration Wizard first performs a Source Power Cal. The GCA Source Power Cal is a 

little different from a standard Source Power Cal. Although GCA measurements are performed at 

many power levels, the GCA source power calibration is performed at a single power level over 

the specified frequency span of your GCA measurement. The required source correction from 

that single power level is applied to all power levels. 

Although it is important for GCA to be able to set the absolute power level to the DUT, it is most 

important to be able to exactly measure the actual incident power. Therefore, during the GCA 

Source Power Cal, a receiver calibration is applied to the port 1 reference receiver, and indirectly 

to both test port receivers during the S-parameter calibration, correcting for impedance 

mismatch between the power meter and the VNA source, and the DUT and the VNA source. to 

enter the calibration wizard. 

Press [Cal] > Gain Compression Cal… to enter the calibration wizard. 

Connect the power meter to the VNA input port, then click 'Start Power Measurement' to 

perform the power calibration. 

 

GC Power Calibration 
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After completing the power calibration, click next to enter the S-parameter calibration interface, 

select whether to enable electronic calibration as required, and connect the selected port to the 

corresponding calibration part to start calibration. After completing the S-parameter calibration, 

receiver calibration will be automatically performed.  

 

GC S-parameters Calibration 

 

Click Finish to complete GC calibration. 

 

16.7 Gain Compression Converters 

The gain compression converters measurement (GCX) method is similar to the gain compression 

measurement (GC) method, the difference being that the DUT is different. 
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16.7.1 Create a GCX Measurement 

To enable GCX measurement, both the GC option and the SMM option must be enabled 

simultaneously. 

Press [Meas] > Mode > Gain Compression Converters. After selecting the Gain Compression 

Converters measurement mode, the user can choose whether to check "New Channel" or not, 

then click OK, a GCX measurement is displayed on the current channel or on a new channel and 

New Window. 

 

 

16.7.2 GCX Parameter Configuration and Measurement 

The GCX parameter configuration includes two parts: GC configuration and SMM configuration. 

Since they are the same as the SMM and GC configurations, they will not be described again 

here. 
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The measurement of GCX is similar to that of GC, except that the DUT is a mixer, which will not 

be described in detail here. 
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17 External Switch Matrices 

17.1 Overview  

As the components used in modern communication devices must support more frequency 

bands and functions, such as the wide application of WLAN, Bluetooth and GPS, this means that 

the number of module RF ports is also increasing, while traditional vector network analyzers only 

have a maximum of four test ports, in order to measure multi-port devices, The test cable and 

termination load need to be changed several times between the various ports of the device 

under test (DUT) until all ports have been measured. And this will produce a lot of problems, such 

as: poor repeatability, complex operation, complex calculation is not intuitive and a series of 

problems. To satisfy multiple port scattering parameter tests at the same time, the number of 

ports of the vector network analyzer can be expanded by connecting external matrix switches 

that allow the external test device to be tightly integrated with the VNA itself. Generally called 

vector network analyzer port expansion device. With this extension device, an N-port network 

analyzer can be converted into an M-port network analyzer (M>N) without modifying the 

instrument itself. When making multi-port DUT measurements, multiple measurements can be 

made with a single connection, improving measurement speed, reliability and repeatability 

compared to traditional two/four-port VNA. 

 

17.2 External Matrix switches Introduction 

The firmware of the SNA5000A&SNA5000X-E series is able to control switch matrices from 

SSM5000 directly. It is fast and easy to set up and operate a switch matrix via the graphical user 

interface. For example, an SNA5084X in combination with an SSM5144A can seamlessly work as 

a multiport network analyzer with up to 24 ports. Greatly improve the test efficiency. 
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VNA

DUT1 DUT2 DUT3 DUT4

 

VNA and switch matrix combined expansion port diagram 

 

17.3 Matrix setup step 

17.3.1 Required equipment 

Network vector analysis port expansion required equipment: SNA5000A&SNA5000X-E, 

SSM5000A switch matrix, USB cable, several N-SMA/SMA RF cables. This chapter describes the 

VNA machines and switch matrix devices used by default SNA5084X and SSM5144A. 

 

17.3.2 Establish the physical connection 

1. Power on the SSM5144A and the SNA5084A, Connect the SSM5144A to the SNA5084A 

with a USB cable, and then a message of “The switch matrix plugged in” will displays on 
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the SNA5084A message bar if the SSM5144 is recognized success. 

 

 

2. Press the System >”External Ports” >”Ext Port Enabled” to enable the function, then the 

matrix identifier  is displayed on the upper right corner of the UI. 
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17.3.3 Define the RF configuration 

After the VNA is physically connected to the SSM, Touch the “Switch Matrix...” menu to enter 

the “Switch Matrix RF connections” dialog box. This dialog allows you to define the RF 

connections between the VNA and the switch matrices, and the test port numbering.as picture 

below. 

 

 

: The A/B/C/D labels in the VNA check box indicate the four physical ports of the vector 

network analyzer port. 

: The edit box under the A/B/C/D label in the VNA selection box indicates that the RF input 

port of the SSM to be selected is connected to the VNA port for expansion. By default, physical 

Port1 (A) of the VNA connects to RF input port 1A of the SSM, physical port 2 (B) of the VNA 

connects to RF input port 1B of the SSM, physical port 3 (C) of the VNA connects to RF input port 

1C of the SSM. And physical Port4 (D) of the VNA connects to RF input port 1D of the SSM. If you 

want to customize the RF Port connection between the VNA and the SSM, click the 

corresponding edit box under the A/B/C/D tab and select the port in the “Select Port” dialog 
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box. As shown below: 

 

 

All Port: Indicates all RF ports (including VNA RF ports and SSM RF ports). You can select 

a port from the drop-down list. 

Unused Port: Indicates an unused RF port number. 

Used Port: Indicates the RF port number that is currently in use. 

Switch Matrix: Indicates the RF input physical port number of the matrix switch. When A 

VNA is physically connected with two SSM, “1A” in the drop-down list of Switch Matrix 

represents the RF input port A of the first SSM, “2A” represents the RF input port A of the 

second SSM, and the same applies to 1B, 2B, 1C, 2C, 1D, 2D. 
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: Represents the RF output port of the matrix switch. 

: the “Reset” in the Switch Matrix check box indicates that the default port number 

assignment is restored for the switch port of the matrix. 

: The “Renumber” under the Switch Matrix check box means to re-assign automatic port 

numbers to the switch matrix. 

: The “All Unused” under the Switch Matrix check box indicates that all RF ports of the switch 

matrix are set to unused (that is, no connection exists). 

: The “Reset” in Switch Matrix RF Connections restores the default port number assignment 

for all RF ports (including VNA RF ports and RF ports in the switch matrix). 

: The “Renumber” under the Switch Matrix RF Connections check box indicates automatic 

port number assignment for all RF switch ports (including VNA RF ports and RF ports of the 

switch matrix). 

After the RF port configuration is completed, click the "ok" menu option to apply the VNA 

multi-port expansion. and then the expansion ports also can be selected in the function of Basic 

Calibration, Port Ex tension, Fixtures, Port power.  

 

17.3.4 Setting S Parameters 

After VNA port expansion takes effect, connect the SNA5084X’s Port 1, port 2, port 3, and 

port 4 to the Ports A, B, C, D of the SSM5144A via RF cables (N-SMA). Press the Meas >”S-

Params” >”Other...” to enter the parameter configuration dialog, user can customize the RF Port 

number from the Receiver Port and Source Port drop-down lists. For example, S0512 is select 

the “5” as the receiver port and the ”12” as the source port, or click the "Edit..." under the 

Measure dialog box. To enter the input edit box, enter "0512", and select S0512. 
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17.3.5 Calibrate and measure 

After configure the S params, user can do the calibration by Ecal or by mechanical kit before 

measuring the DUT. The VNA expansion ports only supports the VNA measurement mode. 

Note: In order to obtain more accurate measurement results, the DUT should be fully preheated 

before measuring. 

Note: The machine should be fully preheated before measuring the DUT in order to obtain 

more accurate measurement results. 

 

17.4 Characterize 

Users can leverage the characterization data of the switch matrix to flexibly generate a 

calibration dataset suitable for the current measurement task. 

To open the Characterize Switch Matrix dialog via the front panel keys: Press 【System】 > 

External Ports > Characterize. This utilizes the current channel sweep parameters for 

characterization and supports only Ecal for the process. The characterization procedure is 

divided into two steps: 
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1. Automatically select the output ports that can communicate with the VNA ports, and 

perform a full N-port calibration on these ports. This step can obtain the errors between the 

VNA ports. 

2. Perform OSL calibration on the remaining output ports. Combined with the previous step, 

this can obtain the S2P parameters for all paths from the output ports to the VNA ports. 

Based on the errors between the VNA ports and the S2P parameters, the measurement 

plane can be moved to the end of the output ports. 

After characterization is completed, save the characterization data (.csm file) 

When performing characterization using SCPI commands, ensure that a four-port Ecal is used, 

and connect the output ports sequentially to the ports of the Ecal. 

 

Characterize Switch Matrix Interface 

 

The characterize function of the switch matrix needs to be used in conjunction with the de-

embed function of the switch matrix below. 

 

17.5 De-embed 

This function flexibly generates calibration datasets based on port usage, and moves the 

measurement plane to the output ports of the switch matrix. 

Press [System] > External Ports > De-embed to open the de-embedding switch matrix dialog 
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box.  

 

De-embedding Switch Matrix Interface 

 

A. Whether to use the sweep configuration that was used when characterizing the switch 

matrix. 

B. Select the data file used for characterizing the switch matrix. 

C. Select the channels to be de-embedded; by default, the current channel will be de-

embedded, but multiple channels can be de-embedded simultaneously. 

D. Select the output ports to be de-embedded. 

E. Select the type of calibration dataset to be de-embedded. 
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18 Noise Figure (Only for SNA5000A)  

18.1 Overview of Noise Figure 

The most common definition of noise figure is: input signal-to-noise ratio/output signal-to-

noise ratio. It is an important parameter for measuring the noise quality of the equipment itself, 

reflecting the degree of deterioration of the signal-to-noise ratio after the signal passes through 

the system. The noise figure is a number greater than 1, which means that the signal-to-noise 

ratio deteriorates after the signal passes through the system. Noise figure is one of the key 

indicators of RF circuits, which determines the sensitivity of the receiver and affects the signal-

to-noise ratio of analog communication systems and the bit error rate of digital communication 

systems. 

 

18.2 How to enable noise figure mode 

Through the front panel buttons, press 【Meas】> Mode > NF, select the NF measurement 

mode, and users can choose whether to check "New Channel". After clicking OK, the noise figure 

function can be opened on the current or new channel. 

file:///D:/Baidu_Translate/install/baidu-translate-client/resources/app.asar/app.html
file:///D:/Baidu_Translate/install/baidu-translate-client/resources/app.asar/app.html
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Figure 18-1 NF Mode Channel Selection Dialog Box 

 

The "Show Setup dialog" checkbox is selected by default, indicating that every time NF is 

opened, a Noise Figure Setup dialog box will pop up for users to set NF related parameters. 

If the "Show Setup Dialogs" checkbox is unchecked, the Noise Figure Setup dialog box will not 

pop up simultaneously when the user opens the NF function. If the user needs to modify the NF 

parameter settings again, they can call up the Noise Figure Setup dialog box by pressing the 

excitation condition buttons [Start]/[Stop]/[Freq]/[Power]/[Sweep] on the front panel>Noise 

Figure. 

 

18.3 SLM series Switch and LNA Module 

Noise measurements need to be conducted in conjunction with the use of the SLM, which is a 

device used to amplify the output noise of the DUT as well as to provide different input 

impedances for the DUT. 
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Figure 18-2 SLM series Switch and LNA Module 

 

A. The input end provides five different switchable loads. In scalar cold source measurements, 

only one load is used, whereas in vector cold source measurements, all five loads are utilized. 

B. The receiver end consists of a high-gain (35~45dB) amplifier and a variable band-pass filter. 

During measurement, it is necessary to appropriately reduce the input power to prevent 

gain compression in the VNA (Vector Network Analyzer) receiver. 

The Y-factor method uses the receiver end of the SLM, while the cold-source method requires 

the use of both the input and receiver ends of the SLM simultaneously. 

 

18.4 Noise Figure Setting dialog box 

The Noise Figure Setup dialog box interface has three tabs: Noise Figure tab, Frequency tab, and 

Power tab. 
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18.4.1 Noise Figure tab 

 

Figure 18-3 Noise Figure Tab 

 

Noise Figure Method: 

⚫ Y Factor: Use Y Factor method for noise figure measurement. 

⚫ Scalar Cold Source: Use Scalar Cold Source method for noise figure measurement. 

⚫ Vector Cold Source: Use Vector Cold Source method for noise figure measurement. 

Average: 

⚫ Average Number: Set the average number of noise receivers. As the average number 
of times increases, the measured noise trace becomes smoother, while the 
measurement speed decreases. 

⚫ Average ON: Turn on and off noise averaging. 

Bandwidth: 

⚫ Noise Bandwidth: The bandwidth of the noise receiver for noise measurement can 
be set to 600kHz/1MHz. 
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Ambient Temperature: 

⚫ Environmental temperature during measurement. 

 

18.4.2 Frequency tab 

 

Figure 18-4 Frequency Tab 

 

Sweep Settings： 

⚫ Sweep Type: Set the sweep type, which can choose from linear sweep, log sweep, 

CW Frequency or segment sweep. 

⚫ Num of Points: The measured data points of sweep. 

⚫ IF Bandwidth: Set the intermediate frequency bandwidth. 

⚫ Start: Set the sweeping start frequency. 

⚫ Stop: Set the sweeping stop frequency. 

⚫ Center: Set the center frequency. 

⚫ Span: Set the frequency span. 

When the sweep type is segment sweep, the edits made to the segment sweep table are exactly 
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the same as those made to the segment sweep table. 

 

18.4.3 Power tab 

 

Figure 18-5 Power Tab 

 

Power On(All Channels): Select to open the internal RF source for all channels of VNA. 

DUT Input Port: Users can select the input port of the DUT Input signal based on the actual 

connection situation of the DUT, and then set the power level of that port.  

⚫ Input Port: The input port for the DUT Input signal. 

⚫ Power Level: The power level value of the input port. 

DUT Output Port: Users can select the output port of the DUT based on its actual 

connection situation, and then set the power level of that port. 

⚫ Output Port: The output port of the DUT Output signal. 

⚫ Power Level: The power level value of the output port. 

Receiver Calibration: The cold source method uses a power meter for receiver calibration, 
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and the power level of the input port of the DUT Input signal. 

 

18.5 Y-Factor method for noise figure measurement 

18.5.1 Overview of the Principle of Y-Factor Method 

The noise figure measurement process using the Y-factor method is shown in the following 

figure. One noise figure measurement includes two noise power scans.  

Hot state noise power 
scan

Cold state noise power 
scan

Y-factor method

 

Figure 18-6 Y-Factor Method Measurement Sweeping Process 

 

The Port 2 measurement receiver of the VNA, together with the low-noise amplifier and band-

pass filter in the SLM, constitutes the noise receiver. The VNA controls the power switch of the 

NSD28 noise source driver to turn the noise source on and off. During actual scanning, by 

switching the state of the noise source between on and off, the noise power in both hot and cold 

states is measured respectively. This allows for the calculation of the noise figure of the DUT. 
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Figure 18-7 Principle Diagram of Y-Factor Method Measurement 

 

18.5.2 Measurement Parameters Configuration 

Press the [Start]/[Stop]/[Freq]/[Power]/[Sweep] buttons on the front panel > Noise Figure… to 

bring up the Noise Figure Setup dialog box. In the Noise Figure Setup interface, select the Y 

Factor for the Noise Figure Method, and set other relevant parameters. For detailed parameter 

descriptions, please refer to the 'Noise Figure Setting dialog box' section. 
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Figure 18-8 Noise Figure Method is Y Factor 

 

18.5.3 Y-Factor method calibration steps 

1. The Y-factor noise figure calibration only requires the completion of receiver calibration, and 

the remaining unnecessary calibration items will be grayed out. 

 

Figure 18-9 Y-Factor Method Noise Figure Calibration Wizard Interface 

 

2. Input the ENR table of the noise source: As shown in the figure below, edit the Frequency 

ENR Value table, click Next to proceed to the next step, select Save to complete this step, 

and the ENR table will be saved inside the machine. There is no need to input it again when 
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entering the interface next time. 

 

Figure 18-10 ENR Table Input Interface 

 

3. Use a noise source for calibration: Connect the noise source as shown in the figure below: 

1 2

Noise
Source

Noise Source 
Driver

USB

VNA
USB

SL
M VN

A
 

B
D

U
T

 
B

U
SB

Calibration
reference plane 

Calibration
reference plane 

 

Figure 18-11 Y Factor Method Calibration Connection Diagram 

 

4. Calibration reference planes connected, click on Start Calibration on the interface to 

perform calibration. After calibration is completed, click Finish to complete the calibration. 
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Figure 18-12 Y Factor Method Calibration Wizard Interface 

 

5. After the noise coefficient calibration is completed, the bottom status area will display the 

error calibration type symbol "NF Cor" that the trace has been executed. 

 

Figure 18-13 Noise Figure Calibration Status Identification 

 

18.5.4 Connect DUT for measurement 

The calibration reference plane is directly connected to the input and output ports of the DUT as 

shown in the figure below for connecting the DUT to perform measurements. 
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Figure 18-14 Y Factor Method Measurement Connection Diagram 

 

18.6 Cold Source method for noise figure measurement  

18.6.1 Overview of the Principle of Cold Source Method 

1. The process of scalar cold source method noise figure measurement is shown in the 

following figure. One noise figure measurement includes one forward and reverse S-

parameter scan and one noise power scan.  

Noise power sweep

S-para sweep

Cold Source Method

 

Figure 18-15 Scalar Cold Source Method Measurement Sweeping Process 

 

The measured value of the S parameter will be used to calculate the resource power gain 𝐺𝐴 

of the DUT. When measuring the noise power output of the DUT, connect the DUT input 

terminal to a 50 Ω load. The Port 2 measurement receiver of the VNA, together with the 

low-noise amplifier and band-pass filter in the SLM, constitutes the noise receiver. During 

actual scanning, the measurement path is changed by switching the internal switch of the 

SLM, and S parameter scanning and noise power scanning are alternated to calculate the 

noise figure of the DUT. 
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Figure 18-16 Principle Diagram of Scalar Cold Source Method Measurement 

 

2. The process of vector cold source method noise figure measurement is shown in the 

following figure. One noise figure measurement includes one forward and reverse S-

parameter scan and five noise power scans.  

Five noise power sweeps

S-para sweep

Cold Source Method

 

Figure 18-17 Vector Cold Source Method Measurement Sweeping Process 

 

The measured value of the S parameter will be used to calculate the resource power gain 𝐺𝐴 

of the DUT. When measuring the noise power output of the DUT, the DUT input terminal 

sequentially switches through impedance states 1 to 5. The Port 2 measurement receiver of 

the VNA, together with the low-noise amplifier and band-pass filter in the SLM, constitutes 

the noise receiver. During actual scanning, the measurement path is changed by switching 
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the internal switch of the SLM, and S parameter scanning and noise power scanning are 

alternated to calculate the noise figure of the DUT. 

Impedance 
States 1~5

1 2

LNA+BPF

DUT

 S-Parameter 
Measurement

Noise Power 
Measurement

VNA

 

Figure 18-18 Principle Diagram of Vector Cold Source Method Measurement 

 

18.6.2 Measurement Parameters Configuration 

1. Scalar Cold Source : Press the [Start]/[Stop]/[Freq]/[Power]/[Sweep] buttons on the front 

panel > Noise Figure… to bring up the Noise Figure Setup dialog box. In the Noise Figure 

Setup interface, select the Scalar Cold Source for the Noise Figure Method, and set other 

relevant parameters. For detailed parameter descriptions, please refer to the 'Noise Figure 

Setting dialog box' section. 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  409 

 

Figure 18-19 Noise Figure Method is Scalar Cold Source 

 

2. Vector Cold Source : Press the [Start]/[Stop]/[Freq]/[Power]/[Sweep] buttons on the front 

panel > Noise Figure… to bring up the Noise Figure Setup dialog box. In the Noise Figure 

Setup interface, select the Vector Cold Source for the Noise Figure Method, and set other 

relevant parameters. For detailed parameter descriptions, please refer to the 'Noise Figure 

Setting dialog box' section. 
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Figure 18-20 Noise Figure Method is Vector Cold Source 

 

18.6.3 Cold Source Method Calibration Wizard 

The calibration of noise figure using cold source method is divided into three parts: S-Params 

Calibration → Receiver Calibration → Noise Bandwidth. S-Params calibration can be performed 

using the mechanical calibration or the electronic calibration, receiver calibration can be 

performed using the power sensor or the noise source. 

 

Figure 18-21 Cold Source Method Noise Figure Calibration Wizard Interface 
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18.6.4 Using mechanical calibration for two-port calibration 

1. Preparation before calibration: Connect the mechanical calibration part to the calibration 

reference planes as shown in the figure below.  
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Figure 18-22 Cold Source Method Mechanical Calibration Connection Diagram 

 

2. On the calibration wizard interface, select the corresponding Cal Kit, DUT Connector, and 

Cal Type, then click Next to proceed to the next step. 

 

Figure 18-23 Cold Source Method Mechanical Calibration Wizard Interface 

 

3. Perform a full two-port calibration using the corresponding mechanical calibration kit. When 

the progress reaches 100%, the calibration is complete. Click Next to proceed with 
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subsequent calibration operations. 

 

Figure 18-24 Cold Source Method Full Two-Port Calibration Interface 

 

18.6.5 Using ECal for two-port calibration 

1. Preparation before calibration: Connect the electronic calibration component to the 

calibration reference planes as shown in the figure below.  
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Figure 18-25 Cold Source Method Electronic Calibration Connection Diagram 

 

2. After the heating of the electronic calibration component is completed and the READY light 

is on, click Next to proceed to the next step. 
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Figure 18-26 Cold Source Method Electronic Calibration Wizard Interface 

 

3. Perform a full two-port calibration using the corresponding electronic calibration kit. When 

the progress reaches 100%, the calibration is complete. Click Next to proceed with 

subsequent calibration operations. 

 

Figure 18-27 Cold Source Method Full Two-Port Calibration Interface 

 

18.6.6 Using power meter for receiver calibration 

Noise receiver calibration includes two parts: Part 1: Connect the power meter to the DUT A 

calibration reference plane and use the power meter to measure the output power of DUT A; 

Part 2: With the calibration reference planes connected, use the output power of DUT A from 

Part 1 to calibrate the noise receiver. 

1. Connect the power meter as shown in the figure below. The power meter is connected to 

the DUT A calibration reference plane of the SLM. 
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Figure 18-28 Cold Source Method Power Meter Connection Diagram 

 

2. Click Start Power Calibration on the interface to measure the output power of DUT A using 

the power meter. After the calibration is complete, click Next to proceed to the next step. 

 

Figure 18-29 Cold Source Method Power Calibration Wizard Interface 

 

3. Connect the calibration reference planes as shown in the figure below to perform noise 

receiver calibration. 
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Figure 18-30 Cold Source Method Noise Receiver Calibration Connection Diagram 

 

4. Click Start Noise Receiver Calibration on the interface to perform noise receiver calibration 

using the output power of DUT A. After the calibration is complete, click Next to proceed to 

the next step. 

 

Figure 18-31 Cold Source Method Noise Receiver Calibration Wizard Interface 

 

18.6.7 Using noise sources for receiver calibration 

Noise receiver calibration is divided into two parts: Part 1: Connect the noise source to the DUT 

B calibration reference plane and use the noise source to perform noise receiver calibration; Part 

2: Connect the calibration reference planes to measure the input impedance of the noise 
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receiver. 

1. Input the ENR table of the noise source: As shown in the figure below, edit the Frequency 

ENR Value table, click Next to proceed to the next step, and the ENR table will be saved 

inside the machine. There is no need to input it again when entering the interface next time. 

It can also be manually saved and called up for the next measurement. 

 

Figure 18-32 ENR Table Input Interface 

 

2. Calibrate the noise receiver using the noise source: Connect the noise source as shown in 

the figure below, and connect the noise source to the DUT B calibration reference plane of 

the SLM. 

 

Figure 18-33 Cold Source Method Noise Source Connection Diagram 

 

3. Click Start Noise Receiver Calibration on the interface to perform the noise receiver 

calibration. After the calibration is complete, click Next to proceed to the next step. 
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Figure 18-34 Cold Source Method Noise Source Calibration Wizard Interface 

 

4. Connect the calibration planes as shown in the figure below to measure the input 

impedance of the noise receiver. 
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Figure 18-35 Cold Source Method Noise Receiver Calibration Connection Diagram 

 

5. Click Start Noise Receiver Calibration on the interface to measure the input impedance of 

the noise receiver. After the calibration is complete, click Next to proceed to the next step. 
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Figure 18-36 Cold Source Method Noise Receiver Calibration Wizard Interface 

 

18.6.8 Noise bandwidth calibration 

1. Noise bandwidth calibration: Connect the calibration reference planes as shown in the figure 

below. 
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Figure 18-37 Noise Bandwidth Calibration Connection Diagram 

 

2. Click Start Noise Bandwidth Calibration on the interface to perform the noise bandwidth 

calibration. After the calibration is complete, click Finish to complete all calibrations. 
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Figure 18-38 Noise Bandwidth Calibration Wizard Interface 

 

After performing noise bandwidth calibration under a specific noise bandwidth, the calibration 

results will be saved in the machine. The next time entering the same noise bandwidth 

calibration, the previous calibration result will be automatically read, and the UI will display as 

calibration completed. You can also click to start calibration, perform calibration again, and 

update the calibration results saved in the machine from the previous calibration. 

3. After the noise coefficient calibration is completed, the bottom status area will display the 

error calibration type symbol "NF Cor" that the trace has been executed. 

 

Figure 18-39 Noise Figure Calibration Status Identification 

 

18.6.9 Connect DUT for measurement 

The calibration reference plane is directly connected to the input and output ports of the DUT as 

shown in the figure below for connecting the DUT to perform measurements. 
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Figure 18-40 Cold Source Method Measurement Connection Diagram 

 

18.7 Noise Figure measurement item 

Through the front panel buttons, press [Meas] to display the noise figure measurement item. 

 

Figure 18-41 Noise Figure Measurement Item 

 

The Y-factor method supports the following measurement items: Noise Figure. 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  421 

The scalar cold source method supports the following measurement items: Noise Figure, S-

Params, Receiver. 

The vector cold source method supports the following measurement items: Noise Figure, Noise 

Params, Noise Correlation, S-Params, Receiver. 

For a detailed introduction of S-Params, please refer to the "S parameters" section; for a detailed 

introduction of Receiver, please refer to the "Receiver Measurement" section. 

 

18.7.1 Noise Figure measurement item 

Noise figure is a quality factor used to describe excessive noise in a system. Reducing the noise 

figure to the minimum can reduce the impact of noise on the system. The noise factor (F) of a 

network is defined as the SNR of the input signal divided by the SNR of the output signal: 

𝐹 =
(𝑆𝑁𝑅)𝑖𝑛𝑝𝑢𝑡

(𝑆𝑁𝑅)𝑜𝑢𝑡𝑝𝑢𝑡
=

Signal𝑖𝑛𝑝𝑢𝑡 𝑁𝑜𝑖𝑠𝑒𝑖𝑛𝑝𝑢𝑡⁄

Signal𝑜𝑢𝑡𝑝𝑢𝑡 𝑁𝑜𝑖𝑠𝑒𝑜𝑢𝑡𝑝𝑢𝑡⁄
=

(𝑆/𝑁)𝐼

(𝑆/𝑁)𝑂
 

The noise factor in decibels (dB) is the noise figure (NF): 

𝑁𝐹 = 10log|𝐹| = 10𝑙𝑔 (
Signal𝑖𝑛𝑝𝑢𝑡 𝑁𝑜𝑖𝑠𝑒𝑖𝑛𝑝𝑢𝑡⁄

Signal𝑜𝑢𝑡𝑝𝑢𝑡 𝑁𝑜𝑖𝑠𝑒𝑜𝑢𝑡𝑝𝑢𝑡⁄
) = 10𝑙𝑔 (

(𝑆/𝑁)𝐼

(𝑆/𝑁)𝑂
) 

 

18.7.2 Noise Param measurement item 

The noise figure for amplifiers varies as the source impedance changes. For most amplifiers, 

the noise figure is specified at Z0, usually 50 Ω. However, many amplifiers have a lower noise 

figure at some different impedance, and a key design task is to create a matching network that 

transforms 50 Ω to the optimum impedance for minimum noise figure. 

Noise parameters provide the basis for understanding how the noise figure of an amplifier 

changes with the source impedance. The noise figure of the DUT at any reflection coefficient is 

described by the following formula: 

𝑁𝐹 = 𝑁𝐹𝑚𝑖𝑛 +
4𝑅𝑛

𝑍0

|𝛤𝑜𝑝𝑡 − 𝛤𝑠|
2

|1 + 𝛤𝑜𝑝𝑡|
2

(1 − |𝛤𝑠|2)
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18.7.2.1 NFmin 

NFmin - The minimum noise figure that occurs at GammaOpt. NFmin is a scalar quantity that 

can be displayed as Log Mag, Lin Mag, or Real. 

 

18.7.2.2 GammaOpt 

GammaOpt (Optimum Complex Reflection Coefficient) - The optimal impedance for the noise 

figure measurement. Select the data format to display GammaOpt in terms of Log Mag, Lin Mag, 

Phase, Unwrapped Phase, Real, Imaginary, Polar, or on a Smith Chart. 

 

18.7.2.3 Rn 

Rn (Noise Resistance) - Specifies the rate of change of the level of noise when varying the source 

impedance. Rn is a scalar quantity in units of ohms that should be displayed in Lin Mag or Real 

format. 

 

18.7.3 Noise Correlation measurement item 

NCorr_11, NCorr_12, NCorr_21, NCorr_22 - The NCorr_11 and NCorr_22 terms are effective 

noise 

temperature, normalized to 290 K. Both terms are time-averaged, noise-wave powers referred 

to the input of the DUT, where NCorr_11 is the forward wave (noise going through the device 

towards the output), and NCorr_22 is the reverse noise wave (noise coming out of port 1 of the 

DUT, going back towards the source). 

To convert to available noise power, multiply the terms by 290*k*B where: 

⚫ k = Boltzmanns constant 

⚫ B = system bandwidth 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  423 
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19 Automatic Fixture Removal 

19.1 Function Overview 

Automatic Fixture Removal (AFR) is one of the core functions of VNA, used to eliminate the 

influence of test fixtures on measurement results, thereby accurately obtaining the true 

performance parameters of the device under test (DUT). When the DUT (such as PCB microstrip 

lines, high-speed connectors, surface mount components, etc.) cannot be directly connected 

through coaxial interfaces, fixtures are needed to fix or convert the connection. At this time, the 

fixture will introduce insertion loss, reflection and phase error, etc. AFR can remove these errors 

through algorithms to ensure the precise measurement of the DUT. 

 

19.2 Theory of AFR Function 

The automatic fixture removal function of the VNA can extract and store the fixture parameters 

and remove the fixture to obtain the real parameters of the measured parts. Compared with TRL 

calibration, this function has the advantages of simple operation and high precision. By 

measuring the standard parts of the test fixture that need to be removed, and then transforming 

and intercepting the transmission parameters and reflection parameters in the time domain, the 

parameters of the fixture are extracted and embedded, Then obtain the real S-parameters of 

the tested part. 

 

19.3 Method of extracting fixture parameters 

There are two methods for extracting fixture parameters: 2X-Thru to embed and 1X-Reflect to 

embed. 

1. 2X-Thru to embed 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  425 

 

 

The 2X-Thru method uses the 2X-Thru standard to create a fixture model. The scenario is as 

follows: 

A. The test fixture has the same impedance, delay and loss as the standard. 

B. The reference plane of the DUT is the time at half of the standard delay of the 2X-Thru. 

C. Each half of the 2X-Thru is symmetrical. 

D. When the conditions of points B and C above are not met, 2nd-2X-Thru and an additional 

1x-Reflect auxiliary correction can be used. 

2. 1X-Reflect to embed 

 

 

The 1X-Reflect method uses the DUT test fixture itself to estimate the de-embedding S-

parameter, thus eliminating the need to customize the embedding test structure (e.g. 2X-Thru). 

This method requires that the DUT be detachable. The end of the reflection shall be open or 

short circuit. It is also possible to use both at the same time to achieve higher accuracy. 

 

19.4 Preparation before Measurement 

1. Prepare the standard parts of the test fixture to be removed in advance, usually including 2x 

straight-through standard parts, 1x reflection standard parts (open/short circuit) and their 
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combinations, as shown in the following figure. 

Test 
Fixture DUT

Left 
half

Right 
half

Thru 
Standard

Left and Right 
halves of Thru 

Standard

 

Figure 19-1 Single Ended Fixture 

 

Test 
Fixture

Thru 
Standard

Left and Right 
halves of Thru 

Standard

DUT

Left 
half

Right 
half

 

Figure 19-2 Differential Fixture 
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2. In the AFR calculation process, low-pass pulse and low-pass step time-domain changes are 

used to determine the segmentation plane and impedance, and the measurement starting 

frequency must be equal to the frequency step. Start =Span= Stop / Number of points. At 

the same time, a wider frequency span and scanning points can be appropriately set to 

achieve better test results. At the same time, it is necessary to ensure that the electric 

length of the fixture EL is greater than 4 times the rise time. For example, if the maximum 

frequency is set to 26.5G and Tr is 37.73ps, ensure that EL>4 x Tr=150.9ps 

 

 

3. S-parameter calibration should be completed before VNA measurement fixture standard. 
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19.5 AFR operation wizard 

For best results, follow the AFR Wizard form steps 1 through 4 by clicking Next. 

1. Start the AFR wizard 

2. Describe Fixture 

3. Specify Standards and Measure Standards 

4. Remove Fixture and Save Fixture files 

 

19.5.1 Start the AFR wizard 

Before starting the AFR process, Perform a Full N-port calibration of the VNA using an Electronic 

calibration kit (Ecal) or mechanical calibration kit to ensure coverage of the measured frequency 

range. Then connect the test fixture to the VNA port. Press Cal > Fixture > Automatic Fixture 

Removal to launched the AFR Configuration dialog. 

 

19.5.2 Describe Fixture 

In the AFR Wizard interface, the selections for the fixture port type and the fixture ports number 

will be reflected in the diagram, as shown in the red box in the subsequent image of this section. 

Fixture Port Type: 

⚫ Single Ended: The fixture and DUT have single-ended inputs and outputs. 

⚫ Differential: The fixture and DUT have differential inputs and outputs. 

When the fixture port type is single ended, the fixture ports number is: 

⚫ 1 Port: Such as S11 
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⚫ 2 Ports: Such as S21 

 

 

⚫ Multiport: Select up to 32 ports. 

⚫ Use THRUs: Check Use THRUs to use the thru fixture. 
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When the fixture port type is differential, the fixture ports number is: 

⚫ 2 Ports: Such as sdd11 

 

 

⚫ 4 Ports: Such as Sdd21 



SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  431 

 

 

⚫ Multiport: Select up to 64 ports. 

⚫ Use THRUs: Check Use THRUs to use the thru fixture. 

 

 

DUT Z0: Select the impedance value of the segment plane after the time domain. 
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⚫ System Z0: Sets impedance to the System Impedance setting. 

⚫ Measured Fixture Z0: Sets impedance to the value that is measured during the AFR process. 

⚫ User Z0: Sets impedance to an arbitrary value. 

Fixture match A ≠ B: Check the option to perform correction when the match of Fixture A is not 

equal to the match of Fixture B. 

Fixture length A ≠ B: Check the option to perform correction when the electrical length of 

Fixture A is not equal to the electrical length of Fixture B. 

Use Bandpass time domain mode: If checked ,the bandpass mode will be used during the Time 

Domain measurement. If not checked, the Lowpass mode is used. 

 

19.5.3 Specify Standards and Measure Standards 

After the fixture description configuration is complete, click "Next" to enter the interface of 

obtaining. As shown below: 

 

 

Thru: Indicates that the fixture parameters are obtained by using 2X-Thru to embed. 
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Open A/Short A: Indicates that the fixture parameters are obtained by using 1X-Reflect. 

Thru Fixture has:  

⚫ Know thru length: Enter the length when the through-length is known. 

⚫ Unknown thru length computed using reflects: This setting requires the two halves of the 

Thru fixture be characterized separately with a reflect standard. 

Take the Thru check box as an example, click "Next" to enter the measurement interface of the 

fixture S parameter, as shown below: 

 

 

In the interface of obtaining S parameter of fixture, "Measure" and "Load..." are provided. There 

are two ways to obtain S-parameter data of fixture. 

Measure: VNA will Measure the S-parameter of the standard fixture, as prompted in the following 

dialog box, connect the specified standard to the VNA port, and then click "Measure"(For the best 

test results, the VNA should be calibrated, in addition, the measured starting frequency and step 

frequency should be equal. This is crucial for measuring with TDR). 



SNA5000A&SNA5000X-E User Manual 

434                                                                                   int.siglent.com 

 

 

Load: It involves load the "*.snp" file of the standard (provided that the fixture has obtained the S-

parameter). 

After completing the 'Measure' or 'Load...' operation, the fixture's impedance and length will be 

calculated and displayed. 
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Impedance: The impedance of the fixture. When loading standards from files, the typical system 

characterization impedance (Z0) value is used, which is 50 Ω. 

Length: The length of the fixture. 

Click View... to display the temporal images before and after the left and right clamps are 

segmented. 

 

Click Save All Measurements and select a folder to save the raw fixture measurement data. 
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19.5.4 Remove Fixture and Save Fixture files 

After the fixture parameter measurement/loading is completed, click "Next" to enter the 

application fixture removal and saving interface, as shown below: 

 

 

with a base file name: The resulting filename will appear as follows: 

⚫ <base file name>_1.s2p - The left half of a Single Ended fixture. 

⚫ <base file name>_2.s2p - The right half of a Single Ended fixture. 
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⚫ <base file name>_1.s4p - The left half of a Differential fixture. 

⚫ <base file name>_2.s4p - The right half of a Differential fixture. 

Save Fixture Files: Save the fixture files to the specified directory. 

If the fixture port type is single ended, in the Apply Fixture Removal interface, select the ports 

from which you want to remove the fixture effects, then click Save Fixture Files: 

VNA will save the.s2p file of the fixture after processing the S-parameter of the fixture using the 

algorithm. When applied to the 2-Port De-embedding function (fixture de-embedding on the 

selected ports), the fixture effect is removed from the measurement results. Press Cal > 

Fixtures > Fixture Setup > 2-Port DeEmbed… the 2-Port DeEmbed menu is available. 

 

 

 

If the fixture port type is differential, in the Apply Fixture Removal interface, select the ports from 

which you want to remove the fixture effects, then click Save Fixture Files: 

VNA will save the.s4p file of the fixture after processing the S-parameter of the fixture using the 

algorithm. When applied to the N-Port De-embedding function (fixture de-embedding on the 

selected balance ports), the fixture effect is removed from the measurement results. Press Cal > 

Fixtures > Fixture Setup > N-Port DeEmbed… the N-Port DeEmbed menu is available. 
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SNA5000A&SNA5000X-E User Manual 

int.siglent.com                                                                                  439 

20 System settings 

Press the System button on the front panel. We can set the IP address, set the date, restore the 

factory settings, consult the help document, set the buzzer, self-detection, language setting, 

obtain the software and hardware information of the device, and license management in the 

menu on the right side of the screen. 

 

Figure 20-1 System setting interface 

 

20.1 System Configuration 
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20.1.1 Preferences 

Preferences are settings that remain even after switching presets or shutting down. The 

following is a detailed description of each feature.

 

 

Measurement 

● Power Level: Default power. 

● Start Freq: Default start frequency. 

● Stop Freq: Default stop frequency. 

● Points: Default number of points. 

● IFBW: Default IF bandwidth. 

● Sweep Status: Default sweep status. 

● Auto Show Meas-Class Setup Dialog: Once enabled, starting a new measurement mode 

such as SA or GC will open the settings window by default. 
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● Auto New Channel on Switch Meas-Class: Once enabled, starting a new measurement 

mode such as SA or GC will automatically create a new channel. 

 

Marker 

● Discrete: Default marker discrete state. 

● Couple: Default marker coupled state. 

● Format: Default marker format. 

● Active Trc Only: Default only displays the current trace state. When checked, only the 

current trace will be displayed in the window. 

● Align: Default marker information alignment state. 

● X Pos: Default marker information X coordinate. 

● Y Pos: Default marker information Y coordinate. 

● Auto Decimal: Default marker information automatic precision. 

● Stimulus Decimal: Default marker excitation information precision. 

● Response Decimal: Default marker response information precision. 

● BW/Notch Ref Type: Default BW/Notch reference type. 

 

Scale 

● Couple State: Default scale coupling state. 

 

Display 

● Touchscreen: Default touchscreen on/off state. 

● Softtool Layout: Default toolbar layout. 
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● Grid Brightness: Default window grid brightness. 

● Open Hardkey on Setup: Default keyboard on/off state. 

● Open Softtool on Setup: Default toolbar on/off state. 

● Limit Draw Failed Trc Policy: Default limit measurement failure highlighting type (red). 

 

Trigger 

● Trigger Source: Default trigger source. 

● Trigger Scope: Default trigger range. 

● Trigger Event: Default trigger mode. 

● Trigger Input: Default external trigger input mode. 

● Trigger Delay: Default trigger delay. 

● Ext Trigger Output: Default external trigger output state. 

● Trigger Polarity: Default external trigger polarity. 

● Trigger Position: Default external trigger position. 

 

Utility 

● Language: Default language. 

● Preset Confirm: When checked, pressing the Preset button requires clicking the Preset key 

on the screen; when unchecked, pressing the Preset physical button immediately executes 

the preset operation. 

● Remote Screen Lock Control: When checked, the machine will enter remote mode when 

controlled via SCPI commands; when unchecked, the machine will not enter remote mode 

when controlled via SCPI commands. 
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Buzzer 

● Buzzer: Default buzzer status. 

● Warning Buzzer: Default warning buzzer status. 

● Complete Buzzer: Default completion buzzer status. 

● Touch Buzzer: Default touch buzzer status. 

● Hardkey Buzzer: Default key buzzer status. 

 

Calibration 

● Show SOLR Delay Information: Default SOLR calibration delay status. 

● Use SOLR Method To Replace SOLT Method: When checked, SOLT calibration will be 

replaced by SOLR calibration during two-port calibration. 

 

Save 

● Default Save Type: Default save state type. 

● Default CSV Format: Default CSV file format. 

● Default Snp Format: Default SNP file format. 

 

 

20.1.2 Firmware upgrade 

Store the .ADS file in the firmware upgrade package downloaded from the official website in the U 

disk root directory, insert the U disk into the USB port of the vector network analyzer, click the 

Upgrade command in the System submenu, select the required file in the pop-up file browser, and 
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click OK to upgrade the firmware. The firmware upgrade process may last for several minutes. 

When the upgrade is completed, the device will automatically restart. Any operation that 

interrupts the upgrade process may cause the upgrade to fail or even the device cannot start 

normally. Please keep the U disk stable and the power supply of the equipment normal during the 

firmware upgrade process. 

 

 

20.1.3 File Browser 

Click File Browser command to open the file browser, File management can be carried out in the 

file browser. 

 

20.1.4 Date/Time setting 

Use the Date & Time command in the System submenu to set the date/time. You can set whether 

to display the date/ time and display the format at the bottom right of the screen and modify the 

date/ time value.  
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Figure 20-2 Date/Time setting interface 

 

20.1.5 Screenshot setting 

Press the System>System>Screenshot Settings…, open the screenshot settings interface to 

configure the screenshot parameters. 

 

Figure 20-3 Screenshot Settings Dialog 

 

⚫ Save as Anti-color Image: If this option is checked, the background color of the saved image 

will be white, which is suitable for printing; if not checked, the saved image will retain the 

same color tone as displayed on the screen. 
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⚫ Only Capture Waveform Area: If this option is checked, the screenshot will only capture the 

waveform display area, excluding menus, time, and other information displayed on the 

screen. If not checked, the entire contents of the screen will be saved. 

⚫ U-disk Storage First: If this option is checked and a U-disk is connected, the screenshot files 

will be saved to the U-disk by default. If the option is not checked, the screenshot files will be 

saved to the local path by default. 

 

20.1.6 Screensaver 

Press the System>System>Screensaver, set the screen saver parameters.  

 

20.1.7 System language 

Press the System>System>Language to change the equipment's language settings. Both 

Simplified Chinese and English are supported. 

 

20.1.8 Power 

Press the System>System>power，this menu provides shutdown and restart operation buttons.  

 

20.2 Communication interface setting 

20.2.1 LAN Status  

We can select static or dynamic allocation of LAN-related parameters. Use LAN Status 

command in System submenu to set LAN parameters.  
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20.2.2 mDNS Setting 

The mDNS host name and description can be set in the mDNS Setting submenu.  

The Reset menu button can restore the host name and description of mDNS to the default state. 

 

20.2.3 LXI 

You can view LXI related information in the LXI submenu. 

 

20.2.4 VNC Setting 

The analyzer supports VNC remote access to web pages. That is to say, the content displayed by 

the analyzer is projected to the web page remotely, and at the same time, the mouse and 

keyboard are supported to input parameters remotely. 

The VNC port can be set in the VNC Setting submenu. When logging in to VNC, the port of VNC 

should be consistent with the set port. 

The Reset menu button can restore the VNC port to the default state. 

 

20.2.5 Web Setting 

You can set the Web password in the Web Setting submenu, and you need to enter the web 

password when remotely controlling the analyzer through the web. 

The Reset menu button can restore the Web password to the default state. 

 

20.2.6 GPIB 

Use the GPIB command in the System submenu to set the GPIB port number. 
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20.2.7 Net Storage 

Set up SNA network storage function, supporting SMB Server, SMB Client, and FTP Server 

configuration. 

 

⚫ Introduction to SMB Server 

Check 'Start Server' to enable the SMB Server feature, and check 'Self start up startup' to 

automatically enable this feature after the device is started. 

 

 

Attention: If the connection cannot be successful after resetting the password, the net 

configuration needs to be deleted before the connection can be made. 
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⚫ Introduction to SMB Client 

Configure Server Path and other information on SNA, click the Connect button to connect, and 

after successful connection, click the folder button for remote access. 
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⚫ Introduction to FTP Server 

Check 'Start Server' to enable the FTP Server function, and check 'Self start up startup' to 

automatically enable this function after the device is started. 

 

 

20.3 Preset 

Preset operation and related settings can be performed in Preset submenu. 

Preset: Use the Preset command to reset immediately according to the setting reset options.  

Preset Option: Use the Preset Option command to set the reset options, and to determine the 

preset source: 

⚫ Default: Load default parameters. 

⚫ Last: When the equipment is shut down, the current state will be saved automatically. Use 

this option to restore to the last shutdown state. 

⚫ User: Restore the equipment to the user-specified state. 

User Preset: Use the User Preset command to specify the user preset status information file. 

Confirm Preset: Use the Confirm Preset command to set whether to confirm before reset. 
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Power On Option: Use the Power On Option command to set the default source of equipment 

reset when the equipment starts. 

Power On-Line: Use the Power On-Line command to set whether the device starts 

automatically when it is powered on. 

 

20.4  Factory Reset 

⚫ Configuration files (Selected by default) Indicates that the equipment is restored to the 

factory default state, but the files saved by the user to local will not be deleted. 

⚫ User data (Optional), user can selectively delete the files saved to local. 

⚫ Secure delete (optional), If the check box is checked, the original data will be overwritten 

with random data, achieving the effect of permanent deletion, which may take a little longer. 

If the check box is not checked, the normal deletion mode will be used. 

 

Figure 20-4 Select the saved file 

 



SNA5000A&SNA5000X-E User Manual 

452                                                                                   int.siglent.com 

⚫ Configuration files and User data If user select both, the equipment is restored to the factory 

default state and deletes the files saved to local by users. 

 

20.5  Help information 

20.5.1 Help and About 

In the Help submenu, we can open the help document (Help command) or view the equipment 

information (About command). 

 

20.5.2 Message Setting 

In the Message Setting submenu, we can open the message setting dialog. 

⚫ Enable Message Display (Selected by default) Check to display all messages as they occur. 

Clear to suppress the display of messages. You can still view them in the View Message. 

⚫ Enable Power Unlevel Detection (Selected by default) Check to enable the power unlevel 

detection. Clear to close. 

 

20.5.3 View Message 

In the View Message submenu, we can open the message log dialog. 

 

20.6  Buzzer 

We can set the sound in the Buzzer submenu. 

Buzzer: Use the Buzzer command to turn the device sound on or off. 
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Complete Test: Use the Complete Test command to test the completion tone. 

Complete Buzzer: Use the Complete Buzzer command to turn the completion tone on or off. 

Warning Test: Use the Warning Test command to test the alarm tone. 

Warning Buzzer: Use the Warning Buzzer command to turn on or off the alarm tone. 

Touch Buzzer: Use the Touch Buzzer command to turn on or off the touchscreen keystone. 

 

20.7  Self-Test 

20.7.1 Key and touch screen test 

In the Self Test submenu, we can perform keyboard self-test (Key Test command), touch screen 

self-test (Touch Test command), screen self-test (Screen Test command) and LED self test (LED 

Test command).  

 

20.7.2  Performance test (Only for SNA5000A) 

20.7.2.1 Enter VNA Test Dialog Method 

Press the  Utility  key of front panel →  Self Test  →  Performance Verification...  
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20.7.2.2 VNA Test Dialog UI Description 

 

 

A. Adjustment and PV mission area 
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B. Detailed test item 

C. Test parameter 

D. Task Process control area 

E. Test result (Pass/Fail) 

 

20.7.2.3 Task Process Description 

Instrument performance veriflaction mainly includes Quick PV, PV and Adjustment. 

 

⚫ Quick PV 

Needed equipment: 

 Calibration Kits (Short, Load) 

 

Adjustment Process: 

1. Enter Quick PV tab page 

2. Select the test port 

3. Connect the Calibration Kits to the port as prompted by the wizard 

4. Click  Run  button to begin the PV test. 
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⚫ Adjustment Task 

Needed equipment: 

 Power Meter (The maximum frequency of the machine is less than 13.5GHz with R&S 

NRP18A, and greater than 13.5GHz with R&S NRP18A and R&S NRP33S)  

 10 dB attenuator × 1 

 Coaxial cable × Several 

 Calibration Kits (2-port machine: Open × 1+Short × 1+Load× 2; 4-port machine: Open × 

1+Short × 1+Load × 4) 

 Adapter × Several 

 

Adjustment Process: 

1. Enter adjustment tab page. 

2. Select all calibration items. 
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3. Click  Start  button to begin adjustment tasks. 

4. Follow the tips to complete the adjustment process. 

 

 

 

⚫ PV Task 

Needed equipment: 

 Power Meter (The maximum frequency of the machine is less than 13.5GHz with R&S 

NRP18A, and greater than 13.5GHz with R&S NRP18A and R&S NRP33S) 

 Coaxial cable × Several 

 Adapter × Several 

 

PV Process: 

1. Enter PV tab page. 
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2. Select all test items. 

3. Click  Start  button to begin PV tests. 

4. Follow the tips to complete the PV process. 

5. Click test item  Export Report...  button to save the report. (Optional) 

 

 

 

20.7.2.4 Switch to User Factory Calibration Data 

Press the  Cal  key of front panel→  Cal  →  Factory Cal...  

Tips: 

1. Factory mode, VNA use factory calibration data. 

2. When the check box is checked, VNA will use user calibrated calibration data. 

3. After the user performs factory calibration, this check box will be automatically selected. 
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20.8 Options 

Refer to the procedures below to activate the options you have purchased. 

1 Press  System  > “Options”-> “License…” 

2 Enter the license key in the onscreen window.  

Press  Enter  to confirm your input and terminate the license key input. Or load the .lic file by 

selecting "Scan U-disk," which will automatically search for the corresponding .lic file stored in the 

root directory of the USB drive. Once found, the license will be installed automatically. 

 

20.9 External Ports 

Used to define external logical port, source port, reference receiver port and test receiver port. 
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20.10 External Devices 

20.10.1 External Devices 

Press the System>External Devices>External Device… , configure external devices, once 

configured, an external device will appear in, and be controlled from, relevant VNA dialogs as 

though it were internal to the VNA. 

 

20.10.1.1 Devices Manager Dialog 

 

Figure 20-5 Devices Manager Dialog 

 

⚫ The name of the currently configured device will appear on the left side of the dialog 

interface. 

⚫ Label: Used to create an alias for the currently connected external device. Click the "Test" or 

"Save" button to complete the name modification. This makes it more convenient and faster 

to operate multiple devices, especially when frequent switching between different devices is 

required. The name will be displayed when referencing this device in the VNA dialog and can 
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be edited at any time. 

⚫ Device Type: Supports types of external devices. Please select the corresponding device 

type when connecting external devices. 

⚫ IP: Enter the IP address of the external device to connect using LAN. If you set the IP address 

to 0.0.0.0, it will display the information of the current VNA itself. This menu does not appear 

if connecting the device via USB. 

⚫ New: Click to create a new device configuration for a LAN connection. 

⚫ Delete: Click to remove the selected device. Please note, this option is only available when 

the device is connected via LAN. 

⚫ Properties…: Click to open the properties dialog for the selected device type, enabling users 

to customize settings for the connected external device. Note that this feature is only 

available for certain device types. 

⚫ Test: Verify if communication is functioning normally. Upon successful verification, display the 

device's Manufacturer, Model, Serial Number, Address, etc. The label, Device Type, and IP 

address of the current external device will be automatically saved in the network analyzer's 

configuration file for future use and management. 

⚫ Save: Store the modifications of the Label, Device Type, and IP address of the current 

external device in the network analyzer's configuration file for future use and management. 

 

20.10.1.2 Interactive I/O 

External devices that connect to the VNA can be categorized into two types: those that connect 

directly via the VNA's USB port, and those that are connected to the network through LAN. This 

categorization helps clarify the connection methods and suitable scenarios for different devices, 

making it easier for users to select the appropriate connection solution based on their specific 

needs. 

1. USB: USB communication is plug-and-play. Upon connecting an external device to the USB 

port of the VNA, the device information automatically appears in the devices manager 
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dialog interface. 

 

Figure 20-6 Device Manager Dialog via USB 

 

2. LAN: Establish the connection by accurately entering the IP address of the external device. 

After inputting the correct IP address, click 'Test'. The system will verify if the communication 

is functioning properly and will display the device information in the devices manager dialog. 
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Figure 20-7 Device Manager Dialog via LAN 

 

20.10.1.3 How to Configure External Devices 

Configuration of External Devices: Using "Source" as an Example, steps are as follows: 

1. Connect the external signal source to the VNA. Press the System>External 

Devices>External Device…, enter the device manager dialog, input the Label, and click Test 

to verify if the communication is normal. 

 

Figure 20-8 Source configuration dialog interface 

 

2. Click on Properties... to enter the dialog interface for external source device property 

settings. After completing the settings, click OK. 
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Figure 20-9 Source property settings dialog 

 

⚫ Dwell Time: Applies a dwell in Hardware List triggering only Set the time (in 

milliseconds) the external source will wait before data acquisition. 

⚫ Trigger Mode:  

SoftWare CW: The external source receives each CW frequency from the VNA over 

USB, or LAN. No other trigger cables are required. 

Hardwave List(BNC): The external source receives a list of CW frequencies from the 

VNA, then receives trigger signals though a rear-panel connector when appropriate 

from the VNA. 

⚫ Device Command Settings: Used for customizing SCPI commands for external sources. 

Custom Commands Enable: If this option is checked, users can customize SCPI 

commands based on examples to control specific functions of external sources; if not 

checked, custom SCPI commands cannot be edited. 
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20.10.2 Power Meter 

20.10.2.1 Function Overview 

This module allows the user to control an external power meter through the VNA and read the 

power values in real time, displaying the current value digitally or graphically and synchronously 

displayed on the VNA screen. 

 

20.10.2.2 Hardware Connection 

Power meter with USB interface (SCPI or VISA compliant). 

Recommended models: Keysight N1911A, Rohde & Schwarz NRX series, etc. 

 

20.10.2.3 Enabling the Power Meter 

Connect The power meter to the USB Host port of the VNA via USB cable. Wait for the VNA to 

recognize the connected power meter. "The power sensor plugged in" is displayed in the 

message bar. Press System> External Device > Power Meter to enter the power meter reading 

dialog box. 

 

20.10.2.3.1 Power Meter Measure Parameter Setting TAB 

In the "Meas" TAB, user can configure the basic working parameters, reading control parameters, 

and display parameters of the power meter. Basic operating parameters will send control 

commands to the power meter, display parameters will not, it is only responsible for data 

processing and display. 
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A Select the power meter model: When multiple USB power timers are connected to the VNA, 

specify the power meter through the drop-down box. After specifying the power meter dialog 

box name, the power meter name will be automatically displayed. 

(1) Reading parameters 

B Set the power meter reading trigger mode or clear power meter data. 

 "Continuous": The reading is automatically updated at regular intervals. 

 "Single": click this button to set the reading trigger mode to Single. In this case, the 

Continuous button will automatically turn off and update the meter reading once every time 

you click "single". 

 Reset Data: clears data in the C and D reading area and starts collecting statistics again. 

(2) Power meter data display 

C. Power meter reading dial display area: the power meter reading is displayed in real time in the 

form of dial, simulating the traditional dial type power meter. 
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D. Power meter reading statistics display area: responsible for displaying or clearing the 

minimum/maximum reading and average value of the power meter reading. When the 

measurement method is relative value measurement, the relative reference value and real-time 

relative value are also displayed. 

(3) Basic parameters of the power meter 

E. Set the frequency of the power meter. 

F. Set and Enable the power meter reading bias. 

(4) Power meter display parameters 

G. Set the unit of the power meter: dBm or Watt is optional. 

H. Set power meter reading accuracy: decimal digits 0, 1, 2, 3. 

I. Enable power meter measurement method for relative value measurement: When relative 

measurement is checked, the current reading is used as the relative reference value, and the 

reading calculates the relative value from that reference value.  

 When the reading unit is dBm, the relative value is in dB: 

Relative value = current measurement value - relative reference value 

 When the reading is in Watt, the relative value is in”%”: 

Relative value = current measured value/relative reference value 

J. Set the lower reading limit of the wattmeter dial. 

K. Set the upper reading limit of the wattmeter dial. 

L. Click the "Auto Scale" button to automatically adjust the power meter dial scale with the 

current reading as the intermediate value. 

M. Set/Enable the lower limit warning value of the power meter reading: After this function is 

enabled, the range between the lower limit reading of the power meter dial and the warning 

value of the lower limit reading is set to blue. When the power meter reading is lower than the 
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lower limit warning value, the reading is also set to blue. 

N. Set/Enable Upper warning value for power meter reading: After this function is enabled, the 

range between the upper warning value and the upper reading value of the power meter dial is 

set to red. When the reading of the power meter is greater than the lower warning value, the 

reading is also set to red. 

(5) Other 

O. Restore default Settings: including power meter working parameters, reading control 

parameters, display parameters. 

P. Exit the power meter reading dialog box 

Q. Open the power meter dialog box help document 

 

20.10.2.3.2 Power Meter Advanced TAB 

Any configuration set on this page sends control commands to the power meter. 
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A Set the average mode of the power meter. 

 Auto: the power meter will automatically select the average times. 

 Manual: Manual Indicates set the average times in Num Averages. 

 None: The power meter does not perform average operations. 

B Set Manual average times: When the value changes, "Averaging" is automatically set to manual. 

C. Step Detection ": When is enabled, it is used to reduce the stabilization time when the 

measurement frequency changes over a large span. This feature is commonly found in power 

meters from Keysight manufacturers. 

D. The zero adjustment mode:  

 INT : indicates that the zero adjustment mode is internal zero adjustment. 

 EXT: indicates that the zeroing mode is external zeroing. And Ensure that the power source 

is OFF.  

For power meters that do not support setting the zeroing mode, the drop-down box is ash. 

E. Perform zero setting: click "Start" to perform zero setting. This process may take tens of 

seconds, and a dialog box will pop up after zero setting is completed. 
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21 Service and Support 

21.1 Ordering and activating the options 

There are two ways for you: 

1. Pre-activate the options by Siglent factory. 

If you order a instrument and options, Siglent factory will activate the options for you before 

delivery. 

 

 

2. Post-activate the options by yourself. 

If you want to activate options on a instrument that you are using. 
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21.2 Warranty overview 

SIGLENT guarantees that the products produced and sold will not have defects in materials and 

technology within three years from the date of delivery by authorized distributors. If the product 

is defective within the warranty period, SIGLENT will provide repair or replacement service 

according to the detailed provisions of the warranty.  

For service or a complete copy of the warranty, please contact your nearest SIGLENT sales and 

service office. SIGLENT makes no other warranty, express or implied, except as provided in this 

summary or the applicable warranty, including but not limited to the implied warranty of 

merchantability and special applicability. SIGLENT shall not be liable for any indirect, special or 

consequential damages.  

 

  



SNA5000A&SNA5000X-E User Manual 

472                                                                                   int.siglent.com 

 

 

About SIGLENT 
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generators, spectrum analyzers, vector network analyzers, digital 

multimeters, DC power supplies, electronic loads and other general purpose 

test instrumentation. Since its first oscilloscope was launched in 2005, 

SIGLENT has become the fastest growing manufacturer of digital 

oscilloscopes. We firmly believe that today SIGLENT is the best value in 

electronic test & measurement. 
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Tel: + 86 755 3688 7876 

Fax: + 86 755 3359 1582 
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